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GENERAL

SECTION 1   GENERAL

Figure 1-1   Mobile Programming Setup

Figure 1-2   Typical Portable Programming Setup
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NOTE: An RPI box is 
required with the 
7780 portable.

1.1 PROGRAMMING SETUP

To program the various transceivers, a 
Windows®-based computer, EFJohnson 
PCConfigure™ programming software, Part No. 
023-9998-488, and the following items are required to 
program the various transceivers. A mobile program-
ming setup is shown in Figure 1-1, and a portable setup 
is shown in Figure 1-2.

51xx Portable

• Programming cable from computer to transceiver, 
Part No. 023-5100-920. NOTE: This cable, the -488 
programming software, and the PDF file for this 
manual are included in Programming Kit, Part No. 
250-5100-003.

53xx Mobile

• Programming cable from RPI to transceiver, Part 
No. 023-5300-005. 

• Remote Programming Interface (RPI), Part No. 
023-5300-000. NOTE: The -005 cable, 5300-000 
RPI, -488 programming software, and the PDF file 
for this manual are included in 5300 Programming 
Kit, Part No. 250-5000-004. 

7780 Portable

• Programming cable from RPI to transceiver, Part 
No. 597-2002-122. 

• Remote Programming Interface (RPI), Part No.
023-9800-000. NOTE: The -122 cable, 9800-000 
RPI, -488 programming software, and the PDF file 
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for this manual are included in Programming Kit, 
Part No. 250-7780-002.

9800 Mobile

• Programming cable from RPI to transceiver, Part 
No. 597-2002-200. 

• Remote Programming Interface (RPI), Part No. 
023-9800-000. NOTE: The -200 cable, 9800-000 
RPI, -488 programming software, and the PDF file 
for this manual are included in 9800 Programming 
Kit, Part No. 250-9800-002.

Connecting Mobile Transceivers To Computer

With 53xx transceivers, only RPI, Part No. 023-
5300-000, can be used. Other RPIs such as 023-9800-
000 and 023-9750-000 are not compatible with this 
transceiver. 

With 9800 transceivers, earlier RPIs such as Part 
No.s 023-5810-000 and 023-9750-000 can also be 
used. However, the 023-9800-000 version is required 
for other functions such as Flash programming and 
tuning.

The Radio Programming Interface (RPI) provides 
the required logic interface between the computer and 
transceiver. The cable from the RPI to computer is not 
included with the RPI or in the programming kit. The 
current RPI’s have a female DB9 connector, and most 
computer serial ports have a male DB9 or DB25 
connector. Therefore, a male DB9 to female DB9 or 
DB25 cable is usually required. This is a standard cable 
available at most computer supply stores or order 6 ft. 
DB9M to DB9F cable, Part No. 597-5900-002. 

The cable from the RPI to the transceiver is not 
included with the RPI, but it is included with the 
programming kits or can be ordered separately as 
previously described. 

This cable plugs into the microphone jack of stan-
dard front or remote mount transceivers. With 53xx 
transceivers using the Handheld Control Unit (HHC), 
the connection point is the 10-pin programming jack 
on the HHC junction box via a special adapter plug 
(Part No. 023-5300-140). If the HHC is not equipped 
with the junction box (Part No.023-5300-130), it is 
also required for programming. 

Connecting Portable Transceivers To Computer

NOTE: Although they may look the same, the 5000 
portable programming cable cannot be used to 
program a 5100 portable and vice versa. 

51xx Series - No RPI is required because the radio 
contains the interface circuitry. The programming 
cable has a female DB9 connector for connecting to 
the computer. 

7780 - The 9800 RPI and programming cable listed in 
the preceding information are required. The RPIs used 
to program the 51xx and 53xx are not compatible. The 
programming cable connects to the accessory jack on 
the side of the transceiver. 

As with mobile transceivers, the cable between 
the RPI and computer is not included with the RPI. 
Refer to preceding description for more information. 

1.2 COMPUTER DESCRIPTION

The computer used to run this program must meet 
the following minimum requirements:

• Windows® 95/98/NT/2000/XP (3.1 cannot be used)
• Pentium® processor or equivalent
• At least 16 MB of RAM
• A hard disk drive with at least 4 MB of free space
• A CD-ROM drive
• An available serial port

1.3 OPERATING AND SERVICE MANUALS

This manual includes brief descriptions of the 
various programmable parameters. For detailed radio 
operating information, refer to the applicable radio 
operating or service manuals which are as follows. 
With the 5100/5300, both the operating and service 
manuals contain operating information, so either can 
be used. 

5100 Portable CD Op Man, P.N. 002-5100-1005CD
CD Serv Man, P.N. 001-5100-0015CD

5300 Mobile CD Op Man, P.N. 002-5300-009CD
CD Serv Man, P.N. 001-5300-009CD

7780 Portable Service Manual, P.N. 001-7780-500
9883 Mobile Serv Man Addend, P.N. 001-9800-500

Operating Man, P.N. 002-9800-503
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Figure 1-3   Main Screen (Global Screen Shown)
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1.4 SOFTWARE INSTALLATION

NOTE: Before completely removing an old version of 
PCConfigure, be sure to transfer the files in the Data 
and Keys folders to those folders of the new version.

1. Make sure that there are no other applications open 
during this installation procedure. Also, make sure 
that the computer meets the minimum requirements 
listed in the preceding section.

2. Insert the PCConfigure CD-ROM in the CD drive of 
your computer.

3. In the lower left corner of the screen, select Start > 
Run and then click the Browse button. Select the 
CD-ROM drive and the file “PCConfigurex_x.exe” 
(x_x is the PCConfigure version number). Click the 
Open button and then from the Run window, click 
OK and the installation process begins. 

4. Follow the on-screen instructions. The default 
directory for the program is \Program Files\EF 
Johnson\PCConfigure. This directory can be 
changed during installation if desired.

1.5 STARTING AND EXITING

To Start PCConfigure

To start the PCConfigure program from 
Windows, select Start > Programs > EF Johnson > 
PCConfigure 1.2x.xx. 

The PCConfigure program can also be started 
from an MS-DOS command prompt (C:\). To display 
the PCConfigure options that can be selected from the 
command prompt line, enter PCConfigure /?. The 
following information is then displayed.

To Exit PCConfigure:

Select File > Exit or press ALT and F4.
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1.6 PROGRAMMING FILE TYPES

Programming data is stored in a disk file that can 
be saved, read, copied, and deleted (see Section 3.1). 
This file is automatically given the extension “.rcf”.

1.7 HELP FILES

To display help information on the current screen, 
click Help in the menu bar.

NOTE: For a list of changes made with the various 
releases of this software, refer to the ReleaseNotes.txt 
file located in the PCConfigure Program Files folder. 

1.8 MAIN SCREENS

Four different screens can be selected by clicking 
the tabs at the top as shown in Figure 1-3. The func-
tions of these screens are as follows:

Global - This screen is shown in Figure 1-3, and it 
programs parameters that are the same for all Conven-
tional, Project 25 Trunked, SMARTNET™, and 
SmartZone® systems. Refer to Section 4 for more 
information on parameters in this screen.

Radio Wide - This screen programs the parameters 
that are the same for all programmed Conventional 
(P25 and analog), Project 25 trunked, and 
SMARTNET/SmartZone systems (a different screen is 
displayed for each). The screen system type is selected 
in the System Specific box. Refer to Section 5 for 
more information on parameters in this screen.

Per System - This screen programs the parameters 
that are unique to each programmed system. The 
system to be edited is selected by clicking it in the 
Systems box. Refer to Sections 7.1, 8.1, and 9.1 for 
more information on parameters in this screen.

Zone - This screen programs the channels and zones. 
Unique channel parameters include system number and 
type, frequency, and talk group. Refer to Sections 7.3, 
7.4, 8.3, and 9.3 for more information on parameters in 
this screen.

1.9 OTHER SCREEN INFORMATION

1.9.1  PROGRAMMABLE TITLE AND LOGO

The title that is displayed after “Radio Configura-
tion” at the top of the screen (see Figure 1-3) is 
programmable using the Tools > Organization Iden-
tity menu item. This can be used, for example, to 
display a company name on the top line. In addition, 
the logo that is displayed on the right end of the menu 
bar can be customized. Refer to Section 3.4 for more 
information.

1.9.2  ORGANIZER

Clicking the organizer button  on the right 
end of the toolbar displays a screen is used to organize 
the various programming files into groups and 
subgroups. This can make administrating the program-
ming files of a large organization easier. Refer to 
Section 3.8 for more information.

1.9.3  FILE SIZE INDICATION

The maximum number of channels that can be 
programmed may be limited by the available memory 
space in the radio. A running indication of the amount 
of memory used by the current data if it was down-
loaded to the radio is displayed as a percentage in the 
“Size:” box in the status bar on the bottom of the 
screen (see Figure 1-3). When this percentage reaches 
100%, the available memory is full and some channels 
may need to be deleted if more information remains to 
be programmed.

1.9.4  DECIMAL/HEXADECIMAL SELECT

On some screens, such as the SMARTNET Talk 
Group, numbers can be entered using either a Decimal 
or Hexadecimal format. The format is selected 
globally which means that when a format is selected, it 
is selected for applicable numbers on all screens. 

The currently selected format is indicated in the 
status bar on the bottom of the screen in the box next 
to the file size indication (see Figure 1-3). A “D” indi-
cates the Decimal format is selected and an “H” indi-
cates the hexadecimal format is selected. The back-
ground color indicates the number type. It is ivory for 
Hexadecimal numbers, and white for Decimal and 
other entries. 
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To toggle between the Decimal and Hexadecimal 
formats, right click the H/D box and click Yes in the 
confirmation box that is displayed. This mode can also 
be toggled using the Tools > Preferences screen 
described in Section 3.4.

1.10 CREATING SYSTEMS

NOTE: To view the current and added systems, select 
the “Per System” tab and all programmed systems are 
displayed in the “Systems” pane on the left side.

A system as used with these transceivers is a 
collection of channels or talk groups typically assigned 
to the same repeater site. Unique system parameters 
are shown in the Per System screen and include the 
scan list, various timers, and talk groups. Up to sixteen 
systems of any type can be created.

To create a new Conventional, SMARTNET, 
SmartZone, or Project 25 Trunked system, select 
Radio > Add Systems in the menu bar and then select 
the desired system type (see Section 3.2). Alterna-
tively, click  in the toolbar and select the desired 
system type from the drop down list. To delete a 
system, select it in the “Systems” box and then select 
the Radio > Delete System in the menu bar or  in 
the toolbar.

1.11 HOW TO PROGRAM SCANNING

1.11.1  GENERAL

The two types of scanning that can be 
programmed are Radio Wide and Priority (Standard). 
Generally, these scanning types are utilized as follows: 

Radio Wide Scan - This type is usually programmed 
when two or more types of channels must be scanned 
at the same time such as conventional and P25 
trunked. If this is not a requirement, use the more effi-
cient Priority Scan which follows because there is less 
chance of missed calls. 

Priority (Standard) Scan - This type of scan monitors 
only channels that are the same type as the selected 
channel. For example, if a conventional channel is 
selected, only conventional channels can be scanned. 
Trunked channels must also belong to the system of 
the selected channel.

1.11.2  PROGRAMMING THE RADIO WIDE 
SCAN MODE

1. On the Radio Wide screen, program the Radio Wide 
Scan List and Scan Hold time as described in 
Section 5.2. The channels to be included in the scan 
list must have been set up as described in Section 6.

2. Program the Radio Wide Scan option button by 
clicking the Assign Buttons button on the Radio 
Wide screen as described in Section 5.4. With 51xx 
portables, a Radio Wide Scan menu parameter can 
also be programmed as described in Section 5.3. 

1.11.3  PROGRAMMING THE PRIORITY SCAN 
MODE

Priority scan is set up on the Per System screen 
because it is unique for each system type. Proceed as 
follows:

1. On the Per System screen, select the desired system 
in the left pane. 

2. In the System Lists drop down list near the bottom 
of the screen, select “Priority Scan List”. Then click 
the Edit List button and program the scan list as 
described in Section 7.2, 8.2, and 9.2. The channels 
to be included in the scan list must have been set up 
as described in Section 6.

3. With conventional channels, program the Per 
System Scan List Settings on the Per System screen. 
There is also the option to slave a particular scan list 
to a zone. Refer to Section 6.2 for more information.

4. Repeat the preceding steps for each system that will 
have Priority Scan function.

5. With trunked (SMARTNET/SmartZone/P25) chan-
nels, each channel may need to be programmed to 
select a scan list and auto scan. Select the Zone 
screen and program this information for each 
channel if required (see Sections 8.3 and 9.3).

6. Program the Scan option button by clicking the 
Assign Buttons button on the Radio Wide screen as 
described in Section 5.4. With 51xx portables, a 
Scan menu parameter can also be programmed as 
described in Section 5.3.
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1.12 FIRMWARE UPGRADING RESTRICTIONS

NOTE: Version 1.24 or later PCConfigure software 
can only upgrade radios with later firmware versions. 
Refer to the following for more information. 

1.12.1  GENERAL

Beginning in approximately June 2004, all 51xx 
and 53xx radios began shipping with a new version of 
firmware which uses a different memory configuration 
for storing the radio operating program. One effect of 
this change is that a new firmware upgrade utility must 
be used to program radios with this firmware. The 
firmware upgrade utility is included with the PCCon-
figure software and is selected by the Transfer > 
Write Application Code To Radio menu described in 
Section 3.3. The following information describes 
which firmware versions can be upgraded with this 
version of PCConfigure software.

1.12.2  COMPATIBILITY

PCConfigure software, Version 1.24.0 or later, 
must be used to upgrade radios with the following 
firmware version or later: 

51xx Series
Non-SEM - Version 1.14.0 or later
SEM - Version 2.04.0 or later
UCM - Version 3.04.0 or later

53xx Series
SEM - Version 2.04.0 or later
UCM - Version 3.04.0 or later
ARM - Version 1.27.0 or later

To summarize these restrictions:

• To upgrade radios to the above firmware versions or 
later, PCConfigure, Version 1.24.0 or later, must be 
used. 

• To upgrade radios to earlier versions than those 
shown above, PCConfigure, Version 1.22.0 or 
earlier must be used. 

• If an attempt is made to upgrade firmware with the 
wrong version of PCConfigure software, the proce-
dure halts and an error message is displayed.

• The Boot Loader code must also be upgraded when 
upgrading firmware versions earlier than the 
preceding. This must be done before updating the 
Application code. Two passwords are provided by 
EFJohnson with new firmware. One selects the Boot 
Loader utility and the other the Application Code 
utility. 

• This limitation does not apply to standard program-
ming of radio personality parameters. The PCCon-
figure software is backward compatible and can be 
used to program radios with earlier versions of firm-
ware. However, some parameters may be available 
only with certain versions of firmware.

1.12.3  SAFEGUARDS TO PREVENT DOWN-
LOADING WRONG CODE VERSION

NOTE: The following applies only to downloading 
Application Code (firmware), not to downloading 
standard personality information.

General

PCConfigure software, Version 1.25 or later 
includes safeguards to prevent downloading an incor-
rect firmware version. For example, it prevents 5100 
SEM code (Version 2.x) from being downloaded to a 
5100 UCM radio (Version 3.x). If this did happen, no 
damage occurs. The radio is just inoperative and the 
condition is corrected by simply downloading the 
correct version.

The radio version is determined by detecting the 
radio boot code version, and the firmware version is 
determined by checking the file name of the firmware 
being downloaded. More information follows.

Radio Version Detection

Since the boot loader code version number is 
unique for each radio type, it can be used to determine 
the radio type. However, the version numbers used by 
mobiles and portables are similar, so it does not indi-
cate if the radio is a mobile or portable. This is deter-
mined by detecting the serial port type (RS-485 = 
mobile, RS-232 = portable).

Version 1.25 or later PCConfigure software can 
only upgrade firmware in radios which have boot code 
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with the built-in ability to identify its version. With 
portables, code versions with this ability are 1.10/2.1/
3.1/4.0 or later. With mobiles it is 2.0/3.0/4.0 or later. 
If radio with an earlier version needs to be upgraded, 
either the boot code must be upgraded first or an 
earlier version of PCConfigure must be used. 

ARM 53xx radios (code Version 1.x) do not have 
the ability to report the boot code version. Therefore, 
if no response is received to a boot loader code version 
inquiry, the PCConfigure software assumes it is an 
ARM radio. The file must then be named accordingly 
for an ARM radio (see following).

Code Version Detection

The following naming conventions must be used 
for the file names of the firmware being downloaded. 
If a file name does not use this convention, an error 
occurs and it is not downloaded. To download older 
files that do not use this convention, rename them so 
that the correct name is used.

51xx Portable File Naming Convention

53xx Mobile File Naming Convention

Boot Version File Naming Convention
1.x (NonSEM/UCM) 5100NonSEM_Ver_01_yy_zz
2.x (SEM) 5100SEM_Ver_02_yy_zz
3.x (UCM) 5100UCM_Ver_03_yy_zz
4.x (new SEM) 5100x_Ver_04_yy_zz

Boot Version File Naming Convention
1.x (ARM) 5300ARM_Ver_01_yy_zz
2.x (SEM) 5100iSEM_Ver_02_yy_zz
3.x (UCM) 5100iUCM_Ver_03_yy_zz
4.x (new SEM) 5100x_Ver_04_yy_zz
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SECTION 2   PROGRAMMING PROCEDURE

The following is a general procedure that can be 
followed to program a transceiver.

2.1 PRELIMINARY

1. Select a programming file as follows:

Create a New File - To start with a new file 
containing default parameters, select File > New and 
then when the dialog box appears, select the frequency 
band of the radio: VHF, UHF 380 (380-470 MHz), 
UHF Low (403-470 MHz), UHF High (450-512 
MHz), 700/800 MHz (762-870 MHz), 800 MHz 
(806-870 MHz).

Open An Existing File - To open an existing file 
stored on disk, select File > Open and then the file-
name to be opened.

Read a File From a Radio - To transfer a file from a 
radio to the computer for editing or use as a basis to 
program another radio, connect the radio to the 
computer as described in Section 1.1. Then turn the 
radio on and select Transfer > Read Parameters From 
Radio in the menu bar. Encryption parameters cannot 
be uploaded for security reasons. Refer to Section 3.3 
for more information.

2. Be sure the correct radio type (such as the 53xx 
mobile or 51xx portable) is selected by the Radio > 
Series menu (see Section 3.2).

3. With trunked operation, the correct system key must 
be selected on the Per system screen. Refer to 
Section 13 for more information.

NOTE: Some operating protocols and options may not 
be available with your radio. To display the options 
that have been factory enabled, select Transfer > Read 
Options From Radio (see Section 3.3).

2.2 CREATING SYSTEMS

A conventional system is automatically set up 
when a new programming file is created. Create the 
desired number and type of Conventional, 
SMARTNET, SmartZone, and/or Project 25 Trunked 

systems by selecting Radio > Add System or  in 
the toolbar. Refer to Section 1.10 for more informa-
tion. NOTE: The Per System screen must be selected 
to view the current systems. 

2.3 ENTERING GLOBAL PARAMETERS

1. Display the Global Parameter screen by clicking the 
Global tab at the top of the screen.

2. Program the applicable parameters in this screen as 
described in Section 4. Parameters that do not apply 
to the selected Radio Series are grayed out.

2.4 ENTERING RADIO WIDE PARAMETERS

1. Display the Radio Wide screen by clicking the 
Radio Wide tab at the top of the screen. 

2. Program the applicable parameters for all Conven-
tional, SMARTNET/SmartZone, and/or Project 25 
Trunked systems as described in Section 5.

NOTE: The Radio Wide Scan List cannot be 
programmed until the channels are set up as described 
in the next section.

2.5 SETTING UP ZONES AND CHANNELS 

1. Display the Zone screen by clicking the Zone tab at 
the top of the screen. 

2. Set up Zones and Channels as described in 
Section 6. Zones can include up to 16 channels of 
any type from any system.

2.6 ENTERING CONVENTIONAL SYSTEM AND 
CHANNEL PARAMETERS

NOTE: If no conventional channels are programmed, 
proceed to Section 2.7.

1. Display the system programming screen by clicking 
the Per System tab at the top of the screen. 

2. Select the system in the left pane and program the 
applicable parameters for each Conventional system 
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as described in Section 7.1. NOTE: It may be neces-
sary to further define the channels as described in 
the next steps before programming the standard 
scan lists.

3. Display the Zone screen by clicking the Zone tab at 
the top of the screen. Program the individual 
channel information of each Conventional channel 
in each zone as described in Sections 7.3 and/or 7.4. 

4. If necessary, program the priority scan lists in each 
system (see preceding step 2). After all channel 
information is programmed, program the Radio 
Wide scan list in the Radio Wide screen (see
Section 2.4).

2.7 ENTERING SMARTNET/SMARTZONE 
SYSTEM AND CHANNEL PARAMETERS

NOTE: If no SMARTNET or SmartZone channels are 
programmed, proceed to Section 2.8.

1. Display the system programming screen by clicking 
the Per System tab at the top of the screen. Make 
sure the correct System Key is selected as described 
in Section 13.

2. Select the system in the left pane and program the 
applicable parameters for each SMARTNET and 
SmartZone system as described in Section 8.1. 
NOTE: It may be necessary to further define the 
channels as described in the next steps before 
programming the various system lists.

3. Display the Zone screen by clicking the Zone tab at 
the top of the screen. Program the individual 
channel information of each SMARTNET and 
SmartZone channel in each zone as described in 
Section 8.3. 

4. If necessary, program the system lists (see preceding 
step 2). After all channel information is 
programmed, program the Radio Wide scan list in 
the Radio Wide screen (see Section 2.4).

2.8 ENTERING PROJECT 25 TRUNKED SYS-
TEM AND CHANNEL PARAMETERS

NOTE: If no Project 25 Trunked channels are 
programmed, proceed to Section 2.9.

1. Display the system programming screen by clicking 
the Per System tab at the top of the screen. Make 
sure the correct System Key is selected as described 
in Section 13.

2. Select the system in the left pane and program the 
applicable parameters for each Project 25 Trunked 
system as described in Section 9.1. NOTE: It may be 
necessary to further define the channels as 
described in the next steps before programming the 
priority scan lists.

3. Display the Zone screen by clicking the Zone tab at 
the top of the screen. Program the individual 
channel information of each Project 25 Trunked 
channel in each zone as described in Section 9.3. 

4. If necessary, program the priority scan lists in each 
system (see preceding step 2). After all channel 
information is programmed, program the Radio 
Wide scan list in the Radio Wide screen (see
Section 2.4).

2.9 PROGRAMMING RADIO (WRITING FILE)

When all the required programming information 
has been entered in the various programming screens, 
the information can be written (downloaded) into the 
radio. When writing a file, be sure that all connections 
between the computer and radio are secure, the radio is 
turned on, and the proper serial port is selected (see 
Section 3.3). Then proceed as follows:

1. Select Transfer > Write Parameters To Radio from 
the menu bar.

2. If no file is currently loaded, a dialog box appears to 
select the desired file. Otherwise, the current file is 
transferred to the radio. 
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SECTION 3   MENUS, TOOLBAR, AND STATUS BAR

3.1 FILE MENU

New - Creates a new programming file named
“Untitled.rcf” containing default parameters and 
displays a dialog box for selecting the frequency 
range.

Open - Opens a programming file that was previously 
saved to disk. If a modified file is currently open, you 
are asked if that file should be saved before the new 
file is opened.

Save - Saves the current file to disk using the current 
file name. If it is the first time a New file is being 
saved, the following Save As screen is displayed to 
specify the file name and destination.

NOTE: It is no longer possible to save any type of new 
programming file to disk without a radio connected. 
Refer to Section 15 for more information.

Save As - Saves the current file to disk and displays a 
screen for selecting a file name and destination if 
desired. The default file name is the P25 Unit ID in the 
format “UnitID_xx”.

Close - Closes the current file without exiting the 
program so that another file can be opened or created 
if desired. If the current file has been modified and the 
changes have not been saved, you are asked if the 
changes should be saved before closing.

Send to Selected Organizer Group - Adds the 
current file to the group that is selected in the 
Organizer. Refer to Section 3.8 for more information.

Print - Prints the information in the current file. A 
screen is displayed to select if Global, Radio Wide, Per 
System, and/or Zone information is printed.

Convert Band - If the current file type is UHF 380 
(selected when it is created by File > New), this can be 
used to change it to the UHF LO type and vice versa. 
Likewise, it can be used to convert an 800 MHz file to 
700/800 MHz and vice versa.

Exit - Closes the PCConfigure program. If the current 
file has been modified and the changes have not been 
saved, you are asked if the changes should be saved 
before closing.

3.2 RADIO MENU

Series - Selects the specific radio being programmed. 
Only parameters which apply to that radio are then 
displayed and others are grayed out. 

Add System - Adds a new Conventional, 
SMARTNET, SmartZone, or P25 Trunking system as

Radio Menu
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described in Section 1.10. “Multi-Net” is available 
with ASCEND radio models only.

Delete System - If two or more systems have been set 
up, this function deletes the system that is currently 
selected in the Per System screen.

Load System Keys - Allows the system keys to be 
loaded from a folder other than the default “Keys” 
folder. A dialog box is displayed to select the desired 
folder. Refer to Section 13 and “Preferences” in 
Section 3.4 for more information.

View Programmed Radio Wide Functions (All 
Protocols) - Displays the screen shown below which 
indicates the functions that have been assigned to the 
programmable option buttons on the Radio Wide 
screen (see Section 5.4). These buttons can be 
programmed for a different function in each mode 
(conventional, SMARTNET/SmartZone/P25 
Trunked). Up to two modes selected by the drop down 
lists are displayed.

3.3 TRANSFER MENU

NOTE: To stop a data transfer in progress, click  
in the toolbar (see Section 3.6).

Comports - Displays a dialog box which selects the 
serial port used to program the transceiver (see Section 
1.1). The default is COM1, and the last selected port is 
saved and then automatically reselected whenever the 
program is started. Ports 1-12 can be selected. Refer to 
Preferences in Section 3.4 for more information.

Transfer Menu

Baud Rates - Select 9600 baud for standard program-
ming of the 7780 portable, 9883 mobile, and 5300 
mobiles with the Rev 4 logic board. All 5100 portables 
and all 5300 mobiles with Rev 6 or later logic boards 
use the 19200 baud rate. DSP and ARM code download 
functions can be performed at the higher baud rates. 
The default baud rate is 19200. Refer to Preferences in 
Section 3.4 for more information. 

Read Parameters From Radio - Transfers the infor-
mation programmed in a transceiver into a new 
programming file. If the current file has not been 
saved when this function is selected, a dialog box is 
displayed to allow it to be saved if desired. The trans-
ferred data can be viewed, edited, or saved to a disk 
file as desired. An upload password may have to be 
entered. Refer to Section 10 for more information.

Write Parameters To Radio - Programs the trans-
ceiver connected to the computer with the data in the 
current programming file. A download password may 
have to be entered. Refer to Section 10 for more 
information.
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NOTE: Later 51xx/53xx models have safeguards to 
prevent unauthorized cloning. Refer to Section 15 for 
more information.

Write DSP Code To Radio - Reprograms early 5300 
radios (see Section 16) and also 9883 radios with 
updated DSP operating code (see following).

Write Application Code to Radio - Programs all 
53xx and 51xx radios with updated firmware (oper-
ating software). With “F” and earlier 5300 radios, this 
code is referred to as ARM code. 

NOTE: This version of PCConfigure and later can be 
used only to upgrade radios to the latest release or 
later of radio firmware (refer to Section 1.12).

Proceed as follows:

1. A special computer file containing the operating 
code must be obtained from EFJohnson. The 
Application code has a “.hex” extension, and the 
5300 DSP code (if applicable) has an “.out” 
extension. With all 51xx models, copy the .hex 
file to the PPC\5100 folder of the PCConfigure 
program, and with later 53xx models, copy it to 
the PPC\5300_i folder. With early 53xx ARM 
models, copy the .hex file to the ARM\5300 
folder, and the .out file to the DSP\5300 folder. 
Other locations can also be used if desired.

2. Put the radio in the firmware programming mode 
as follows. 

53xx - Turn power on with the special Flash 
Mode Select Plug, Part No. 023-5300-010, 
plugged into the microphone jack. Alternately, 
short pin 3 to 7. With the HHC, plug it into the 
programming adapter plug that is plugged into 
the junction box programming connector.
51xx - Turn power on with the option button 
above the PTT switch pressed.
98xx - Turn power on with the PTT sw pressed.

3. Select the 115,200 baud rate with the 5100 and 
the 57,600 rate with the 5300.

4. If applicable, make sure that the radio is 
connected to the computer and then select this 
function. Enter the password (obtained from the 
E.F. Johnson Company) in the screen that is 
displayed and click the OK button.

NOTE: The Boot Loader code may need to be 
updated in addition to the Application code. The 
Boot code is then updated first. The Boot Loader 
utility is selected by one password and the Applica-
tion utility by another (see Section 1.12).

5. The following screen is then displayed. Select the 
loader and code files if required by clicking the 
“Change” button. The loader file is included with 
PCConfigure software. In some cases, an updated 
loader file may be required and would then need 
to be selected instead of the included loader file. 
The application code file should be in the folder 
selected in step 1.

6. Click the Start button to begin code downloading 
(try clicking Start again if a failure occurs). Writing 
may require 20 minutes or more. With the early 
53xx, repeat for DSP code if applicable.

NOTE: After downloading is complete, perform “Read 
Parameters From Radio” and then “Write Parameters 
To Radio” to ensure that the file format is correct.

Read Version Info From Radio - Transfers version 
information on the software the radio contains and 
then displays it as shown below.
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Figure 3-1   Transfer > Read Options Screen (5300 Shown)

Read Options From Radio - Displays information on 
which options have been enabled in the radio as shown 
in Figure 3-1. The check boxes indicate which options 
are enabled. They are for informational purposes only 
and cannot be edited.

The “Update Options” button is used to add additional 
options that have been purchased for the radio. An 
encrypted data file keyed to the radio serial number is 
provided to unlock these options. This file has an 
“.opt” extension and is selected and downloaded by a 
screen that is displayed when this button is clicked.

Read/Write IP Address (5100 only) - This function 
is not used because an Ethernet link to the radio is 

currently not supported. It displays the preceding “IP 
Address” screen which reads/edits the IP address 
stored in the radio. 

Read/Write Spur Frequencies (7780 only) - 
Displays the following “Spur Frequencies” screen 
which is used to read and write spurious frequencies. 
When a frequency in this table is selected by the radio, 
the internal crystal frequency is shifted slightly to 
minimize receive noise caused by these signals.
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3.4 TOOLS MENU

Toolbar Options - Displays the following dialog box 
which is used to select the icons that are displayed in 
the toolbar (see Section 3.6). When the “Custom” box 
is checked and highlighted, the additional window 
shown below is displayed to select which icons to 
display. The last selected configuration is saved and 
then automatically reselected when the program is 
restarted.

Organization Identity - Displays the following 
screen which can be used to display a unique company 
title and logo on the programmer screen. To display a 
unique company name, enter the desired name in the 
“Organization’s Name” box in this screen. It is then 
displayed after “Radio Configuration” at the top of the 
screen (see Figure 1-3).

A logo is displayed on the right end of the toolbar, and 
when a radio read or write operation is occurring, this 

logo changes. To display the default logo, check the 
Use Default box. To display a custom logo, create a 
bitmap file of the desired graphic that meets the 
following requirements. A photo editing program such 
as Photoshop® or Paint Shop Pro® can be used.

• 53 W x 22 H pixels 
• .bmp file format
• 256 colors or higher recommended
• Up to 30 files can be created named Logo1.bmp, 

Logo2. bmp, and so on up to Logo30.bmp. These 
graphics are then displayed in rapid succession 
during a radio read or write operation.

Password Management - Displays the following 
screen which is used to enable, disable, and change 
radio passwords. A radio must be connected to display 
this screen. Actual passwords are never displayed in 
this screen. Passwords, no matter what the length, are 
always represented by eight asterisks (********).

NOTE: This is a new feature available only with later 
51xx and 53xx radios with updated firmware. The 
power-up password previously programmable on the 
global screen with earlier models can be programmed 
in those models only with PCConfigure, Version 1.21.6 
or earlier. Refer to Section 10 for more password 
information.

User - This drop down list selects the particular 
password being changed as follows

User 1, User 2, User 3, User 4 - Up to four different 
power-on passwords can be programmed. 
Currently, the same user features are available with 
each.

Incorrect
Password
Indicator
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Upload, Download - These passwords are required 
to Upload (read) or Download (write) program-
ming parameters. A preceding “User” password is 
not required to upload or download parameters.

Master - This password overrides all the other pass-
words. It can be used by a system administrator or 
if any of the above passwords are lost.

Selected User - This box indicates status of the 
selected password (Enabled or Disabled). The Pass-
word box always indicates eight asterisks and is not 
editable.

Proceed as follows to set up or change a password. 
Passwords must be 1-8 characters in length and 
consist of numbers 0-9. Zeros are valid characters in 
any location, even as leading characters.

Changing a Password

NOTE: To enter a password, click the first asterisk 
or select all eight asterisks. If an incorrect pass-
word is entered, a red “!” exclamation point is 
displayed to the right of the box (see preceding 
screen) and the password must be re-entered.

1. Select the password in the drop down list.

2. If the password was previously set up, enter the 
current password in the Original/Master box.

If this is the first time the password is used, it 
initially consists of null (deleted) characters. In 
this case, do not enter anything in this box.

3. If the password is simply being enabled or 
disabled, click the appropriate Enable or Disable 
button. Proceed to step 6.

4. If the password is being changed or initially set 
up, enter the new password in the New Password 
box and then re-enter it in the Re-enter New Pass-
word box to confirm it. Click the Change button.

5. Repeat for other passwords as required.

6. To exit without sending the change to the radio, 
click the Cancel button. To exit and send the 
change to the radio, click the OK button.

Preferences - Displays the following screens which 
set several program preferences.

PCConfigure Screen

On New

When “Always” is checked, a programming file 
with the Radio Series and Band selected by the 
drop down lists is automatically created in a single 
step by File > New or the  button. However, the 
Band of a file then cannot be changed, so only files 
with the selected Band can be created. If this is not 
checked, the Band is selected in a separate step 
before the file is created (see following).

On Exit

When checked, the parameter is restored to the 
current condition when the program is restarted. 
Otherwise, the default is selected. Note that the 
first two parameters are overridden by the 
preceding “On New- Always” if it is checked.

Remember Series - The current Radio Series is 
automatically selected whenever a new file is 
created by selecting File > New or the  
button. If this is not selected, “5300” is the 
default.

Remember Band - The current frequency Band 
is highlighted (and can be changed if desired) 
when the Band select screen is displayed by 
selecting File > New or the  button. If this is 
not selected, “VHF” is the default.
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Remember Baud Rate - The currently selected 
baud rate is automatically reselected (see Section 
3.3). If this is not selected, “19200” is the 
default.

Remember Keys Directory - The currently 
selected key directory is automatically rese-
lected. If this is not selected, the “Keys” folder is 
the default (see “Load System Keys” in Section 
3.2).

General

Use Hexadecimal Input - When selected, all 
applicable numbers are entered in Hexadecimal 
format instead of Decimal format. All Hexadecimal 
numbers are indicated by an ivory-colored back-
ground. Refer to Section 1.9.4 for more 
information.

“Other” Screen

Serial Communication

Send/Get Delay - Allows a serial port delay of 
0-18 (x 56 ms) to be programmed. This delay may 
need to be programmed with computers which are 
slow to respond to serial port signals. If the soft-
ware times out during read/write operations, try 
increasing this delay. In the large majority of cases, 
the default level of “0” (no delay) should be 
selected. 

3.5 HELP MENU

Contents - Displays the help system table of contents.

About Configuration Software - Displays the PC
Configure version number and company information.

3.6 TOOLBAR

The tools in the toolbar provide quick access to 
many menu functions. The tools that are displayed are 
selected by the Tools > Toolbar Options menu 
described in Section 3.4. The Standard, Transfer, Help, 
and Custom tools can be turned on and off by this 
menu. 

3.6.1  STANDARD TOOLS

Refer to Section 3.1 for more information on 
these functions.

 New - Opens a new programming file containing 
default parameters.

 Open - Loads a file from disk. Clicking the 
down arrow displays a drop-down list of recently 
loaded files.

 Save - Saves the current file to disk.

3.6.2  TRANSFER TOOLS

Refer to Section 3.3 for more information on 
these functions.

 COM Port - Selects the serial port used to 
connect the radio to the computer.

 Read Parameters From Radio - Transfers data 
from the radio to a new programming file. 

 Write Parameters To Radio - Programs the 
radio with the data in the current programming file.

 Stop Data Transfer - Cancels the data transfer 
in progress.

3.6.3  HELP TOOLS

 Help - Displays help information.

 Manual - Reserved for future use.
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Status Bar
InformationDecimal/Hexadecimal Indicator

3.6.4  CUSTOM TOOLS

 Add System - Adds a new system. Clicking 
the down arrow displays a drop-down list of the 
system types that can be added.

 Delete System - When the Per System screen is 
displayed, clicking this button deletes the selected 
system.

 Edit Zones and Channels - Displays the Edit 
Zones and Channels screen. 

 Edit Radio Wide Scan List - Displays the Radio 
Wide Scan List edit screen.

 Read Version From Radio - Reads version 
information from the radio for the software it contains 
and then displays that information.

 Read Options From Radio - Reads option 
information from the radio and then displays it. 

 Write DSP Code To Radio - Programs 98xx and 
early 53xx models with new DSP software.

 Write Application Code To Radio - Programs 
the radio with new Application/ARM software.

3.7 STATUS BAR

The status bar which shown above indicates the 
following information:

Band - The frequency band of the file. This is selected 
when a new file is created by the File > New function.

Series - The Radio Series of the file selected by the 
Radio > Series function.

File - The file name of the current programming file. 
This name is specified the first time the file is saved by 
the File > Save function or it can be changed by the 
File > Save As function.

Size - Indicates the percent of the available memory 
space that would be used if the radio was programmed 
with the current file (see Section 1.9).

D/H Box - Indicates if the Decimal or Hexadecimal 
number format is selected (see Section 1.9.4).

Information - Displays a short description of tools in 
the toolbar when they are selected by the cursor.

Organizer Screen

3.8 ORGANIZER

Clicking the organizer button  on the right 
end of the toolbar toggles the preceding screen which 
can be used to organize a large number of program-
ming files into groups and subgroups for easier identi-
fication when administering a large organization. 

NOTE: This organizer does not add, delete, or move 
programming files on the hard drive. It simply orga-
nizes those files into logical folders and subfolders.

Groups are indicated by a folder symbol , 
and programming files are indicated by a  symbol. 
A  symbol next to an item indicates that the branch 
is expanded, and clicking it collapses the branch. Like-
wise, a  symbol indicates that the branch is 
collapsed, and clicking it expands the branch. If a file 
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in the organizer has been deleted from the hard drive, 
it is indicated by a red “X” through the icon .

1. To add the current programming file to the Orga-
nizer, select the desired Group in the Organizer and 
then select the File > Send to Selected Organizer 
Group menu item (see Section 3.1). To add other 
files, see step 3.

2. To open a file listed in the Organizer, simply double 
click it, drag it to the main programmer screen, or 
select “Open” as described in the next step.

3. To add, edit, delete, or move a group or file, right 
click the applicable group or file and the following 
screen is displayed.

Open - Opens the selected file. If the current file has 
not been saved, you are asked if you would like to 
save it first.

Add Group - Adds a new group below the selected 
location.

Add File(s) - Displays a screen that is used to select 
a file on the hard drive to add to the selected location.

Delete Group - Deletes the selected Group from the 
Organizer only (the actual files on the hard drive are 
not deleted).

Delete File - Deletes the selected File from the Orga-
nizer only (the actual file on the hard drive is not 
deleted).

Show Full Path - Displays the entire path name of the 
file on the hard drive.

Cut - Moves the selected Group or File to the 
clipboard.

Copy - Copies the selected Group or File to the 
clipboard.

Paste - Copies the current file on the clipboard to the 
selected location

Rename - Renames the selected Group. Files cannot 
be renamed from the Organizer.
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GLOBAL SCREEN PARAMETERS

SECTION 4   GLOBAL SCREEN PARAMETERS

Figure 4-1   Global Parameter Programming Screen

4.1 INTRODUCTION

The Global screen shown in Figure 4-1 programs 
parameters that are the same for all systems, channels, 
and zones. Only parameters that apply to the selected 
Radio Series are displayed and the others are grayed 
out. The parameters in this screen are as follows:

NOTE: Passwords have changed and are no longer 
programmed on this screen. Refer to Sections 3.4 and 
10 for more information.

4.2 PARAMETER DESCRIPTION

Systems

Displays the number of systems that have been 
created as described in Section 1.10. 

Zones (A zone is a programmed collection of up 16 
channels of any type.)

Number of Zones - The total number of zones 
currently set up. The maximum number allowed 
is 16. Zones are created in the Zone > Edit Zones 
screen by clicking the “+” button (see Section 6.2).

Home Zone - Selects the zone that is selected by the 
Home Zone option function button (if programmed).

Power Up In - Selects if the transceiver powers up on 
the Home or Last Selected zone. 

Power Up Zone - When data is uploaded from a 
radio, this number indicates the power-up zone in the 
radio. It does not change until the current data is 
downloaded and then uploaded again.

Channels

Home Channel - Selects the channel that is selected 
by the Home Zone function button (if programmed) 
and when the transceiver powers up on the Home 
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zone. With the 51xx, this is selectable only if the 
channel selector switch is disabled (see “Channel 
Selector Enabled” parameter on page 26). 

Power Up In* - Selects if the Home or Last Selected 
channel is selected on power up. With the “Last 
Zone”/“Home Channel” power up configuration, the 
programmed home channel number of the last active 
zone is selected. If that channel number is not 
programmed in the active zone, “Unprogrammd” is 
displayed. With the 51xx/Ascend portable, only 
“Home Channel” is available if the channel selector 
switch is enabled. 

Power Up Channel - Indicates the power-up channel 
in the radio similar to the power-up zone just 
described. 

Global Emergency Channel

Selects the zone and channel on which all emergency 
calls and alarms are transmitted regardless of the 
type of channel currently selected. For example, if 
the global emergency channel is a conventional 
channel and a trunked channel is selected when the 
emergency is initiated, it is transmitted on the 
conventional global emergency channel.

Cursor (53xx/Ascend Mobile Only)

Cursor Time-Out - Programs the time delay that 
occurs before the cursor (zone or channel select indi-
cator) returns to the default position programmed in 
the next parameter. Times of 0-255 seconds can be 
programmed (“0” selects no return).

Cursor Position - Selects if the Zone or Channel 
select mode is enabled when power is turned on and 
after the preceding time-out period expires.

Battery Saver (Portables Only)

If this is checked, 51xx/Ascend and 7780 portables 
automatically switch to the low transmit power mode 
when the RSSI signal indicates the site is probably 
nearby (when operating in the SMARTNET/Smart-
Zone or P25 trunked modes only).

Low Battery Indicators (Portables Only)

Low Battery Beep - When checked, a short tone 
sounds periodically in the standby mode while a low 
battery condition is being detected.

Tx Chirp - When checked, a chirp sounds each time 
the PTT switch is pressed while a low battery condi-
tion is being detected.

LED Indicator - When checked, the LED on the top 
panel indicates a low battery condition. For example, 
the 51xx indicator flashes red in the receive mode. 

Low Power - When checked, low transmit power is 
automatically selected while a low battery condition 
is being detected.

Ignition Power Down (Mobiles Only)

When the ignition switch controls transceiver power, 
this sets the delay that occurs between when the igni-
tion switch is turned off and when transceiver power 
actually turns off. Times of 0-254 minutes or an 
infinite time (no turn-off) can be selected.

Soft Power Down (51xx/Ascend Portable Only)

The soft power down feature prevents radio power 
from being turned off by accidentally turning the top 
panel on-off/volume control. Any side option button 
can be programmed for this function (in addition to 
its normal function). Then for power to turn off, this 
button must be pressed during or just after power is 
turned off by the on-off/volume control. 

Sound

Alert Tone On - If checked, all supervisory tones 
sound. If not checked, no tones sound.

Horn Cadence (53xx/Ascend Mobiles Only) - 
Programs the following styles when the horn alert is 
enabled by the horn alert option switch. Repeating 
does not occur with either style.

Style 1 - The horn is on for 1 second and off for 
0.5 second for three cycles.

Style 2 - The horn sounds continuously for the 
programmed time (2-255 seconds).

* This feature available only in 51xx models with Flash code 1.9.0 or 
later and (if applicable) 53xx models with ARM code 1.22.0 or later.
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Minimum Volume (Mobiles and 51xx/Ascend 
Portable) - Sets the minimum volume level that can 
be selected by the volume control. This can be used 
to prevent missed messages caused by inadvertently 
turning the volume down too far. Relative levels of 
0-255 can be set in steps of 1 (“0” sets the lowest 
minimum volume).

Tone Volume - This adjusts the alert tone volume 
level relative to the volume control setting. This can 
also be done by a Tone Volume Edit option button if 
programmed. Changes made by this button perma-
nently override this setting. Relative levels of –170 to 
+170 can be set in steps of 1 (“0” is the standard 
default setting). 

 Mic Levels - Displays the following 
screen which sets the microphone sensitivity for 
various types of calls. Relative levels of 0 (less 
sensitive) to 4 (most sensitive) are set for Analog, 
Digital, and SecureNet® (encrypted) calls with “4” 
the default. This can only be set with 51xx models 
which have Version 1.6.0 or higher Flash code, and 
53xx models must have Version 1.38.0 or higher 
DSP code (or any 2.x/3.x code with both models). 

Key Management

This section of the screen has been moved to 
Page 2 described in Section 4.3.

Keypad (Portables Only)

Keypad Type - Selects if the portable being 
programmed has a Full DTMF Keypad or a Limited 
Keypad (without the 0-9, *, # DTMF keys).

Permanent Keypad Lockout* - If checked, the front 
and side panel keys are permanently disabled and 
cannot be re-enabled by the user. If the “Front Only 
Keypad Lockout” parameter which follows is 
selected, only the front panel keys are permanently 
disabled and the side panel keys can still be used. 

Lock Channel Selector* - When checked, the top 
panel channel selector switch is also temporarily 
locked by the Keypad Lockout function. When not 
selected, it remains functional when the keypad is 
locked. To totally disable this control, do not select 
“Channel Selector Enabled” which follows. 

Lock Volume Knob* - When checked, the top panel 
volume control function (but not on-off) is also 
temporarily locked by the Keypad Lockout function. 
When not selected, it remains functional when the 
keypad is locked. To totally disable this control, 
program an Up/Down volume button (see following 
“Volume Ticks” parameter).

Front Only Keypad Lockout* - This controls the 
keys that are disabled by the preceding Permanent 
Keypad Lockout function and the Keypad Lockout 
option button if programmed. If neither or these 
functions are used, checking this parameter has no 
affect. If checked, the front panel keys are disabled 
but the side panel keys remain active. If not checked, 
both the front and side panel keys are disabled. 

Backlight During Keypad Lockout* - When checked 
the backlight turns on normally when a key is pressed 
with the keypad is locked (if Backlight on Keypress 
which follows is enabled). If not checked, the back-
light is also disabled when the keypad is disabled. 

Other

Hang-Up Box Monitor (Mobiles Only) - When 
checked, enables microphone off-hook detection. 
Taking the microphone off-hook then enables the 
monitor mode (conventional only) and disables
scanning. When not checked, taking the microphone 
off-hook has no affect on these functions.

Backlight on Keypress (Portables Only) - If checked, 
the backlight turns on for the Backlight On Time 
whenever a key is pressed.

Programmed Channels Only on Display (53xx 
Only) - If checked, only programmed channels can 
be selected, and if not checked, all channels are 
displayed. When an unprogrammed channel is 
selected, “UNPROGRAMD” is indicated and a tone 
sounds. 

* This operation applies only to models with firmware Version 
1.16/2.6/3.6/4.2 or later. Earlier versions may be different.
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Backlight On Time (Portables Only) - Programs the 
length of time in seconds that the backlight stays on 
after it is enabled by pressing a key (see preceding). 
Times of 0-7.5 seconds in 0.5-second steps can be 
programmed. When it is turned on by the option 
switch or menu parameter, it stays on.

Backlight Level (Mobiles Only) - Selects the back-
light brightness as Off, Mid, or High whenever 
power is on. This setting can be overridden by the 
Backlight option switch if it is programmed.

Controller Type (53xx Only) - Selects the type of 
control head being used. “Normal” is selected with 
the standard front or remote mount control head, and 
“Handheld” is selected with the Handheld Control 
Unit. 

Volume Ticks (51xx Only)* - When a Volume Up/
Down button is programmed on the Radio Wide 
screen for a particular system type, the volume 
control is disabled when a channel programmed for 
that system type is selected. This then selects the 
number of button presses (ticks) required to change 
from minimum to maximum volume. From 1-50 
steps can be programmed. See also preceding “Lock 
Volume Knob” parameter.

Menu Enabled (51xx Only) - Enables the menu mode 
with 51xx portables. The F1 and F2 keys then 
become menu exit and select keys instead of 
programmable option keys. If this parameter is not 
selected, the menu mode is not available and F1 and 
F2 are programmable option keys.

Channel Selector Enabled (51xx Only) - Enables the 
channel select knob in the top panel. If this is not 
checked, the channel select knob is permanently 
disabled and channels can be selected only by the 
Channel Select option button or menu parameter. See 
also preceding “Lock Channel Selector” parameter.

Ignore Clear/Secure Switch When Strapped** - 
When selected, the mode selected by the switch (or 
menu parameter with the 51xx) is ignored and the 
transmission always occurs in the strapped mode. In 
addition, the error tone and “Sec Only” or “Clear 
Only” are not indicated when the switch is selecting 
a different mode than what is strapped.

NOTE: If all channels/talk groups are strapped 
Clear or Secure and no Clear/Secure option switch 
or menu parameter is used, this parameter must 
always be selected (see following). 

Without the Clear/Secure switch or menu parameter, 
the radio is always in the last known state (usually 
Clear) and there is no way to change it. For example, 
if the last known state is Clear and this parameter is 
not selected, it is never possible to transmit a Secure 
message on a channel strapped Secure because all 
that happens is transmitting is disabled, an error tone 
sounds, and “Sec Only” is displayed.

Surveillance Mode - Disables the transmit/receive 
LED indicator, display and keypad backlight, and all 
alert tones. This provides a quick way of totally 
disabling these functions in all operating modes. It 
overrides any other programming of these functions 
such as a Tone or Backlight option switch. A transmit 
icon in the display indicates the transmit mode when 
the LED indicator is disabled by this mode (51xx, 
code version 1.16/2.6/3.6/4.2 or later only). This icon 
is displayed only in the Surveillance mode, and it is 
displayed for all call types.

LED Disabled w/Backlight Off (5300 Only)*** - 
When selected, the front panel transmit indicator is 
disabled whenever the display backlight is off. If it is 
not checked, this indicator operates normally regard-
less of the backlight state (except when the surveil-
lance mode is selected).

* This feature available only in 51xx models with Flash code Version 
1.11.0 or later and 53xx models with ARM code 1.24 or later.

** This feature available only in 51xx models with Flash code Version 
1.9.0 or later and 53xx models with ARM code 1.23 or later.

*** This feature available only with code Version 1.24.1/2.2.1/
3.2.1 or later.



GLOBAL SCREEN PARAMETERS

27

Figure 4-2   Global Screen (Page 2)

4.3 PAGE 2 GLOBAL SCREEN DESCRIPTION

A second Global screen shown above is opened/
closed by clicking the  buttons in the upper 
right corner of the screen. These additional parame-
ters are then displayed:

PA (53xx Only)

Rx Audio to External PA - Microphone audio is 
always routed to the Ext PA line of the accessory 
cable. If this parameter is selected, receive audio 
signal is also routed to this line. 

External PA Display Indication - If this is selected, 
“Ext PA On” is indicated continuously in the display 
when the external PA function is enabled by the Ext 
PA option button. If it is not selected, “Ext PA On/Off 
is flashed in the display when a button is pressed.

OTAR/Key Management

Unit RSI - This sets the individual Radio Set Identi-
fier of the radio that is used for OTAR (Over-the-Air 
Rekeying). This number is usually set to the Digital 
Unit ID, but other numbers can be programmed if 
desired. The allowed range is 1 - 9,999,999.

Key Management

The following modes select the method used to 
load and manage encryption keys. The Motorola 
keyloader has ASN and Astro 25 modes. The ASN 
mode can be used to load analog channel keys (DES/
DES-XL) only, and the Astro 25 mode can be used to 
load both analog and digital (DES-OFB/AES) channel 
keys. 

Mode - Select the PID/ASN or SLN/CKR mode as 
follows. The keyloader function of the EFJohnson 
SMA (Subscriber Management Assistant) supports the 
SLN mode only. The Motorola keyloader can operate 
in only the ASN mode when PID/ASN is selected, and 
in either the ASN or Astro 25 mode when the SLN/
CKR mode is selected. 

PID/ASN Mode - Select this mode to load analog 
channel keys directly into a Key PID (Physical ID) 
from 0-15. Digital channel keys cannot be loaded 
in this mode, OTAR (Over-The-Air-Rekeying) is 
not available, and the Keys Table is not used. 

SLN/CKR Mode - Select this mode to load keys 
into a SLN/CKR location from 1-4095 instead of a 
Key PID location from 1-16. This mode must be 
selected to program the radio for OTAR. Up to 16 
SLNs are specified, and the following key (alias) 
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table links each SLN to a Key PID. SLN (Storage 
Location Number) and CKR (Common Key Refer-
ence) are equivalent terms.

 - Clicking this button displays the 
following screen which associates Key PIDs 1-16 
with the SLN/CKRs from 1-4095 specified when the 
key is loaded. This table must be programmed if the 
preceding SLN/CKR mode is selected. The SLN/
CKR number points to a specific key or key slot (of 
both keysets is using OTAR). The 10-character Key 
Alias is displayed briefly by the radio when transmit-
ting, changing channels, and switching between the 
clear and secure modes.

OTAR Keys Table Screen

Infinite Key Retention* - If “On” is selected, keys 
are stored in memory and are not lost when power is 
removed. If “Off” is selected, the keys are main-
tained with power removed only until the storage 
capacitance discharges (approximately 8 hours with 
a 53xx mobile and 30 seconds with a 51xx portable).

Erase Keys on Keyset Change (OTAR Only) - If this 
is selected, the keys in the original keyset are erased 
when the OTAR Changeover command or the Keyset 
option switch is used to select the other keyset. If this 
not selected, the keys in the original keyset are not 
erased when this occurs.

Emergency Man Down (51xx Only)**

The Emergency Man Down feature automatically 
selects the emergency mode if the radio remains in a 

horizontal position for the programmed time. The 
emergency mode selected by this feature functions 
the same as if the emergency button had been 
pressed. An optional man-down device must be 
attached to the accessory port of the radio, and this 
feature must be selected. The timer can be 
programmed for 0-63 seconds, and it resets if the 
radio is moved back to a horizontal position. The 
emergency mode can be canceled by pressing the 
emergency button. 

GPS (53xx Only)

This feature is currently not available. It programs a 
GPS feature that can be used with other equipment to 
determine the geographical location of the subscriber 
unit. 

Other (53xx Only)

Auxiliary B Output - Determines the function 
controlled by Pin 4 output of the accessory 
connector: 

Backlight - When the Siren option is used, the 
control head backlight also controls the Siren 
Controller backlight.

Horn - Controls an external horn alert.

Site Trunking - Controls an external site trunking 
indication of some type with SmartZone and P25 
trunked operation. This feature is available only 
with code Version 1.26.0/2.4.0/3.4.0 or later.

Disabled - The output is nonfunctional.

Auxiliary B Input - Determines the function 
controlled by Pin 8 input of the accessory connector:

PA Broadcast - Selected with the Transit Bus PA 
option only to allow the public address function to 
be selected by an external switch.

Ext Emergency - Selected if an external emer-
gency switch, such as a foot activated type, is used 
to activate an emergency condition (later model 
firmware only).

Disabled - The input is nonfunctional.

* This feature available only in 51xx models with Flash code Version 
1.11.0 or later and 53xx models with ARM code 1.19.0 or later.

** This feature available only in 51xx models with firmware 
Version 1.16/2.6/3.6/4.2 or later.
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RADIO WIDE SCREEN

SECTION 5   RADIO WIDE SCREEN

Figure 5-1   Radio Wide Conventional Screen

5.1 INTRODUCTION

The Radio Wide screen programs parameters that 
are the same for all Conventional, Project 25 Trunked, 
and SMARTNET/SmartZone systems (a different 
screen is displayed for each system type). These 
screens are shown in Figures 5-1, 5-3, and 5-4. 

5.2 RADIO-WIDE SCAN LIST PROGRAMMING

NOTE: For more information on how to set up radio 
wide and priority (std) scanning, refer to Section 1.11.

The radio-wide scan list cannot be programmed 
until all channels to be included in it have been set up 
in the Zone screens (see Section 6). The Radio Wide 
scan list is the same for all system types and can 
include up to sixteen channels from any system. This 
scan list is programmed by clicking the  
button on this screen or  in the toolbar. The 
following Radio Wide Scan List screen is then 
displayed.

To select the channels that are in the radio wide 
scan list, click the  button to display the 
Modify Scan List screen. Select the desired zones 
from the drop-down list and then check the channels to 
be included from each zone in the list. 

Radio-Wide Scan List Screens

Scan Talk Back Type

When a call is received while radio wide scanning, 
this determines if a response occurs on the Selected 
Channel or the channel of the call (Active Channel) 
when they are not the same.

Modify Scan List Screen
Radio Wide Scan List Screen
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Figure 5-2   Assign Function Buttons Screen (53xx Series Shown)

Click Button
Here To 

Program It

Scan Hold Time

When Radio Wide scanning is occurring, this 
programs the delay that occurs after a message is no 
longer being received or transmitted before scanning 
resumes. Times of 0 - 7.5 seconds can be programmed.

5.3 MENU ITEMS PROGRAMMING (51XX 
ONLY)

The menu function is available with 51xx porta-
bles only. The menu mode can be user selected if the 
“Menu Enable” box on the Global screen is checked. 
Clicking the  button displays the 
preceding screen which is used to select the functions 
that are selectable in the menu mode. To move a func-
tion to the other list, double click it or select it and 
click one of the single arrow buttons. Clicking a 
double arrow button move all items to the other list. 

A separate set of menu parameters can be 
programmed for each system type similar to the func-
tion buttons described in the next section. The system 
type being programmed is selected in the “System 
Specific” box of the Radio Wide screen. Functions can 
be controlled by both the menu and a function button 
if desired. The available 51xx menu functions are 
shown in Table 5-1.

5.4 FUNCTION BUTTON PROGRAMMING

Clicking  in the Radio Wide screen 
displays a screen similar to the one shown in 
Figure 5-2 that programs the function buttons for the 
radio selected by Radio > Series. 

Each button can be programmed with up to four 
different functions. One function can be programmed 
for Conventional systems, a second for SMARTNET/
SmartZone systems, a third for Project 25 Trunked 
systems, and a fourth for Multi-Net systems. The 
system type is selected in the “System Specific” box 
of the Radio Wide screen. The available 51xx/53xx 
option button functions are shown in Table 5-1.

NOTE: To view the functions programmed for each 
button in the various modes, select Radio > View 
Programmed Radio Wide Functions (see Section 3.2).

Program the function buttons as follows:

1. Click the white “Fx” button being programmed in 
the photo and a drop-down list is displayed showing
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Table 5-1   51xx/53xx Programmable Option Switch and 51xx Menu Mode Functions

Function
Available in Mode: 5100 Menu

DisplayConv. P25 Trk SMARTNET SmartZone
Alert tones On-Off X X X X Tones
Backlight On-Off (51xx), Hi/Med/Off (53xx) X X X X Backlight
Call Alert Select (Paging) X X X X Call Alert
Call Response Select X X X Call Rsp
Cancel Dynamic Regroup X X X Cancel DR
Change Keyset (OTAR) X X X X Chg Keyset
Channel Select X X X X Chan Selct
Clear/Secure Encryption Select X X X X Security
Clone Programming Select (51xx menu only) X X X X Clone
Configure (51xx menu only, not curr used) X X X X Config
Digital (P25) Talk Group Select X Select TG
Display GPS (53xx only, future availability) X -
Display Information Select (freq or chan disp) X Display
Emergency Mode Select X X X X Emergency
Erase Keys, OTAR (menu only w/51xx) X X X X Erase Keys
External Public Address (53xx only) X X X X -
High/Low Power Select X X X X Tx Power
Home Zone Select X X X X Home Zone
Horn Honk Select (53xx only) X X X X -
Key Select, OTAR X Key Select
Keypad Lock Select (51xx only) X X X X (Opt sw only)
Keypad Programming Select X Keypad Prg
Messaging Select X X X Message
Monitor Mode Select X Monitor
Normal/Selective Squelch Select X Squelch
OTAR Rekey Request X OTAR Rekey
P25 Packet Data X Data Modes
Phone Call Select X X X X Phone
Priority Channel Select X Priority
Private Call Select X X Priv Call
Radio Wide Scan Select X X X X RW Scan
Remote Access (Pyramid Repeater) 53xx only X X X X -
Repeater Talk-Around Select X Talk Arnd
RWS List Edit X X X X RWS Edit
Scan Mode Select X X X X Scan
Scan List Edit Select X X X X Scan Edit
Scan List Select X (5100 only) X X X Scan Selct
Set User Password X X X X Set Paswd
Squelch (Code) Select List X Sqlch Code
Single Tone Encoder (51xx only) X Tone Encdr
Site Lock Select X X Site Lock
Site Search Select X X Site Srch
Status Select X X X X Status
Surveillance Mode Select X X X X Surv Mode
Tone Volume Edit X X X X Tone Vol
Unit Call Select X X Unit Call
Unprogrammed (not used) X X X X -
Volume Down (51xx only) X X X X (Opt sw only)
Volume Up (51xx only) X X X X (Opt sw only)

NOTE: Several functions in this table are available only in 
radios with later versions of firmware. 
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* This feature available only in 51xx models with Flash code Version 
1.9.0 or later and 53xx models with ARM code 1.22.0 or later.

the functions that can be assigned (with the 51xx 
portable, almost all buttons are programmable).

2. To select a function, double click it in the drop-down 
list. The functions that have been assigned to each 
button are displayed in the bottom part of the screen.

3. Repeat for all function buttons that are to be 
programmed. Then click OK to exit and save the 
changes or Cancel to exit without saving the 
changes. Then select the other system type if 
applicable and repeat this procedure.

5.5 RADIO WIDE CONVENTIONAL 
PARAMETERS

Clicking “Conventional” in the “System 
Specific” box displays the screen shown in Figure 5-1. 
This screen programs the functions that are the same 
for all Conventional systems. Refer to Section 5.6 for 
information on programming SMARTNET/SmartZone 
systems, and to Section 5.7 for information on 
programming Project 25 Trunked systems. 

IDs

Digital Unit ID - When operating on a Project 25 
(digital) channel, this number identifies the radio. 
Each radio must have a different ID, and it must be 
between 1 and 16,777,216.

NOTE: The analog signaling type (DTMF or MDC) 
is selected on the Conventional Per System screen 
(see Section 7.1). The following DTMF IDs are used 
if DTMF is selected, and the MDC ID is used if 
MDC is selected (MDC is available only with 51xx 
portable models that have Version 4.x firmware).

DTMF PTT ID - The PTT ID is used on a channel 
programmed for pre- or post-transmit ANI if the 
system is programmed for the DTMF Analog 
Signaling Type (see Section 7.1). This ID consists of 
eight digits from 0-9. The ANI function is 
programmed on the channel screen described in 
Section 7.3 or 7.4.

NOTE: The Unit RSI is now programmed on the 
second page of the Global screen described in 
Section 4.3.

DTMF Emergency ID - This sets the ANI number 
transmitted if the “Emergency ANI Call” and/or 
“Emergency Alarm” analog emergency features are 
selected on the conventional Per System screen (see 
Section 7.1).

MDC ID - The ANI and Emergency Alert features of 
the Motorola MDC1200 data protocol are supported 
(by 51xx portable models that have Version 4.x firm-
ware only). This ID from 0-65535 is transmitted if 
the MDC Analog Signal Type is selected on the 
Conventional Per System screen, and ANI or Emer-
gency Alert is programmed. Emergency Alert and 
ANI parameters are programmed on the Per System 
screen, and ANI is enabled on the channel screen.

Clear Alert Tone - If checked, a short beep sounds to 
indicate that the clear (non-encrypted) mode is 
selected. This tone sounds with SecureNet and digital 
OFB encryption only.

Display Options

These functions select if anything is displayed 
alternately with the selected channel alias or frequency 
when Project 25 group calls are received. 

None - Only the selected channel alias or frequency 
is displayed.

Both (51xx/53xx only) - Both of the following are 
displayed.

P25 PTT ID (51xx/53xx only) - The ID of the mobile 
placing the call is displayed. The time this ID is 
displayed is programmable for 0.5-7.0 seconds* or 
infinite. When “infinite” is selected, this ID is 
displayed for the entire call and none of the other 
parameters are displayed.

P25 Talk Group on Rx (51xx/53xx only) - The alias 
of the talk group on which the call is being received 
is displayed. This can also be displayed for 0.5-7.0 
seconds* or infinite as just described.

User Group ID (51xx/53xx only)** - If the ID of the 
call being received is included in a User Group ID 
list (see page 45), the alias of that group is displayed.

** This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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Figure 5-3   Radio Wide SMARTNET/SmartZone Screen

This alias can also be displayed for 0.5-7.0 seconds 
or infinite as just described.

Show MON Icon When in Normal Mode* - If 
checked, the monitor indication in the display (  
with 51xx, MON with 53xx) turns on when the 
Normal mode is selected by the Normal/Selective 
option button or menu parameter (51xx only). If this is 
not checked, there is no continuous indication when 
this mode is selected. 

Clear Mode Alert on Secure Rx** - When this is 
selected, a beep sounds whenever a Secure (encrypted) 
call is received in the Clear mode on a conventional 
channel. If it is not selected, no beep sounds when this 
occurs.

5.6 RADIO WIDE SMARTNET/SMARTZONE 
PARAMETERS

Clicking “SmartNet/SmartZone” in the “System 
Specific” box (if applicable) displays the screen shown 
in Figure 5-3. This screen programs the functions that 
are the same for all SMARTNET and SmartZone 
systems. Refer to Section 5.5 for information on 
programming Conventional systems, and to Section 
5.7 for information on programming Project 25 
Trunked systems. 

Full Spectrum CC Scan 

If all potential control channel frequencies have 
been searched, the radio enters a channel-by-channel 
search across the full spectrum the radio covers. The 
timer sets the length of time this scan is performed 
before checking the expected frequencies again. After 
these frequencies are checked, full spectrum scanning 
resumes. This cycle repeats until a control channel is 
found.

Full Spectrum CC Scan - Checking the box enables 
full spectrum scan.

Scan Time - Sets the time that full spectrum scanning 
occurs as just described. The selectable range is 5-31 
seconds and the default is 5 seconds.

Display Options - Same as conventional P25 display 
options described on page 32. The “Both” selection is 
not available with the 7780/9883.

Trunking 

Display Site Trunking - If this is selected, “Site 
Trunking” is displayed if the affiliated site loses 
communication with the zone controller and is 
operating in the Site Trunking mode. This message is

** This feature available only with 51xx firmware 1.16/2.6/3.6/4.2 
or later and 53xx firmware 1.28/2.6/3.6/4.2 or later.

* This feature available only with 51xx firmware 1.14.0/2.4.0/
3.4.0 or later and 53xx firmware 1.26.0/2.4.0/3.4.0 or later.
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Figure 5-4   Radio Wide Project 25 Trunking Screen

displayed until the zone controller returns to normal 
operation.

Alert Site Trunking - If this is selected, an alert tone 
sounds when entering the site trunking mode just 
described.

Failsoft Inactivity - Programs failsoft operation. If the 
radio remains inactive (no receive or transmit activity 
on channel) while operating in the failsoft mode for 
the programmed time, the radio momentarily leaves 
the failsoft mode and attempts to find a control 
channel. If “0” is programmed, the radio does not 
leave the failsoft mode.

Affiliation Hold Off - With SmartZone operation, this 
is the delay time that occurs after acquiring the control 
channel before it sends an affiliation ISW. This 
prevents all radios on the system from sending affilia-
tion ISWs at the same time.

Talkback Scan - When a call is received while scan-
ning, this determines if a response made before scan-
ning resumes occurs on the Selected talk group or the 

talk group of the call (Active) when they are not the 
same. The Scan Hold Time is programmed on the Per 
System screen.

Out-of-Range Indication - Selects if the periodic tone 
sounds, “Out of Rng” (or “NO SYS”) is displayed, or 
if both or neither of these indications occur when an 
out-of-range condition exists.

Clear Mode Alert on Secure Rx* - When this is 
selected, a beep sounds whenever a Secure (encrypted) 
call is received in the Clear mode on a SMARTNET/
SmartZone channel. If it is not selected, no beep 
sounds when this occurs.

5.7 RADIO WIDE PROJECT 25 TRUNKED 
SYSTEM PARAMETERS

Clicking “Project 25 Trunked” in the “System 
Specific” box displays the screen shown in Figure 5-4. 
This screen programs the functions that are the same 
for all Project 25 trunked systems. Refer to Section 5.5 
for information on programming Conventional 

* This feature available only with 51xx firmware 1.16/2.6/3.6/4.2 
or later and 53xx firmware 1.28/2.6/3.6/4.2 or later.
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systems, and to Section 5.6 for information on 
programming SMARTNET/SmartZone systems. 

RSSI Threshold

This sets the RSSI (Receive Signal Strength Indi-
cator) levels which determine when searching for and 
switching to another site occurs. Clicking the “Restore 
Defaults” button restores these levels to the default 
setting. If the “Hex” box is checked, the RSSI levels 
are displayed in the hexadecimal instead of decimal 
notation.

NOTE: The default RSSI levels should not be changed 
unless you are familiar with how these levels affect 
radio operation.

Full Spectrum CC Scan 

If all potential control channel frequencies have 
been searched, the radio enters a channel-by-channel 
search across the full spectrum the radio covers. The 
timer sets the length of time this scan is performed 
before checking the expected frequencies again. After 
these frequencies are checked, full spectrum scanning 
resumes. This cycle repeats until a control channel is 
found.

Full Spectrum CC Scan - Checking the box enables 
full spectrum scan.

Scan Time - Sets the time that full spectrum scanning 
occurs as just described. The selectable range is 5-31 
seconds with a default of 5 seconds.

Failsoft

Programs failsoft operation which occurs when 
there is a controller or other major system failure.

Failsoft Inactivity Duration - Sets the time the radio 
must remain inactive (no receive or transmit activity 
on channel) in the failsoft mode for it to momentarily 
leave the failsoft mode and attempt to find a control 
channel. If “0” is programmed, the radio does not 
leave the failsoft mode.

Emergency Blocked - If this is checked, emergency 
calls are disabled when in the failsoft mode.

Ring Time

Individual Call Maximum Target Ring - Sets the 
maximum ring time of the target mobile when 
receiving phone and unit-to-unit calls. When this 
time expires, the call is automatically discontinued. 
Times of 61-120 seconds can be programmed with 
61 seconds the default.

Private Call Maximum Int Ring - Sets the maximum 
time the initiating mobile rings when placing a unit 
call (phone calls not included). Ringing stops if the 
target mobile answers before this timer expires. 
Times of 1-255 seconds or infinite can be 
programmed with 30 seconds the default. If infinite 
is programmed, ringing occurs until the target mobile 
answers.

Hold Off Time

Radio Random Hold Off Time - When a failure 
occurs on a site, this sets the delay that occurs before 
a mobile leaves that site and registers on another. It 
also sets the delay that occurs before a mobile returns 
to a site that has returned to normal operation. A 
random time is calculated between 0 and the selected 
time. This timer starts only when the following 
Holdoff delay timer expires. Times of 0-60 minutes 
can be programmed with 10 minutes the default. 

Holdoff Delay - Sets the delay in registration or affil-
iation that occurs before starting the preceding 
random hold off time. During this delay, monitoring 
for over-the-air packets occurs. Times of 5-60 
seconds can be programmed with a default of 5 
seconds.

Trunking

Display Site Trunking - If this is selected, “Site 
Trunking” is displayed if the affiliated site loses 
communication with the zone controller and is oper-
ating in the site trunking mode. This message is 
displayed until the zone controller returns to normal 
operation.

Alert Site Trunking - If this is selected, an alert tone 
sounds when entering the site trunking mode just 
described. 
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Other

Display Options - Same as conventional P25 display 
options described on page 32.

Talkback Scan - When a call is received while scan-
ning, this determines if a response occurs on the 
Selected talk group or the talk group of the call 
(Active Group) when they are not the same. The 
Scan Hold Time is programmed on the Per System 
screen.

Out-of-Range Indication - Selects if the periodic 
tone sounds, “Out of Rng” (or “NO SYS”) is 
displayed, or if both or neither of these indications 
occur when an out-of-range condition exists.

Clear Mode Alert on Secure Rx* - When this is 
selected, a beep sounds whenever a Secure (encrypted) 
call is received in the Clear mode on a P25 trunked 
channel. If it is not selected, no beep sounds when this 
occurs.

SECTION 6   SETTING UP ZONES AND CHANNELS

Figure 6-1   Edit Zones and Channels Screen

Double Click Here
To Display Screen Below

6.1 INTRODUCTION

The following information describes how to set 
up zones and assign channels to each zone. A zone can 
include up to 16 channels of any type (conventional 
analog, Project 25 conventional, SMARTNET/Smart-
Zone, or Project 25 Trunked). 

With all radios except the 51xx portable, up to 16 
zones can be programmed for up to 256 channels. 
With the 51xx portable, up to 32 zones for up to 512 
channels can be programmed if the “512 Talkgroups/
Channels” option is enabled (see page 17). Otherwise, 
up to 16 zones can be programmed.

6.2 SETTING UP ZONES

Setup Procedure

1. Select the Zone screen (see Figure 7-2). Then click 
 to display the Edit Zones and Chan-

nels screen shown in Figure 6-1. Alternatively, click 
 in the toolbar.

2. To add a new blank zone, select “None” in the Zone 
drop-down list and then click the  button. To 
make a copy of a current zone, select the desired 
zone in the Zone drop-down list instead. To delete 
the current zone, click the  button. 

* This feature available only with 51xx firmware 1.16/2.6/3.6/4.2 or 
later and 53xx firmware 1.28/2.6/3.6/4.2 or later.
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3. To display the first zone, click , the last zone ; 
the previous zone ; and the next zone, . 

4. Program the alias (identification) that is briefly 
displayed when the zone is selected by entering up 
to 10 characters in the Alias box.

5. With 53xx mobiles and 51xx portables, a Zone 
Password can be programmed which must be 
entered to perform keypad programming of the zone 
(see Section 11.1). If this password is desired, enter 
any eight numbers from 0-9. If no password is 
desired for the zone, simply leave this field all zeros.

Slave Conventional Scan List To Zone

Conventional systems are programmed on the Per 
System screen with a default scan list that is normally 
selected by all channels in that system (see Section 
7.1). However, this parameter can be selected to slave 
a particular conventional scan list to the zone. This 
then becomes the default list for all conventional chan-
nels in that zone (it overrides the system default list 
programming). This feature is available only with 
radio firmware versions 1.16/2.6/3.6/4.2 (51xx) and 
1.28/2.6/3.6/4.2 (53xx) or later.

6.3 SETTING UP CHANNELS

NOTE: When channels are assigned to zones, the 
system of the channel is also selected. Therefore, 
before assigning channels to zones, all necessary 
systems must be set up as described in Section 1.10.

Channels are set up by assigning them to a zone 
in the Edit Zones and Channels screen shown in 
Figure 6-1. Proceed as follows to set up any type of 

channel (Conventional Analog, Conventional Digital, 
Project 25 Trunked, SMARTNET/SmartZone). 

1. If necessary, select the Zone screen (see Figure 7-2) 
and then click  to display the Edit 
Zones and Channels screen shown in Figure 6-1. 
Alternatively, click  in the toolbar.

2. Select the desired zone as described in the preceding 
section. 

3. To add a channel to the displayed zone, check the 
applicable box in the “Channel” column. To select 
or de-select all channels in the box, check or 
uncheck the “All” box. 

4. To assign the channel to a system (if applicable), 
select the drop-down list in the “System/Type” 
column and select the desired system.

5. For Conventional channels, also select the channel 
type of each channel by clicking Analog or Digital 
(P25) in the “Conventional System Specific” box.

6. To copy an enabled channel to unprogrammed chan-
nels of the current zone or other zones, double click 
the shaded area of the channel as shown in 
Figure 6-1. The “Distribute Channel Data” screen is 
then displayed to select the desired channels.

7. Repeat the preceding steps until the desired chan-
nels are set up in each zone. 

8. To program individual system and channel informa-
tion, refer to Section 7 (Conventional), Section 8 
(SMARTNET/SmartZone), or Section 9 (Project 25 
Trunked). 

SECTION 7   CONVENTIONAL SYSTEMS AND CHANNELS

7.1 INDIVIDUAL CONVENTIONAL SYSTEM 
PARAMETERS

Individual system parameters are programmed by 
the “Per System” screen shown in Figure 7-1. These 
parameters can be programmed after the desired 
systems have been set up as described in Section 1.10. 

There are also radio wide parameters that are 
programmed by the Radio Wide screen as described in 
Section 5.5. For information on programming 
individual SMARTNET/SmartZone and Project 25 
Trunked system parameters, refer to Sections 8.1 
and 9.1. The parameters in the individual Conven-
tional System screen are as follows:
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Figure 7-1   Conventional System Screen

Alias - Programs the alias that is displayed for the 
system in the left pane after the system type. This alias 
is not displayed by the radio.

Per System Scan List Settings

These parameters set various timers that control 
priority scanning when a channel assigned to the 
system is selected. 

Scan Hold Time - Sets the delay that occurs before 
scanning resumes after a signal is no longer received. 
Times of 0 -7.5 seconds can be programmed.

Priority Lookback Time A - This time determines 
how often the priority channel is checked for activity. 
Times of 0.25-4.00 seconds in 0.25-second steps can 
be programmed.

Priority Lookback Time B - This time determines 
how often the priority channel is checked once an 
incorrect Call Guard (CTCSS/DCS) or NAC code is 
detected. Since it takes much longer to detect an 
incorrect Call Guard signal than a carrier, this time 
should be relatively long to prevent the interruptions 

from making a message difficult to understand. 
Times of 0.5-8.0 seconds can be programmed in 
0.5-second steps.

Default User Selected Scan List - Selects the scan list 
that is normally always selected on power up. A 
different scan list can be temporarily selected using 
the Scan List option switch or menu parameter (if 
applicable). This setting is overridden if a scan list is 
slaved to a particular zone on the Zone setup screen 
(see Section 6.2).

Individual (Unit) Call List Settings (P25 Only)

Encryption Key ID - Selects the location from 0-15 
(PID/ASN mode) or 1-16 (SLN/CKR mode) of the 
key used for secure individual calls on the system if 
applicable. 

Call Timer - Used with 5300, Rev 4, logic board only 
to set the maximum time the radio remains in the 
individual call mode after an individual call is 
received. A response must be made before this timer 
expires. With Rev 6 and later boards and other 
radios, the call is ended by pressing the Call button.
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Timers

Tx Time-Out - This timer limits the length of indi-
vidual transmissions. Times up to 3 minutes, 45 
seconds can be programmed in 15-second steps.

Penalty - This timer disables transmitting after the 
time-out timer disables the transmitter. Times up to 
3 minutes, 45 seconds can be programmed in 
15-second steps.

Conversation - This timer limits the total length of a 
conversation. Times up to 7.5 minutes can be 
programmed in 0.5-minute steps.

System Lists - Refer to page 41 for information on 
these lists.

Analog Signaling Type - Selects the signaling type 
(DTMF or MDC) used for emergency calls and ANI 
on analog channels on the system. MDC selects the 
MDC1200 Motorola signaling protocol. The DTMF 
and MDC IDs are programmed on the Radio Wide 
Conventional screen (see Section 5.5), emergency and 
some ANI information is programmed on this screen, 
and ANI is enabled on the analog channel screen (see 
Section 7.3). NOTE: MDC is available only with 51xx 
portable models that have Version 4.x firmware.

Emergency (Conventional)*

Emergency Alarm - If this box is checked, emer-
gency alarms are sent by pressing the Emergency 
option switch. In the P25 mode, an emergency alarm 
is a special P25 data transmission. In the analog 
mode, it is a DTMF or MDC Emergency ID that is 
sent (see preceding Analog Signaling Type). This ID 
is programmed on the Conventional Radio Wide 
screen described in Section 5.5.

Normal/Silent - When “Normal” is selected and an 
emergency alarm is sent, the red transmit indicator 
lights, an emergency tone sounds, and EMERGNCY 
flashes in the display. EMERGNCY continues to 

flash until power is cycled, the channel is changed, or 
the Emergency switch is pressed and held. If “Silent” 
is programmed, none of these indications occur. 

Acknowledge Alert Tone - If selected, an alert tone 
sounds when the emergency alarm is acknowledged 
by the dispatcher (DTMF only). 

Emergency Call - Digital - Enables Emergency Calls 
on conventional P25 channels. When the Emergency 
button and then the PTT switch are pressed, an emer-
gency call is transmitted. To exit the emergency 
mode, cycle power or press and hold** the 
Emergency switch.

Emergency ANI Call - Analog - Enables Emergency 
Calls on conventional analog channels. When the 
Emergency button and then the PTT switch are 
pressed, the Emergency DTMF code is sent every 
transmission (in place of the DTMF PTT ID if appli-
cable). To exit the emergency mode, cycle power or 
press and hold** the Emergency switch.

Emergency Hot Mic - When this box is checked and 
an emergency alarm is sent by pressing the Emer-
gency switch, automatic transmitting occurs with the 
microphone audio unmuted (without user interven-
tion) for the time specified by the following Emer-
gency Hot Mic Time. If it is not checked or if an 
emergency call is not selected, automatic transmis-
sions do not occur. This feature is initiated only by 
the first press of the Emergency switch. Subsequent 
presses do not trigger automatic transmissions. To 
reset this function, power must be cycled.

Emergency Hot Mic Time - Defines the period 
during which automatic transmissions occur. Times 
of 10-120 seconds in 10-second steps can be 
selected.

No Rx Activity During Emergency*** - When this 
box is checked, the following receive indications are 
disabled in the emergency mode: receive audio, 
receive LED, receive icons. 

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with code 1.21.0/2.x/3.x or later.

** This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.

*** This feature available only with radio firmware Version 1.14.0/
2.4.0/3.4.0 (51xx) or 1.26.0/2.4.0/3.4.0 (53xx) or later.
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ANI

NOTE: The type of ANI (DTMF or MDC) is selected 
by the preceding Analog System Type. DTMF PTT and 
MDC IDs are programmed on the Radio Wide 
Conventional screen, and pre and post ANI is enabled 
on the analog channel screen.

Initial Delay - Sets the delay before ANI is sent for 
0-620 ms.

Digit Duration (DTMF Only) - Sets the duration of 
each digit for 50-800 ms in 50 ms steps.

Inter Digit Delay (DTMF Only) - Sets the delay 
between digits for 50-800 ms in 50 ms steps.

Single Tone Encoder (51xx Only)

This programs the single tone encoder frequency 
and tone duration. This feature is available if the 
Single Tone option button or menu parameter is 
programmed. Tone frequencies of 500-2500 Hz with a 
duration of 0.5-2.5 seconds can be programmed. This 
feature is available only with 51xx radios that have 
Flash code Version 1.8.0. or later.

Other

Busy Channel Override - If selected, the busy 
channel lockout feature can be overridden by quickly 
releasing and then pressing the PTT switch.

Keypad CTCSS/DCS (51xx Only) - If selected, a 
code for the selected channel can be directly selected 
from the programmed CTCSS/DCS/NAC list using 
the keypad. For example, pressing the “3” key selects 
code number 3 from the table. No other functions can 
then be assigned to the keys. If this is not selected, 
these codes can be selected only by the option button 
or menu parameter for that function.

Radio Inhibit (P25 only)* - If selected, the dispatcher 
can send a command which disables the radio.

Radio Check (P25 only)* - If selected, the dispatcher 
can send a message requesting a response from the 
radio (to check if it is in operation, for example).

Conventional System Page 2 Screen Description

An additional conventional system screen is 
opened/closed by clicking the  buttons in the 
upper right corner of the screen. The following addi-
tional parameters are then displayed:

Call Alert (P25 Only)**

Call Alert Decode - If selected, enables call alert 
messages (pages) to be received. 

Call Alert Encode - If selected, enables call alert 
messages (pages) to be sent. 

OTAR and Data Settings

NOTE: The SLN (CKR) key management mode must 
be selected on Page 2 of the Global screen to select 
the OTAR and Data parameters which follow.

Clicking the  button displays the 
following screen which programs various OTAR and 
P25 data parameters:

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.

** This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.
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OTAR

OTAR Enabled - Select “On” to enable OTAR 
(Over-the-Air Rekeying) of encryption keys. Select 
“Off” to disable this feature.

Rekey Request Time Out* - When rekeying is initi-
ated by the radio (OTAR Rekey Request message 
sent), this setting determines how long the radio 
waits for a response from the Key Management 
Facility (KMF). Times of 20-180 seconds can be 
programmed.

Rx Security Level** - When Enhanced is selected, 
only encrypted and authenticated KMMs from the 
KMF are accepted (except for warm-start, which is 
authenticated only). If Basic is selected, any KMM is 
accepted that is in a format allowed by the OTAR 
standard. 

Tx Security Level** - When Enhanced is selected, 
all OTAR procedures originating from the radio are 
encrypted and authenticated. If they cannot be 
encrypted and authenticated, the KMM will not be 
sent. When Basic is selected, the radio always sends 
KMMs in the clear (if the OTAR standard allows 
them to be unencrypted and unauthenticated). 

Originating Response Kind** - Selects if a response 
is required from the KMF to outgoing messages. If 
“Kind 1-Unconfirmed” is selected, no response is 
requested, and if “Kind 3-Confirmed” is selected, 
and immediate response is requested.

Data/SNDCP (Simple Network Data Control 
Protocol)

Data Registration Enabled - Select “On” if OTAR is 
used. The radio then registers with the data system on 
a channel change (P25 channels only)

CAI Data Max Tx Attempts** - Selects the 
maximum number of times the radio attempts to send 
a CAI data packet transmission. Retrys continue until 
it receives an acknowledgement confirming the 
successful receipt of transmission, or until the 
selected amount of transmit attempts is reached.

Response Timer** - Selects the amount of time the 
radio waits for an acknowledgement that a CAI 
transmission is successful before resending.

Phone Interconnect Settings (P25 Only)

NOTE: P25 phone calling is available on conventional 
channels only with 51xx portables with firmware 1.16/
2.6/3.6/4.2 or later and 53xx mobiles with firmware 
1.28/2.6/3.6/4.2 or later.

Usage

Disabled - Phone calls cannot be placed or 
received.

Answer Only - Phone calls can be received but 
not placed.

List Only - Phone calls can be placed and 
received, and numbers can be recalled from a 
preprogrammed list only.

Unlimited - Private calls can be placed and 
received, and numbers can be recalled from a 
preprogrammed list or dialed using a keypad. With 
53xx radios (firmware Version 1.28/2.6/3.6/4.2 or 
later only), this mode is supported only when the 
HHC control unit is used. Standard 53xx front and 
remote models do not support number dialing. 
NOTE: To enter this mode, the Phone key must be 
pressed and held until a tone sounds. 

Other

System Modulation - Reserved for future use.

7.2 CONVENTIONAL SYSTEM LISTS

The various conventional system lists are 
programmed by selecting them in the System Lists 
drop-down list on the Conventional Per System screen 
shown Figure 7-1 and then clicking the Edit List 
button. Descriptions of the various lists and the infor-
mation they program follow.

** This feature available only with radio firmware Version 1.14.0/
2.4.0/3.4.0 (51xx) or 1.26.0/2.4.0/3.4.0 (53xx) or later.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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Status Alias List (P25 Only)*

The Status Alias List screen which follows 
programs the alias for each of up to eight status condi-
tions that can be sent. The meaning of each status 
number is defined by the system manager. 

To display this screen, on the Conventional Per 
System screen, select Status Alias List in the drop-
down list and then click the  button (see 
Figure 8-1). 

To add an alias, click the  button, and to 
delete an alias, simply select it and click the Delete 
button. To edit an alias, select it and change it as 
desired. Up to 10 characters can be entered that iden-
tify the status. This identification is displayed when 
the user selects a status condition.

Message Alias List (P25 Only)*

The Message Alias List screen shown above 
associates an alias (name) with each message number. 
The meaning of each message number is defined by 
the system manager. 

To display this screen, on the Conventional Per 
System screen, select Message Alias List in the drop-
down list and then click the  button (see 
Figure 8-1). 

To add an alias, click the  button, and to 
delete an alias, simply select it and click the Delete 
button. To edit an alias, select it and change it as 
desired. Up to 10 characters can be entered that iden-
tify the status. This identification is displayed when 
the user selects a message.

Call List (P25 Only)

This Call List screen which follows sets up the 
IDs used to place individual calls on conventional 
digital (Project 25) channels. This list is not used with 
conventional analog channels.

To display this screen, on the Conventional Per 
System screen, select Call List in the drop-down list 
and then click the  button (see 
Figure 8-1). 

To add a call, click the  button, and to 
delete an call, simply select it and click the Delete 
button. To edit an Alias or ID, select it and enter the 
desired information as follows:

Alias - Up to ten characters can be entered to identify 
the user being called. This identification and the ID are 
alternately displayed when the call is selected by the 
user. Only uppercase letters can be entered, so lower-
case letters are automatically converted to uppercase 
by the program.

ID - This is the ID of the radio being called. Valid 
entries are 0 - 16,777,216.

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.
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Talk Group List (P25 Only)

The Talk Group screen shown above sets up the 
Talk Groups used to place group calls on conventional 
digital (Project 25) channels. Talk groups are not used 
with conventional analog channels. Talk groups are 
assigned to channels on the channel programming 
screen described in Section 7.4.

To display this screen, on the Conventional Per 
System screen, select Talk Group List in the drop-
down list and then click the  button (see 
Figure 8-1). 

To add a talk group, click the  button, 
and to delete an talk group, simply select it and click 
the Delete button. To edit an ID or Alias, select it and 
enter the desired information as follows:

ID - Group IDs can be any number from 0-65535. 
Group IDs can be entered as decimal or hexadecimal 
numbers depending on which mode is selected. 

Alias - The alias is the identification that is displayed 
when the Talk Group is selected, and up to 10 char-
acters can be entered. This drop-down list selects the 
Talk Group to be edited if applicable.

Security Parameters

Clear - All transmissions on the group occur in the 
clear (unscrambled) mode.

Secure - All transmissions occur in the secure 
(scrambled) mode. 

Switched - The clear or secure status of the group 
is selected by the Clear/Secure option switch.

Encryption Key ID - Selects the location from 0-15 
(PID/ASN mode) or 1-16 (SLN/CKR mode) of the 
key used for secure calls on the group if applicable.

Add Mode - To add an entire block of talk group IDs 
or a specific ID, click the arrow button  in the 
lower right corner of the screen and the following 
screen is displayed:

Add Mode Drop Down List - “Single” adds the next 
available ID similar to the preceding “Add” button. 
“Multiple” adds a block of IDs as follows. To 
initiate the selected add operation, click the 
preceding “Add” button. If the specified ID range 
results in duplicate IDs, an error message is 
displayed and no IDs are added.

Start ID - Specifies the starting ID of the block.

ID Count - Specifies the number of IDs to be added.

ID Step - Specifies if consecutive IDs are added or 
some other step rate is used. 

For example, if Start ID =10, ID Count = 5, and ID 
Step = 10, the IDs added are 10, 20, 30, 40 and 50.

Use Selected Group’s Security - When selected, the 
added groups are automatically programmed with 
the Strapping Mode and Encryption Key ID of the 
selected group.
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Priority (Standard) Scan List Programming Screens

Edit Scan List Screen Modify Scan List Screen

Priority Scan List

NOTE: It may be necessary to define specific channel 
parameters before programming the conventional scan 
lists as follows (see Sections 7.3 and 7.4).

This displays the Priority (Standard) Scan List 
screen shown above. This screen programs the priority 
scan lists that are selected on the system.

List Number - This drop-down list selects which of the 
scan lists to program. Click the “Add” button to add a 
scan list and “Delete” to delete a scan list. 

User Editable - If this box is checked, user editing of 
the scan list is allowed. The Scan Edit function switch 
is then required. User editing can be enabled or 
disabled on each scan list.

NOTE: With the 51xx and 53xx, Priority 1 and 2 chan-
nels can be programmed. The Priority 1 channel is 
sampled while listening to a call on the Priority 2 
channel but not vice versa. Priority sampling does not 
occur while listening to any type of digital call.

Scan Mode - Sets the channel on which transmissions 
occur when the PTT switch is pressed while scanning. 
A different mode can be programmed for each scan 
list. In addition, it selects if priority sampling is used 
and also the type of priority channel. The following 
modes are available:

No Priority - Priority sampling does not occur (all 
channels are scanned in sequence). The radio trans-
mits on the selected channel.

Priority/Tx Selected - Priority sampling occurs and 
the priority channel(s) are those programmed in the 
selected scan list. The radio transmits on the 
selected channel.

Priority/Tx Priority (1) - Priority sampling occurs 
and the priority channel(s) are programmed in the 
selected scan list. The radio transmits on the priority 
(1) channel.

Priority (1) on Sel Chan - The priority (1) channel 
is always the selected channel. The radio transmits 
on the selected channel. 

Talkback - No priority sampling occurs. The radio 
transmits on the channel of a call while scanning is 
halted. Then when scanning resumes, it transmits on 
the selected channel.

If the “Priority/Tx Priority” or “Priority/Tx 
Selected” mode is programmed, the priority channel 
must then be chosen for the scan list. To do this, click 
the box next to the desired channel. Select the Priority 
1 channel in the Priority 1 column and if a Priority 2 
channel is also used, select it in the Priority 2 column.

 (Modify) - To add or delete channels from a 
list, click this button to display the Modify Scan List 
screen shown in the preceding illustration. Select the 
channels from each zone that are to be included in the 
selected list (up to 16 channels maximum).

 - (OK) - Clicking this button closes the 
screen and saves the changes. 
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 (Cancel) - Clicking this button closes the 
screen without saving any changes.

CTCSS/DCS/NAC List

This displays the preceding screen which 
programs the list of CTCSS/DCS (Call Guard) and 
NAC (P25) codes that can be selected if the Selective 
Squelch option switch is programmed or the Keypad 
CTCSS/DCS function which follows is programmed. 

To add a code to the list, click the Add button and 
an additional screen like the one shown above is 
displayed. Different codes can be programmed for the 
transmit and receive modes by selecting the mode in 
the drop down list. In addition, carrier squelch can be 
programmed instead of a CTCSS/DCS code by 
unchecking the CTCSS/DCS box. To change a code, 
select it and then click the Modify button. Up to 64 
different codes can be programmed. A CTCSS/DCS 
code table is shown on page 91.

User Group ID List* (P25 Only)

This User Group ID List screen shown above 
programs aliases that can be displayed if a call is 
received on a talk group ID within the programmed 
block. For example, with the following screen, if a 
group call is received on group IDs 234-264, the alias 

“Fire” can be displayed. The display of this alias is 
controlled by the “User Group ID” parameter on the 
Radio Wide screen.

Phone Access Code List (P25 Only)**

The Phone Access Code List screen shown above 
programs sets of predefined DTMF access and de-
access codes needed to make interconnect telephone 
calls on P25 channels. The code must be entered 
before the actual telephone number. They can be up to 
four digits in length, and the default code is *1P#. The 
access code is selected from this list on the conven-
tional digital channel screen (see Section 7.4).

Phone List (P25 Only)**

The Phone List screen shown above programs the 
telephone number list used for placing telephone calls 
if applicable. A maximum of 16 numbers can be 
programmed. To display this screen, on the Conven-
tional Per System screen, select Phone List in the 
drop-down list and then click the  button 
(see Figure 8-1). 

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.

** This feature available only with 51xx firmware 1.16/2.6/3.6/4.2 
or later and 53xx firmware 1.28/2.6/3.6/4.2 or later.
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To add a number, click the  button, and 
to delete a number, simply select it and click the 
Delete button. To edit an alias or number, select it and 
enter the desired information as follows:

Alias - Up to ten characters can be entered to identify 
the number being called. This identification is 
displayed when the number to be called is selected by 
the user from the list. Only uppercase letters can be 

entered, so lowercase letters are automatically 
converted to uppercase by the program.

ID - This is the telephone number dialed when the 
location is selected. Numbers up to sixteen digits can 
be entered. A pause is entered by “p” or “P” and 
counts as one digit. 
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Figure 7-2   Conventional Analog Channel Screen

7.3 CONVENTIONAL ANALOG CHANNEL 
PARAMETERS

After the desired channels have been set up as 
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown 
in Figure 7-2 and then select the desired Zone using 
the drop-down list in the “Zones” box. Screens which 
program individual channel parameters are selected by 
clicking the channel in the “Channels” box.

The parameters displayed when a Conventional 
Analog channel is selected are as follows. Refer to 
Section 7.4 for information on Conventional Digital 
(P25) channels. SMARTNET/SmartZone and Project 
25 Trunked channels are described in Sections 8 and 9.

Channel Type

Indicates the type of channel (Conventional Analog 
or Conventional Digital) that is currently selected in 
the “Channels” box.

Channel Alias

Programs the alias (identification) that is displayed 
when the channel is selected. 

Transmit

Power - Fixes the transmit power on the channel for 
the high or low level or makes it selectable (the high/
low power option switch is then required).

Time Out - Enables or disables the transmit time-out 
timer on the channel. The time-out timer time is 
programmed on the Per System programming screen 
(see Section 7.1).

Modulation Level - This selects if the channel modu-
lation is wideband (5 kHz), narrowband (2.5 kHz), or 
NPSPAC (4 kHz). NPSPAC (public safety) modula-
tion applies to 800 MHz models only.

Frequency - Programs the transmit frequency of the 
channel.

Disabled - Checking this box disables transmitting 
on the channel so that it is receive only.

CTCSS/DCS - Checking this box enables Call Guard 
(CTCSS/DCS) squelch control transmission on the 
channel. If this box is not checked, no code is trans-
mitted and squelch is carrier controlled.
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CTCSS - If this box is checked, tone Call Guard 
(CTCSS) squelch control is used and the desired tone 
is selected by the drop-down list. NOTE: A CTCSS/
DCS code table is shown on page 91.

DCS - If this box is checked, digital Call Guard 
(DCS) squelch control is used and the desired code is 
selected by the drop-down list.

Receive

Frequency - Programs the receive frequency of the 
channel.

CTCSS/DCS - Checking this box enables Call Guard 
(CTCSS/DCS) squelch control on the channel. If this 
box is not checked, no squelch control coding is 
used, and squelch is carrier controlled. 

CTCSS - If this box is checked, tone Call Guard 
(CTCSS) squelch control is used and the desired tone 
is selected by the drop-down list. 

DCS - If this box is checked, digital Call Guard 
(DCS) squelch control is used and the desired code is 
selected by the drop-down list.

Security

NOTE: Voice encryption is an optional feature that 
requires factory programming and possibly special 
hardware.

Strapping Mode 

Strapped Clear - All transmissions on the channel 
occur in the clear (unscrambled) mode.

Strapped Secure - All transmissions occur in the 
secure (scrambled) mode selected by Security 
Type. 

Switched - The clear or secure status of the channel 
is selected by the Clear/Secure function switch.

Security Type

Securenet - Selects Motorola SecureNet™ DES 
type secure communication when either the 
Strapped Secure or Switched strapping modes 
are selected.

Scrambling - Selects Transcrypt 460 scrambling 
when either the Strapped Secure or Switched 
strapping modes are selected (not available with 
5100 and later 5300 models).

Scrambling Type

When the Transcrypt 460 scrambling type is 
selected, 460 scrambling is always enabled.

Tx DES/DES-XL

When the Motorola SecureNet secure communica-
tion is selected, enables either the DES or DES-XL 
type (with the 51xx, DES-XL is available only in 
later models equipped with the UCM module).

Key PID

Selects the location from 0-15 (PID/ASN mode) or 
1-16 (SLN/CKR mode) of the key used for secure 
calls on the channel if applicable. 

Rx Auto Detect

With the SecureNet protocol, selecting “Secure” 
enables automatic detection of encrypted receive 
signals (not available with 5100 models). This may 
increase the response time of the radio to an 
incoming signal. Selecting “Proper Key” causes the 
radio to search the available SecureNet keys until it 
finds a match for the current transmission.

Other

Busy Channel Lockout 

Off - Disables this feature.

Noise - Transmitting is disabled if a carrier is 
detected.

Tone - Transmitting is disabled if an incorrect Call 
Guard (CTCSS/DCS) tone or code is 
detected (one not programmed for current 
channel). 

Keypad DTMF

If this box is checked, manual dialing of numbers 
using the DTMF keypad is allowed.
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Figure 7-3   Conventional Digital (P25) Channel Screen

ANI

This drop-down list selects Pre Tx or Post Tx ANI. If 
“Pre Tx” is selected, a DTMF-coded ID is sent at the 
beginning of each transmission. If “Post Tx” is 
selected, a DTMF coded ID is sent at the end of each 
transmission. This ID is set in the Radio Wide 
Conventional screen by “DTMF PTT ID” (see 
Section 5.5), and ANI timing is set in the Per System 
Conventional screen (see Section 7.1).

Ignore Keypad CTCSS - If this is checked and a 
CTCSS/DCS code has been selected from the 
preprogrammed CTCSS/DCS table by the Selective 
Squelch Code Select feature, it is ignored and the 
programmed code for the channel is selected instead.

7.4 CONVENTIONAL DIGITAL (P25) CHANNEL 
PARAMETERS

After the desired channels have been set up as 
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown 
in Figure 7-3 and then select the desired Zone using 
the drop-down list in the “Zones” box. Screens which 
program individual channel parameters are selected by 
clicking the channel in the “Channels” box.

The parameters displayed when a Conventional 
Digital channel is selected are as follows. Refer to 
Section 7.3 for information on Conventional Analog 
channels. SMARTNET/SmartZone and Project 25 
Trunked channels are described in Sections 8 and 9.

Channel Type

Indicates the type of channel (Conventional Analog 
or Conventional Digital) that is currently selected in 
the “Channels” box.

Channel Alias

Programs the alias (identification) that is displayed 
when the channel is selected. Up to ten characters 
can be programmed.

Mixed Mode

Mixed analog and digital (Project 25) operation can 
be programmed on a channel. With mixed mode 
operation, both types of calls can be received, and the 
Tx Type determines if NAC or CTCSS/DCS is trans-
mitted. With analog operation, channel modulation, 
coded squelch, and ANI signaling may require 
programming similar to that described in Section 7.3.
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Enable - Checking this box selects both analog and 
digital operation on the current channel.

Tx Type - When “Analog” is selected, CTCSS/DCS 
is transmitted, and when “Digital” is selected, NAC 
is transmitted. 

Transmit

Power - Fixes the transmit power on the channel for 
the high or low level or makes it selectable (the high/
low power function switch is then required).

Time Out - Enables or disables the transmit time-out 
timer on the channel. The time-out timer time is 
programmed on the Per System programming screen 
(see Section 7.1).

Modulation Level - If the Mixed Mode and Tx 
Type = Analog is selected, the modulation level is 
programmed. This selects if the channel modulation 
is wideband (5 kHz), narrowband (2.5 kHz), or 
NPSPAC (4 kHz). 

Frequency - Programs the transmit frequency of the 
channel.

Disabled - Checking this box disables transmitting 
on the channel so that it is receive only.

NAC - Programs the transmit NAC (Network Access 
Code). These codes can be 0-4095, and either 
decimal or hexadecimal numbers can be entered.

CTCSS/DCS - If the Mixed Mode and Tx Type = 
Analog is selected, the transmit Call Guard (CTCSS/
DCS) squelch coding can be programmed (see 
Section 7.3). 

Phone Access Code - Selects the Phone Access Code 
if telephone calls are placed on the channel. The 
access codes are programmed by the Phone Access 
Code system list on the Per System screen.

Receive

Frequency - Programs the receive frequency of the 
channel.

NAC - Programs the receive NAC (Network Access 
Code). These codes can be 0-4095, and either 

decimal or hexadecimal numbers can be entered. 
NAC F7E (hex) is interpreted as a standard code.

Digital Squelch - When checked, carrier squelch is 
enabled which results in all digital traffic, regardless 
of NAC or talk group ID, being received. This does 
not program NAC F7E which is used the same as 
other NAC codes. 

CTCSS/DCS - If the Mixed Mode is selected, the 
receive Call Guard (CTCSS/DCS) squelch coding 
can be programmed (see Section 7.3). Both analog 
and digital (P25) calls can be received in the mixed 
mode.

Talk Group

Group ID - This selects the Project 25 talk group that 
is assigned to the channel. The talk group includes 
the Talk Group ID, talk group alias, secure strapping 
mode, and encryption key address. Talk Groups are 
programmed in the Per System screen (Section 7.1).

Group Selection

Strapped To Selected Group - The talk group on 
the channel is always the programmed talk group 
and cannot be changed.

List Selectable - The talk group may be changed 
using the Digital TG Select function button.

Other

Busy Channel Lockout 

Off - Disables this feature.

Noise - Transmitting is disabled if a carrier is 
detected.

NAC - Transmitting is disabled if an incorrect NAC 
code is detected (or CTCSS/DCS if mixed 
mode is enabled). An incorrect code is any 
code not programmed for the current channel.

Keypad DTMF

If this box is checked, manual dialing of numbers 
using the DTMF keypad is allowed. This is available 
in the mixed mode only.
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ANI

If the Mixed Mode and Tx Type = Analog are 
selected, ANI can be programmed similar to that 
described in Section 7.3.

Override Talkgroup Security Settings*

This allows the encryption strapping mode and key 
location to be set on a per channel basis instead of 
just on a per talk group basis. If “Yes” is selected in 

the drop down menu, the selected strapping mode 
and key location overrides the talk group program-
ming if applicable (conventional digital channels 
only).

Ignore Keypad CTCSS - If this is checked and a 
CTCSS/DCS code has been selected from the 
preprogrammed CTCSS/DCS table by the Selective 
Squelch Code Select feature, it is ignored and the 
programmed code for the channel is selected instead.

SECTION 8   SMARTNET AND SMARTZONE SYSTEMS AND CHANNELS

Figure 8-1   SMARTNET/SmartZone System Screen

System Key
Indicator

8.1 INDIVIDUAL SMARTNET/SMARTZONE 
SYSTEM PARAMETERS

NOTE: Some SMARTNET/SmartZone trunking param-
eters can be edited only if the proper system key is 
detected. A key is being detected if a yellow key icon is 
indicated as shown in Figure 8-1. If there is a red “X” 
through this icon, a key is not being detected. Refer to 
Section 13 for more information.

Individual system parameters are programmed by 
the “Per System” screen shown in Figure 8-1. These 
parameters can be programmed after the desired 
systems have been set up as described in Section 1.10. 

There are also radio wide system parameters that 
are programmed by the Radio Wide screen as 
described in Section 5.6. For information on program-
ming individual Conventional and Project 25 Trunked 
system parameters, refer to Sections 7.1 and 9.1. 

* This feature available only in 51xx/53xx models with Flash code 
2.x or 3.x (see Section 16).
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The parameters in the individual SMARTNET/
SmartZone System screen are as follows:

IDs

NOTE: These IDs can be entered in either decimal or 
hexadecimal format (see Section 1.9.4)

System ID - This drop down list selects the system 
ID of the system. This ID comes from the system key 
in the “Keys” folder (see above “Note”). System ID 
numbers can be 1-65535 or 0001-FFFF hex. If a 
valid system key is not detected, only a default ID of 
“1” can be selected. 

Individual ID - Uniquely identifies the radio on a 
particular system. Each radio must have a different 
Unit ID. Valid Unit IDs are 1-65535. If the “Hex” 
box is checked, the Individual ID can be entered as a 
hexadecimal number instead of a decimal number.

Keys

Programs the following encryption key ID (hard-
ware location) that is used for all except group calls.

System Wide - Key used for system-wide calls (typi-
cally originated by the dispatcher).

Failsoft - Key used in failsoft conditions.

Patch - Key used in patch calls.

Unit To Unit - Key used for unit-to-unit (private) 
calls.

Interconnect - Key used for telephone interconnect 
calls.

System Lists - Refer to page 55 for information on 
these lists.

Emergency

Emergency Alarm

Disabled - No emergency signal is sent when the 
user presses the Emergency option switch.

Normal - An emergency alarm is sent when the 
user presses the Emergency option switch. If the 
Emergency Call is disabled, the alarm always 
occurs on the selected group. If the Emergency 
Call is enabled, it occurs, in order of preference, on 
the Emergency group, selected group, and 
Announcement group. When an emergency condi-
tion is sent, the red transmit indicator lights, an 
emergency tone sounds, and EMERGNCY flashes 
in the display. EMERGNCY continues to flash 
until power is cycled or the Emergency switch is 
pressed and held*. 

Silent - Same as “Normal” except none of the 
above audio or visual indications occur.

Emergency Call

Enable - When this box is checked, if the Emer-
gency option switch and then the PTT switch are 
pressed, an emergency call is transmitted on the 
Emergency group. The emergency mode is 
canceled by cycling power or pressing and 
holding* the Emergency switch.

Disable - When this box is not checked, an emer-
gency group call is not authorized.

Emergency Hot Mic

Enable - When this box is checked and an emer-
gency alarm is sent by pressing the Emergency 
switch, automatic transmitting occurs with the 
microphone audio unmuted (without user inter-
vention) for the time specified by the following 
Emergency Hot Mic Time. If it is not checked or if 
neither emergency call is selected, automatic 
transmissions do not occur. This feature is initiated 
only by the first press of the Emergency switch. 
Subsequent presses do not trigger automatic trans-
missions. This function resets if the channel is 
changed.

Disable - When this box is not checked, automatic 
transmissions do not occur.

Emergency Hot Mic Time - Defines the period 
during which transmissions occur. Times of 10-120 
seconds in 10-second steps can be selected.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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Emergency Retry Counter - When “Infinite” is 
checked, an emergency call is repeated until 
acknowledged or canceled. When it is not checked, 
calls are attempted only the specified number of 
times.

No Rx Activity During Emergency* - When this box 
is checked, the following receive indications are 
disabled in the emergency mode: receive audio, 
receive LED, receive icons. 

Time/Timers

Time-Out Timer - Programs the time-out timer 
setting for the system. It can be programmed for 
15-225 seconds in 15-second steps or it can be 
disabled (0).

ISW Delay Time - Increasing or decreasing this 
value changes the transmission timing of ISWs 
relative to the reception of OSWs.

Scan Hold Time - Programs the delay that occurs 
after a message is no longer received before scanning 
resumes. Times of 2-10 seconds can be programmed.

Phone DTMF Timing (Analog Only)

Initial Delay - Delay from 10-500 milliseconds from 
when a traffic channel is granted for phone intercon-
nect to the start of the dialing out of the phone 
number.

Digit Duration - Duration from 10-500 milliseconds 
of each phone number digit.

Inter-Digit Delay - Delay from 10-500 milliseconds 
between each digit of a phone number.

NOTE: Customized Roaming Properties are now 
programmed on Page 2 of this screen (see page 55)

Other

PTT ID Enable - When selected, the radio can key 
during the programmed hang time and continue the 
conversation on the active channel (similar to 
message trunking). If a user keys during the hang 
time, re-affiliation with the system occurs before 
using the voice channel. The voice channel is held 

while this re-affiliation occurs, and the call is then 
routed to the open voice channel. This results in all 
traffic being logged, even the radios which transmit 
during the hang time. 

If neither PTT ID Enable or Transmission Trunking 
which follows is selected, operation is similar to that 
above except that re-affiliation does not occur during 
the hang time. Therefore, radios that key up during 
the hangtime do not affiliate and are not logged and 
only the radio initiating the call is logged.

Splinter Channels - When checked, the receive and 
transmit frequencies are 12.5 kHz lower than the 
normal frequencies. Splinter channels are used only 
as required in the Mexico and Canada border areas 
for frequencies between 806 and 820.975 MHz.

Dynamic Regrouping - When checked, a dynamic 
regrouping channel can be programmed. This is a 
SMARTNET/SmartZone channel which has the talk 
group dynamically set by the dispatcher. It is selected 
on the channel screen (see Section 8.3).

Transmission Trunking - Hangtime is not used and 
the radio must affiliate and receive a new channel 
grant on every PTT. When a radio unkeys, the 
channel is immediately available for other users, and 
all traffic is logged. If this parameter is not selected, 
see preceding PTT ID Enable description. 

Connect Tone - The tone expected by the controller 
on the traffic channel to verify that a subscriber trans-
mission is occurring. This tone should be set the 
same as it is in the controller.

Private Call Usage 

Disabled - Private calls cannot be placed or 
received.

Response Only - Private calls can be received but 
not placed.

List Only - Private calls can be placed and 
received, and numbers can be recalled from a 
preprogrammed list only.

Unlimited - Private calls can be placed and 
received, and numbers can be recalled from a 

* This feature available only with radio firmware Version 1.14.0/
2.4.0/3.4.0 (51xx) or 1.26.0/2.4.0/3.4.0 (53xx) or later.
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preprogrammed list or dialed using a keypad. With 
53xx radios (firmware Version 1.28/2.6/3.6/4.2 or 
later only), this mode is supported only when the 
HHC control unit is used. Standard 53xx front and 
remote models do not support number dialing. 
NOTE: To enter this mode, the Phone key must be 
pressed and held until a tone sounds. 

Private Call 2

Standard - Selects the standard Private Conversa-
tion mode in which the user does not receive any 
feedback when the called radio is not active in the 
system. Only a “No Answer” is received if the 
called radio does not answer.

Enhanced - Selects the Enhanced Private Conver-
sation™ mode. When a call is placed with this 
mode, the system tells the user if the called radio 
is currently active in the system and within range. 
The calling radio displays “No Ack” if the called 
radio is not active in the system and “No Answer” 
if it is active but does not answer.

Phone Interconnect Usage - Programs operation of 
telephone calls same as “Private Call Usage” above.

Affiliation Type (SMARNET Only)

Automatic - The radio immediately affiliates with 
the central controller as soon as it is turned on and 
automatically re-affiliates each time the talk group 
is changed.

On PTT - The radio affiliates with the central 
controller each time the PTT switch is pressed, 
even when pressed during the hang time. Also, 
when the radio is keyed during the hang time, the 
currently active channel is held active during the 
re-affiliation and the re-affiliated radio continues 
traffic on this channel. 

Channel Bandwidth - Selects the channel bandwidth 
as 25, 20, or 12.5 kHz. When “20 kHz” is enabled, 
the radio operates with a 4 kHz maximum deviation 
between 821.000 and 824.975 MHz and 5 kHz 
maximum deviation for all other frequencies. When 
12.5 kHz is selected, deviation is 2.5 kHz with all 
frequencies.

Transmit Power - Fixes the transmit power on the 
system for the high or low level or makes it select-
able (the high/low power function switch is then 
required). 

RSSI Threshold (SmartZone Only) - Sets the RSSI 
(Receive Signal Strength Indicator) levels that deter-
mine when searching for and switch to another site 
occurs. Do not change the default levels unless you 
are familiar with how these settings affect operation.

Hot DTMF - When enabled, DTMF digits are sent 
when buttons are pressed when transmitting in the 
SMARTNET/SmartZone analog mode.

STAR Trunking - Selects this feature which is avail-
able with SmartZone systems. The system selected in 
the “System ID” box is then regarded as the “Home” 
system and no other system information is required 
to use this feature. The talk groups must be entered 
as with non-Omnilink systems, and all other 
programming occurs on the infrastructure side. All 
required roaming information is received via adja-
cent site control channel data.

SMARTNET/SmartZone System Page 2 Screen 
Description

An additional system screen is opened/closed by 
clicking the  buttons in the upper right corner 
of the screen. The following additional parameters are 
then displayed:

Analog Transmit DES/DES-XL* - Allows the type 
of encryption to be specified individually for Unit 
and Interconnect calls made in the analog mode. 
DES-XL is available only with the Motorola UCM 
encryption module (see Section 16).

* This feature available only in 51xx/53xx models with Flash
code 2.x or 3.x (see Section 16).
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SmartZone Customized Roaming Properties Screen (SmartZone/P25 Trunked Only)

Customized Roaming Properties (SmartZone Only)

SmartZone and Project 25 Trunked roaming 
properties can be customized by clicking the  
button. The screen shown above is then displayed. 
Information programmed in this screen is described in 
the “Notes” window that is displayed. The RSSI Filter 
slider bar controls how quickly the radio reacts to 
dropouts in the RSSI level. The more aggressive the 
setting, the quicker site switching occurs. 

Other (SmartZone Only)

Disable Site Trunking Operation* - When checked, 
site trunking is disabled on the system.

8.2 SMARTNET/SMARTZONE SYSTEM LISTS

The various SMARTNET/SmartZone lists are 
selected by the System Lists drop-down list on the 
SMARTNET/SmartZone Per system screen (see Figure 
8-1). After the desired list is selected, it is edited by 
clicking the  button. Descriptions of the 
various lists and the information they program follow.

Control Channel List

The Control Channel List screen which follows 
allows the system manager to view and edit the control 

channels. Each SMARTNET system can have up to 
four control channels, and each SmartZone system can 
have up to 48 control channels. With the 5300 Rev 4 
or earlier logic board, up to 32 SmartZone entries are 
allowed. Only one control channel is active at a time. 

To display this screen, on the SMARTNET/
SmartZone Per System screen, select Control Channel 
List in the drop-down list and then click the 

 button (see Figure 8-1). 

To add a channel, click the  button, and to 
delete a channel, simply select it and click the Delete 
button. To edit a channel, select the digits to be changed 
and edit them as desired. For the 800 MHz band, only 
the receive channel frequency can be changed and the 
transmit frequency is automatically calculated (45 MHz 

* This feature available only with 51xx firmware 1.16/2.6/3.6/4.2 or 
later and 53xx firmware 1.28/2.6/3.6/4.2 or later.
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below the receive frequency). These are the mobile 
frequencies, not the repeater frequencies. Only multi-
ples of 5 kHz and 6.25 kHz are valid. 

Status Alias List

The Status Alias List screen shown above 
programs the alias for each of up to eight status condi-
tions that can be sent. The meaning of each status 
number is defined by the system manager. 

To display this screen, on the SMARTNET/
SmartZone Per System screen, select Status Alias List 
in the drop-down list and then click the  
button (see Figure 8-1). To add an alias, click the 

 button, and to delete an alias, simply select it 
and click the Delete button. To edit an alias, select it 
and change it as desired. Up to 10 characters can be 
entered that identify the status. This identification is 
displayed when the user selects a status condition.

Message Alias List

The Message Alias List screen which follows 
associates an alias (name) with each message number. 
The meaning of each message number is defined by 
the system manager. 

To display this screen, on the SMARTNET/
SmartZone Per System screen, select Message Alias 
List in the drop-down list and then click the 

 button (see Figure 8-1). To add an alias, 
click the  button, and to delete an alias,

simply select it and click the Delete button. To edit an 
alias, select it and change it as desired. Up to 10 char-
acters can be entered that identify the message. This 
identification is displayed when the user selects a 
message. 

Call List

The Call List screen which follows programs the 
list of IDs used for private calls. A maximum of 255 
IDs can be programmed. To display this screen, on the 
SMARTNET/SmartZone Per System screen, select 
call list in the drop-down list and then click the 

 button (see Figure 8-1). 

To add a call, click the  button, and to 
delete an call, simply select it and click the Delete 
button. To edit an Alias or ID, select it and enter the 
desired information as follows:

Alias - Up to ten characters can be entered to identify 
the user being called. This identification is displayed 
when the mobile to be called is selected by the user 
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from the list. In addition, when a call is received from 
a unit in this list, the alias of the unit is then displayed 
instead of the unit ID number. Only uppercase letters 
can be entered, so lowercase letters are automatically 
converted to uppercase by the program.

ID - This is the ID of the radio being called. Valid 
entries are 0 - 65535. A “0” is detected as no entry. 

Phone List

The Phone List screen shown above programs the 
telephone number list used for placing telephone calls 
if applicable. A maximum of 255 numbers can be 
programmed. To display this screen, on the 
SMARTNET/SmartZone Per System screen, select 
Phone List in the drop-down list and then click the 

 button (see Figure 8-1). 

To add a call, click the  button, and to 
delete an call, simply select it and click the Delete 
button. To edit an alias or number, select it and enter 
the desired information as follows:

Alias - Up to ten characters can be entered to identify 
the number being called. This identification is 
displayed when the number to be called is selected by 
the user from the list. Only uppercase letters can be 
entered, so lowercase letters are automatically 
converted to uppercase by the program.

ID - This is the telephone number dialed when the 
location is selected. The 3-digit area code and 7-digit 
telephone number are entered using the numbers 0-9. 

Talk Group List

The Talk Group List screen which follows sets up 
SMARTNET/SmartZone talk groups and programs 
unique talk group information. To display this screen, 
on the SMARTNET/SmartZone Per System screen, 
select the Talk Group List drop-down system list and 
then click the  button (see Figure 8-1). 

The parameters programmed in this screen are as 
follows: 

ID - This list displays the talk group IDs currently 
contained in the Talk Group list. To edit a talk group 
ID in this list, select it and then change it in the 
Selected Group box. This is the actual ID of the talk 
group. Talk groups are assigned to channels in the 
Zone screen (see page 63). NOTE: This ID can be 
entered in either the decimal or hexadecimal format as 
described in Section 1.9.4.

 - Clicking this button adds the next avail-
able talk group ID to the list. Each SMARTNET/
SmartZone system can be programmed with up to 
255 talk groups.

SmartZone
Only
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Add Mode

To add an entire block of talk group IDs or a 
specific ID, click the arrow button  in the lower 
right corner of the screen. The following screen is then 
displayed:

Add Mode Drop Down List - “Single” adds the next 
available ID similar to the preceding “Add” button. 
“Multiple” adds a block of IDs as follows. To initiate 
the selected add operation, click the preceding “Add” 
button. If the specified ID range results in duplicate 
IDs, an error message is displayed and no IDs are 
added.

Start ID - Specifies the starting ID of the block.
ID Count - Specifies the number of IDs to be 
added.
ID Step - Specifies if consecutive IDs are added or 
some other step rate is used. 

For example, if Start ID =10, ID Count = 5, and ID 
Step = 10, the IDs added are 10, 20, 30, 40 and 50. 

Use Selected Group’s Security - When selected, the 
added groups are automatically programmed with 
the Strapping Mode, Encryption Key ID, and Group 
Type (Analog or Digital) of the selected group.

 - Clicking this button deletes the talk 
group that is currently selected in the list.

Group Type - Selects either Analog or Digital 
signaling on the talk group. 

Use System Preferred Site List (SmartZone Only) - 
Selects one of the preferred sites for the talk group. 
Refer to the “Preferred Sites” description which 
follows for more information.

Strapping Mode

Strapped Clear - All transmissions on the talk 
group occur in the clear (unscrambled) mode. 

Strapped Secure - All transmissions on the talk 
group occur in the secure (scrambled) mode 
selected as follows.

Switched Mode - The clear or secure status of the 
talk group is selected by the Clear/Secure option 
switch.

Security Type

NOTE: Voice encryption is an optional feature 
that requires factory programming and possibly 
special hardware.

SecureNet - Selects the Motorola SecureNet DES 
type of secure communication when either the 
coded or switched strapping mode is selected. 

Scrambling - Selects the Transcrypt 460 type of 
secure communication when either the coded or 
switched strapping mode is selected. This type of 
encryption is no longer available. 

Scrambling Type

When Transcrypt scrambling is selected, selects 
the type. Currently, only the 460 type is available.

Tx DES/DES-XL

With analog channels, when SecureNet secure 
communication is selected, selects either the DES 
or DES-XL type. (DES-XL is available only in 
later models equipped with the UCM module.) On 
digital channels, the type is not selectable and both 
DES-OFB and AES encryption are supported. The 
actual type used is determined by the encryption 
key that is selected by the talk group (see 
following). NOTE: AES encryption is not avail-
able with the 51SL/53SL.

Key PID - Selects the location from 0-15 (PID/ASN 
mode) or 1-16 (SLN/CKR mode) of the key used for 
secure calls on the group if applicable.
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Rx Auto Detect

Secure - If this option is checked, an encrypted 
signal is automatically detected and received. This 
option may increase the response time to incoming 
signals. If it is not checked, those signals are 
detected only if they are coded like the transmit 
signals.

Proper Key - If this option is checked, the radio 
will search the available encryption keys until it 
finds a match for the current transmission.

Failsoft Enable - If this box is checked, a failsoft 
channel is enabled on the talk group if a controller or 
other major failure occurs. If this box is not checked, 
the failsoft mode is not entered if a failure occurs.

Tx/Rx Frequency - Programs the failsoft channel 
frequency if “Enable” is checked.

Preferred Sites (SmartZone Only)

With SmartZone systems, up to four Preferred 
Sites and/or a Preferred Site List* can be associated 
with each talk group. This forces a call on the talk 
group to access the specified sites. The system 
manager can then keep mobiles on specific sites even 
if the “Site Search” feature has not been enabled. The 
preference for each site can be programmed for Least, 
None, Preferred, or Always as follows.

The Preferred Site Lists are programmed by the 
System Preferred Site List screen described on 
page 61. Up to 16 lists can be programmed, and each 
site can include up to 16 sites. 

If both a Preferred Site List and one or more 
Preferred Sites (selected at bottom of screen) are asso-
ciated with a talk group, the Preferred Sites at the 
bottom are searched first. The first entry found for a 
given site is used. If the same site is in both lists, the 
entry in the list at the bottom of the screen is used first. 

Use Sys Preferred Site List* - When this box is 
checked, the talk group is associated with a Preferred 
Site List. The specific site list is selected by the drop 
down list.

 - Displays the Preferred Site List 
screen described on page 61 as a quick reference to 

determine which sites are included in each site list. 
This screen is for informational purposes only, so 
lists can be viewed but not be edited. Clicking the 
“Select into Talk Group” button sets the “List To 
Use” field in the main screen to the selected list.

Talk Group Specific Preferred Sites - Up to four indi-
vidual sites can also be associated with each talk 
group (see preceding information). Sites are enabled 
using the checkbox, the applicable site ID is entered 
in the Site ID box, and the drop down list programs 
the selected site preference for Least, None (no pref-
erence), Preferred, or Always (preferred).

Announcement Group List

The Announcement Group List screen shown 
above sets up SMARTNET/SmartZone announce-
ment groups that are used to communicate with several 
talk groups simultaneously. Each announcement group 
can have up to 15 talk groups.

To display this screen, on the SMARTNET/
SmartZone Per System screen, select the Announce-
ment Group List in the drop-down list and then click 
the  button (see Figure 8-1). The parame-
ters programmed in this screen are as follows: 

Group ID - This list displays the Announcement 
group IDs currently contained in the Announcement 
Group list. To edit an ID in this list, select it and then 
change it in the Selected Group box. This is the 
actual ID of the announcement group. Announce-
ment groups are assigned to channels in the Zone 
screen (see page 63). NOTE: This ID can be entered 
in either the decimal or hexadecimal format as 
described in Section 1.9.4.

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.
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 - Clicking this button adds the next avail-
able announcement group ID to the list. Each 
SMARTNET/SmartZone system can be 
programmed with up to 255 announcement groups.

To add an entire block of announcement group IDs or 
a specific ID, click the arrow button  in the lower 
right corner of the screen. The following screen is 
then displayed. Refer to the preceding “Talk Group 
List” description for more information on this screen.

 - Clicking this button deletes the 
announcement group that is currently selected in the 
list.

Group Type - Selects either Analog or Digital 
signaling on the announcement group. 

Use System Preferred Site List (SmartZone Only) - 
Selects one of the preferred sites for the announce-
ment group. Refer to the preceding Talk Group List 
description for more information.

Security - Programs the secure communication oper-
ation on each announcement group similar to talk 
groups described in the preceding “Talk Group List” 
description.

Talk Group ID - Selects the talk groups that are 
included in each announcement group. This ID can 
also be entered in either decimal or hexadecimal 
format as described in Section 1.9.4.

Preferred Sites (SmartZone Only) - Programs the 
preferred site information similar to talk groups 
described in the preceding “Talk Group List” 
description. Up to four Preferred Sites and/or a 
Preferred Site List a can be associated with each 
announcement group. 

Priority Scan List

NOTE: Before the priority monitor scan lists can be 
programmed as follows, the channels to be included in 
these lists must be set up in the Zone screen as 
described in Section 8.3 on page 63.

The Priority Scan List screen shown above sets 
up the Priority (Standard) Scan lists that can be 
programmed on each SMARTNET or SmartZone 
system. Each scan list can include up to 16 channels, 
one of which may be a priority channel. These chan-
nels must be from the same SMARTNET or Smart-
Zone system. Channels from other systems are not 
allowed. 

To display this screen, on the SMARTNET/
SmartZone Per System screen, select Priority Scan 
List in the drop-down list and then click the 

 button (see Figure 8-1). 

List Number - This drop-down list selects the scan 
list to edit. Click the “Add” button to add a scan list 
and “Delete” to delete a scan list. 

 - Clicking this button displays the screen 
shown on the right above which is used to edit the 
selected scan list. Check the channels in each zone to 
be included in the selected scan list. Repeat for the 
other scan lists if applicable. 

Scan Mode - If priority scan is used on a list, select 
“Priority on Selected” (51xx/53xx only) or “Priority 
on Programmed” from the drop down list. If priority 
scanning is not used, select “Non Priority Scan”. If 
“Priority on Programmed” is selected, check the 
priority box of the desired priority channel. 

NOTE: Priority talk group scanning must also be 
supported at the system level for it to occur as 
programmed. Talk Groups programmed as “Priority” 
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in PCConfigure must also be designated as Priority 
Monitor Groups by the System Control software.

Site List (SmartZone Systems Only)

Sites in a SmartZone system are designated by a 
number. The Site List screen shown above programs 
an alias for each site number that is displayed when 
using the Site Search feature. 

To display this screen, on the SmartZone Per 
System screen, select Site List in the drop-down list 
and then click the  button (see Figure 8-1). 
To add an alias, click the  button, and to 
delete an alias, simply select it and click the Delete 
button. To edit an alias or ID, simply select it and 
make the desired changes. 

Alias - Programs up to 10 alphanumeric characters 
that identify the site. 

ID - Site ID from 0-48. With the 5300 Rev 6 logic 
board, up to 255 entries are supported.

System Preferred Site List (SmartZone 
Systems Only)*

The Preferred Site List screen which follows 
programs up to 16 Preferred Site Lists. These lists can 
be associated with individual talk groups on the Talk 
Group List screen described starting on page 57. This 
forces calls on a talk group to access specific sites. The 
preference for each site in a list can be set for Least, 
None, Preferred, or Always as follows.

Each list can be programmed with up to 16 sites. 
Therefore, the use of Preferred Site Lists allows up to 
16 sites to be associated with a group instead of just 4 
available on the Talk Group List screen. In addition, if 
several talk groups are associated with the same sites, 
a list can simply be selected instead of separate sites. 

Site Lists - This drop down list selects the list to be 
edited. To add a new list, click the “Add” button. To 
delete the selected list, click the “Delete” button.

Sites In List - To add/delete a site from the list, click 
the checkbox.

Site ID - Enter the site ID from 0-48.

Preference - Select the site preference in the drop 
down list. A default weighting is usually assigned to 
these preference levels which results in the most 
preference given to “Always” and the least prefer-
ence to “Least” as follows:

1. Always (preferred)
2. Preferred
3. None (no preference)
4. Least (preferred)

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.
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Other Band Trunking List (VHF/UHF Only)

The Other Band Trunking screen shown above 
can be displayed only when programming channels in 
the VHF and UHF frequency bands. It is used to 
define the relationship between transmit and receive 
channel frequencies in these bands. With 800 MHz 
systems, this is not required because the difference 
between transmit and receive frequency is always 
45 MHz. 

To display this screen, on the SMARTNET/
SmartZone Per System screen, select the Other Band 
Trunking in the drop-down list and then click the 

 button (see Figure 8-1). 

This screen organizes the available frequency 
band into three sub-bands, called splits. Each split is 
defined by a start frequency, stop frequency, and 

channel spacing as follows. Frequencies outside the 
defined split cannot be accessed by the radio. These 
frequency splits must be defined the same way they 
are defined for the trunking controller.

Tx and Rx Spacing - Spacing in kHz between each 
potential transmit and receive frequency.

Tx and Rx Start Frequency - Start in MHz of the band 
split for transmit and receive frequencies.

Tx and Rx Stop Frequency - Stop in MHz of the band 
split for transmit and receive frequencies.

User Group ID List*

This User Group ID List screen shown above 
programs aliases that can be displayed if a call is 
received on a talk group ID within the programmed 
block. For example, with the preceding screen, if a 
group call is received on group IDs 234-264, the alias 
“Fire” can be displayed. The display of this alias is 
controlled by the “User Group ID” parameter on the 
Radio Wide screen.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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Figure 8-2   SMARTNET/SmartZone Channel Screen

8.3 SMARTNET/SMARTZONE CHANNEL 
PARAMETERS

After the desired channels have been set up as 
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown 
in Figure 8-2 and then select the desired Zone using 
the drop-down list in the “Zones” box. Screens which 
program individual channel parameters are selected by 
clicking the channel in the “Channels” box.

The parameters displayed when a SMARTNET/
SmartZone channel is selected are as follows. Conven-
tional and Project 25 Trunked channels are described 
in Sections 7 and 9.

Channel Parameters

Channel Type - Indicates the type of channel that is 
currently selected in the “Channels” box.

Channel Alias - Programs the alias (identification) 
that is displayed when the channel is selected. Up to 
ten characters can be programmed. 

Scan List - Selects the priority (standard) scan list 
selected by the channel. If “No List” is selected, 
scanning is not selectable on that channel. 

Auto Scan - When this is checked, the radio automat-
ically begins scanning the scan list associated with 
the channel whenever the channel is selected. When 
it is not checked, scanning must be started manually 
by the Scan option switch.

IDs

Operation with the various combinations of Talk 
Groups (TGs) and Announcement Groups (AGs) is as 
follows: 

Talk Group Only - Transmit on TG, receive on TG.
Announcement Group Only - Transmit on AG, 

receive on all TGs in AG.
Talk and Announcement Groups - Transmit on 

TG and receive on TG plus AG but not the TGs 
assigned to the AG.

NOTE: These IDs can be entered in either the decimal 
or hexadecimal format as described in Section 1.9.4.

Talk Group ID - Selects the talk group selected by 
that channel. Talk Groups are programmed by 
selecting “Talk Group List” on the Per System screen 
(see page 57).
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Announcement Group ID - Selects the receive-only 
announcement group selected by that channel. 
Announcement Groups are programmed by selecting 
“Announcement Group List” on the Per System 
screen (see page 59).

Emergency Group ID - Selects the talk group used 
for emergency calls on the channel. 

Other

Talk Permit Tone - When this feature is checked, a 
short tone sounds after a request for a group call has 
been approved by the main controller. This indicates 
that speaking can begin. When not checked, no audio 
feedback is used to indicate when speaking can 
begin.

Make Dynamic Regrouping Channel - Checking this 
box designates the channel as the dynamic 
regrouping channel. The talk group is then 
programmed over the air, so the Talk Group ID and 
Announcement Group ID are not programmable.

Dynamic Regrouping must be enabled on the System 
screen to program a dynamic regrouping channel. 
The dynamic talk group does not need to be a 
programmed group. 

A Cancel Dynamic Regrouping* option button or 
menu parameter (51xx only) can now be 
programmed (see Sections 5.3 and 5.4). This allows 
the user to reselect the previous talk group if desired.

Transmit Disabled** - When this feature is checked, 
transmitting is disabled on the channel, and it can be 
used for monitoring only.

** This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.

* This feature available only with radio firmware Version 1.14.0/
2.4.0/3.4.0 (51xx) or 1.26.0/2.4.0/3.4.0 (53xx) or later.
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SECTION 9   PROJECT 25 TRUNKED SYSTEMS AND CHANNELS

Figure 9-1   P25 Trunked System Screen

9.1 INDIVIDUAL P25 TRUNKED SYSTEM 
PARAMETERS

NOTE: Some P25 trunking parameters can be edited 
only if the proper system key is detected. A key is being 
detected if a yellow key icon is indicated as shown in 
Figure 8-1. If there is a red “X” through this icon, a 
key is not being detected. Refer to Section 13 for more 
information.

Individual system parameters are programmed by 
the “Per System” screen shown in Figure 9-1. These 
parameters can be programmed after the desired 
systems have been set up as described in Section 1.10. 

There are also radio wide system parameters that 
are programmed by the Radio Wide screen as 
described in Section 5.7. For information on program-
ming individual Conventional and SMARTNET/
SmartZone system parameters, refer to Sections 7.1 
and 8.1. 

The parameters in the individual P25 Trunked 
System screen are as follows:

IDs

NOTE: These IDs can be entered in either the decimal 
or hexadecimal format as described in Section 1.9.4.

System ID - This drop down list selects the Home 
System ID of the radio. This must be a unique ID 
within a Wide Area Communications Network 
(WACN). This ID comes from the system key in the 
“Keys” folder (see above “Note” at beginning of this 
section). System ID numbers can be 1-4094 (001-
FFE hex). If a valid system key is not detected, only 
a default ID of “1” can be selected. 

WACN - This ID determines the home Wide Area 
Communications Network to which the radio is 
assigned. One or more systems make up a WACN. 
Valid WACN IDs are 1-1048574 (00001-FFFFE 
hex).
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Site - Specifies the home site of the radio. If the Zone 
Fail Site Lock feature is enabled, this also determines 
the site to which the radio is restricted.

RFSS - Specifies the RF subsystem (zone controller) 
that is used as the default, or that the radio is 
restricted to if the SmartZone coverage option is 
enabled. One or more RF Subsystems make up a 
system. Valid IDs are 0-254.

Unit - Provides a unique identification of the radio on 
a system. Therefore, each radio must have a different 
Unit ID. Valid Unit IDs are 1-16,777,215 (000001-
FFFFFF hex). The decimal version of this ID is the 
private call ID of the radio.

Keys

Programs the following encryption key ID (hard-
ware location) that is used for all except group calls.

Failsoft - Key used in failsoft conditions.

Patch - Key used in patch calls.

Private Call - Key used for unit-to-unit (private) 
calls.

Interconnect - Key used for telephone calls.

Dynamic Talk Group - Key used for dynamic talk 
groups.

System Lists - Refer to page 70 for more information.

Emergency

Emergency Alarm

Disabled - No emergency signal is sent when the 
user presses the Emergency option switch.

Normal - An emergency alarm is sent when the 
user presses the Emergency switch. If the Emer-
gency Call is disabled, the alarm always occurs on 
the selected group. If the Emergency Call is 
enabled, it occurs, in order of preference, on the 
Emergency group, selected group, and Announce-
ment group. When an emergency condition is sent, 

the red transmit indicator lights, an emergency 
tone sounds, and EMERGNCY flashes in the 
display. EMERGNCY continues to flash until 
power is cycled, the channel is changed, or the 
Emergency switch is pressed and held.*

Silent - Same as “Normal” except none of the 
above audio or visual indications occur. 

Emergency Call

Enable - When this box is checked, if the Emer-
gency option switch and then the PTT switch are 
pressed, an emergency group call is transmitted on 
the Emergency group. The emergency mode is 
canceled by cycling power or pressing and 
holding* the Emergency switch.

Disable - When this box is not checked, an emer-
gency group call is not authorized.

Emergency Hot Mic

Enable - When this box is checked and an emer-
gency alarm is sent by pressing the Emergency 
switch, automatic transmitting occurs with the 
microphone audio unmuted (without user inter-
vention) for the time specified by the following 
Emergency Hot Mic Time. If it is not checked or if 
neither emergency call is selected, automatic 
transmissions do not occur. This feature is initiated 
only by the first press of the Emergency switch. 
Subsequent presses do not trigger automatic trans-
missions. This function resets if the channel is 
changed. 

Disable - When this box is not checked, automatic 
transmissions do not occur.

Emergency Hot Mic Time - Defines the period 
during which transmissions occur. Times of 10-120 
seconds in 10-second steps can be selected.

Emergency Retry Counter - When “Infinite” is 
checked, an emergency call is repeated until 
acknowledged or canceled. When it is not checked, 
calls are attempted only the specified number of 
times.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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No Rx Activity During Emergency* - When this box 
is checked, the following receive indications are 
disabled in the emergency mode: receive audio, 
receive LED, receive icons. 

Time/Timers

Time-Out Timer - This timer determines the 
maximum length of a continuous transmission. It can 
be programmed for 15-225 seconds in 15-second 
steps or it can be disabled (0).

RFSS Response Time - Specifies the time between 
attempts to affiliate on RFSS sites. Times of 625-
7000 ms can be programmed with a default of 625 
ms.

Force Unmute Time - Specifies the maximum time 
the radio remains muted after transmitting because of 
probable system throughput delay. If it is determined 
that the incoming audio signal is from some other 
radio, this delay is disregarded. Times of 25-6375 ms 
can be programmed with a default of 1200 ms.

PTT Warning Time - Specifies the time the radio 
waits before sounding the PTT Prohibit Tone to warn 
the user that the PTT request is being processed and 
the PTT switch should be released. Times of 25-6375 
ms can be programmed with a default of 4000 ms.

Busy Update Timer - Specifies the time the radio 
waits in a busy state for a reject, grant, or another 
busy update from the radio system. When this timer 
expires, a response is no longer expected from the 
system and the transmission is retried. Times of 15-
945 seconds can be programmed with a default of 30 
seconds.

Response Pending Timer - Specifies the time the 
radio waits when expecting a further response from 
the radio system to a request. This occurs when the 
system sends a response indicating that the request is 
being processed and a response is coming. When this 
timer expires, a response is no longer expected and 
the radio returns to the idle state. Times of 1-255 
seconds or infinite can be programmed with a default 
of 6 seconds.

ISP Sequence Length - Specifies the time allowed 
per site for an ISP retry request. The radio retries 

until this timer expires (at least five retries are made 
regardless of this timer setting). Times of 1-255 
seconds or infinite can be programmed with a default 
of 5 seconds.

Quick Fade Protect - Specifies the time the radio will 
stay on the control channel when synchronization is 
lost before resynchronizing. This allows recovery 
without performing a full resynchronization of the 
channel. Times of 200-6575 ms can be programmed 
with a default of 2000 ms.

Scan Hold Time - Specifies the delay that occurs 
after a message is no longer received before scanning 
resumes. Times of 2-10 seconds can be programmed 
with a default of 3 seconds.

Other

Talk Permit Tone - When selected, a short tone 
sounds after a request for a group call has been 
approved by the main controller. This indicates that 
speaking can begin. When not checked, no audio 
feedback is used to indicate when speaking can 
begin.

Radio Inhibit - When selected, the dispatcher can 
disable/enable the radio. When this command is 
received by the radio, an acknowledgment is sent to 
the dispatcher and then it is disabled as follows. The 
radio can be enabled again by the dispatcher or by 
reading and then re-writing the programming data 
using PCConfigure.

• Receive audio is muted and transmit audio 
disabled

• All radio controls are inoperative
• Scanning is disabled on the selected mode (P25 

trunking)
• The transmit indicator is disabled and the display 

is blanked

Radio Check - When selected, the radio will respond 
to a remote check command. This command can be 
sent by the dispatcher to confirm that the radio is 
active and operational on the system. If this feature is 
not enabled, this command is ignored.

* This feature available only with radio firmware Version 1.14.0/
2.4.0/3.4.0 (51xx) or 1.26.0/2.4.0/3.4.0 (53xx) or later.
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SmartZone Coverage Type - When selected, roaming 
is limited to the selected RFSS controller. If not 
selected, roaming can occur across all available 
RFSS controllers in the WACN system.

Conversation Type

Message Trunking - Not available with P25 
trunking.

PTT - ID -This mode is always selected with P25 
trunking. The radio can key during the 
programmed hang time and continue the conversa-
tion on the active channel. If a user keys during the 
hang time, re-affiliation with the system occurs 
before using the voice channel. The voice channel 
is held while this re-affiliation occurs, and the call 
is then routed to the open voice channel. This 
results in all traffic being logged, even the radios 
which transmit during the hang time.

Transmission Trunking - Not available with P25 
trunking.

Status Aliasing - Enables and disables Status 
Aliasing for the system. This function permits 
customization of status numbers and allows an alias 
name to be assigned to each number. 

Dynamic Regrouping - When checked, a dynamic 
regrouping channel can be programmed. This is a 
Project 25 trunked channel which has the talk group 
dynamically set by the dispatcher. It is selected on 
the channel screen (see Section 9.3).

Default RCM Address - Specifies the Radio Control 
Manager used as the target address of Inbound 
Signaling Packet (ISP) transmissions such as Status 
and Message transmissions. Hexadecimal addresses 
from 000000-FFFFFF can be programmed, and the 
default is FFFFFC.

Private Call Usage 

Disabled - Private calls cannot be placed or 
received.

Response Only - Private calls can be received but 
not placed.

List Only - Private calls can be placed and 
received, and numbers can be recalled from a 
preprogrammed list only.

Unlimited - Private calls can be placed and 
received, and numbers can be recalled from a 
preprogrammed list or dialed using a keypad. With 
53xx radios (firmware Version 1.28/2.6/3.6/4.2 or 
later only), this mode is supported only when the 
HHC control unit is used. Standard 53xx front and 
remote models do not support number dialing. 
NOTE: To enter this mode, the Phone key must be 
pressed and held until a tone sounds.

Phone Interconnect Usage* - Programs operation of 
telephone calls same as “Private Call Usage” above.

Call Alert Usage - Programs operation of Call Alert 
calls (pages) the same as “Private Call Usage” above.

Transmit Power - Fixes the transmit power on the 
system for the high or low level or makes it select-
able (the high/low power function switch is then 
required).

Disable Site Trunking Operation - When checked, 
site trunking is disabled on the system.

Inactivity Auto-Reaffiliation - If this is checked the 
radio tries to re-affiliate on the system if there has 
been no activity on the radio for the amount of time 
programmed by the Auto Re-Affiliation Timer.

P25 Trunked System Page 2 Screen Description

An additional system screen is opened/closed by 
clicking the  buttons in the upper right corner 
of the screen. The following additional parameters are 
then displayed:

* This feature available only with radio firmware Version 1.14.0/
2.4.0/3.4.0 (51xx) or 1.26.0/2.4.0/3.4.0 (53xx) or later.
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OTAR and Data Settings*

NOTE: The SLN (CKR) key management mode must 
be selected on Page 2 of the Global screen to select 
the OTAR and Data parameters which follow.

Clicking the  button displays the 
following screen which programs various OTAR and 
P25 data parameters:

OTAR

OTAR Enabled - Select “On” to enable OTAR 
(Over-the-Air Rekeying) of encryption keys. Select 
“Off” to disable this feature.

Rekey Request Time Out - When rekeying is initi-
ated by the radio (OTAR Rekey Request message 
sent), this setting determines how long the radio 
waits for a response from the Key Management 
Facility (KMF). Times of 20-180 seconds can be 
programmed.

Rx Security Level - When Enhanced is selected, only 
encrypted and authenticated KMMs from the KMF 
are accepted (except for warm-start, which is authen-
ticated only). If Basic is selected, any KMM is 
accepted that is in a format allowed by the OTAR 
standard. 

Tx Security Level - When Enhanced is selected, all 
OTAR procedures originating from the radio are 
encrypted and authenticated. If they cannot be 
encrypted and authenticated, the KMM will not be 
sent. When Basic is selected, the radio always sends 

KMMs in the clear (if the OTAR standard allows 
them to be unencrypted and unauthenticated). 

Registration Inactivity Timer - If the radio has not 
registered any OTAR activity within the given 
amount of time set by this timer (in hours), the radio 
attempts to re-register with the KMF.

Originating Response Kind - Selects if a response is 
required from the KMF to outgoing messages. If 
“Kind 1-Unconfirmed” is selected, no response is 
requested, and if “Kind 3-Confirmed” is selected, 
and immediate response is requested.

Registration Number of Attempts - Specifies the 
maximum number of attempts that are made to 
complete a successful OTAR registration.

Registration Time Between Attempts - Specifies the 
time in seconds to wait after an unsuccessful OTAR 
registration attempt before again attempting to 
register. It is suggested that this amount of time be 
greater than the following CAI Data Max Tx 
Attempts “Response Timer” (in seconds).

KMF IP Address - The IP address of the KMF.

KMP UDP Port - The UDP Port to use when sending 
Key Management Messages (KMMs) to the KMF. 
The default value is 64414.

Subscriber OTAR UDP Port - The UDP Port of the 
subscriber unit to be used for OTAR. The default 
value is 64414.

Data/SNDCP (Simple Network Data Control 
Protocol)

CAI Data Max Tx Attempts - Selects the maximum 
number of times the radio attempts to send a CAI 
data packet transmission. Retrys continue until it 
receives an acknowledgement confirming the 
successful receipt of transmission, or until the 
selected amount of transmit attempts is reached.

Response Timer - Selects the amount of time the 
radio waits for an acknowledgement that a CAI 
transmission is successful before resending.

* These features available only with 51xx firmware 1.16/2.6/3.6/
4.2 or later and 53xx firmware 1.28/2.6/3.6/4.2 or later.
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SNDCP Activation Wait Timer - This controls the 
time that an radio waits for the KMF to respond to a 
SNDCP context activation request.

SNDCP Dwell Timer - Controls the dwell time.

Rx Voice Interrupts Data - When checked, the voice 
call can interrupt data. 

Subscriber IP Address - Currently not used. This is 
the default address used for data operations.

Mobile Computer IP Address - Currently not used.

Customized Roaming Properties 

Same as with SmartZone operation. Refer to 
description on page 55.

9.2 P25 TRUNKED SYSTEM LISTS
The various P25 trunking lists are selected by the 

“System Lists” drop-down list on the P25 Trunking 
Per system screen (see Figure 9-1). After the desired 
list is selected, it is edited by clicking the  
button. Descriptions of the various lists and the infor-
mation they program follow.

Channel ID List (All Except 800 MHz)

The Channel ID List screen shown above can be 
displayed only when programming channels in the 
VHF, UHF, and 700/800 MHz frequency bands (Other 
Band Trunking). Both Explicit* and Implicit 
addressing is now available. 
NOTE: Channel ID and Control Channel information 
is provided by the system manager and must match the 
programming of other subscriber units for it to func-
tion properly on the system. 

With Implicit Addressing, only the receive 
frequency is sent by the control channel and informa-
tion in this table is used to determine the transmit 
frequency. With Explicit Addressing, both the receive 
and transmit frequencies are sent. Both types reference 
information in this table. This table is not required 
with 800 MHz systems because the difference between 
transmit and receive frequency is always 45 MHz. 

Control Channel List

The Control Channel List screen which follows 
allows the system manager to view and edit the control 
channels. Each P25 trunking system can have up to 
255 control channels. Only one control channel is 
active at a time. 

To display this screen, on the P25 Trunking 
System screen, select Control Channel List in the 
drop-down list and then click the  button 
(see Figure 9-1). 

To add a channel, click the  button, and to 
delete a channel, simply select it and click the Delete 
button. To edit a channel, select the digits to be changed 
and edit them as desired. For the 800 MHz band, only 
the receive channel frequency can be changed and the 
transmit frequency is automatically calculated (45 MHz 
below the receive frequency). These are the mobile 
frequencies, not the repeater frequencies. Only multi-
ples of 5 kHz and 6.25 kHz are valid. 

Status Alias List

The Status Alias List screen shown which follows 
programs the alias for each of up to eight status condi-
tions that can be sent. The meaning of each status 
number is defined by the system manager. 

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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To display this screen, on the P25 Trunking Per 
System screen, select Status Alias List in the drop-
down list and then click the  button (see 
Figure 9-1). To add an alias, click the  button, 
and to delete an alias, simply select it and click the 
Delete button. To edit an alias, select it and change it 
as desired. Up to 10 characters can be entered that 
identify the status. This identification is displayed 
when the user selects a status condition.

Call List

The Call List screen shown above programs the 
list of IDs used for unit calls. A maximum of 255 IDs 
can be programmed. To display this screen, on the P25 
Trunking Per System screen, select call list in the 
drop-down list and then click the  button 
(see Figure 9-1). 

To add a call, click the  button, and to 
delete an call, simply select it and click the Delete 
button. To edit an Alias or ID, select it and enter the 
desired information as follows:

Alias - Up to ten characters can be entered to identify 
the user being called. This identification is displayed 
when the mobile to be called is selected by the user 
from the list. In addition, when a call is received from 
a unit in this list, the alias of the unit is then displayed 
instead of the unit ID number. Only uppercase letters 
can be entered, so lowercase letters are automatically 
converted to uppercase by the program.

ID - This is the ID of the radio being called. Valid 
entries are 1-16,777,215. “0” is detected as no entry. 

Talk Group List

The Talk Group List screen which follows sets up 
P25 Trunking talk groups and programs unique talk 
group information. To display this screen, on the P25 
Trunking Per System screen, select the Talk Group 
List drop-down system list and then click the 

 button (see Figure 9-1).

The parameters programmed in this screen are as 
follows: 

Group ID - This list displays the talk group IDs 
currently contained in the Talk Group list. To edit a 
talk group ID in this list, select it and then change it 
in the Selected Group box. This is the actual ID of the 
talk group. Talk groups are assigned to channels in 
the Zone screen (see page 76). NOTE: This ID can be 
entered in either the decimal or hexadecimal format 
as described in Section 1.9.4.
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 - Clicking this button adds the next avail-
able talk group ID to the list. Each P25 trunking 
system can be programmed with up to 255 talk 
groups.

Add Mode

To add an entire block of talk group IDs or a 
specific ID, click the arrow button  in the lower 
right corner of the screen. The following screen is then 
displayed:

Add Mode Drop Down List - “Single” adds the next 
available ID similar to the preceding “Add” button. 
“Multiple” adds a block of IDs as follows. To initiate 
the selected add operation, click the preceding “Add” 
button. If the specified ID range results in duplicate 
IDs, an error message is displayed and no IDs are 
added.

Start ID - Specifies the starting ID of the block.
ID Count - Specifies the number of IDs to be 
added.
ID Step - Specifies if consecutive IDs are added or 
some other step rate is used. 

For example, if Start ID =10, ID Count = 5, and ID 
Step = 10, the IDs added are 10, 20, 30, 40 and 50. 

Use Selected Group’s Security - When selected, the 
added groups are automatically programmed with 
the Strapping Mode and Encryption Key ID of the 
selected group.

 - Clicking this button deletes the talk 
group that is currently selected in the list.

Strapping Mode

Clear - All transmissions on the talk group occur 
in the clear (unencrypted) mode. 

Secure - All transmissions on the talk group occur 
in the secure (encrypted) mode selected as 
follows.

Mode - The clear or secure status of the talk group 
is selected by the Clear/Secure option switch.

Use System Preferred Site List - Selects one of the 
preferred sites for the talk group. Refer to the 
“Preferred Sites” description which follows for more 
information.

Encryption Key ID - Selects the location from 0-15 
(PID/ASN mode) or 1-16 (SLN/CKR mode) of the 
key used for secure calls on the group if applicable.

Failsoft Enable - If this box is checked, a failsoft 
channel is enabled on the talk group if a controller or 
other major failure occurs. If this box is not checked, 
the failsoft mode is not entered if a failure occurs.

Tx/Rx Frequency - Programs the failsoft channel 
frequency if “Enable” is checked.

Preferred Sites

With P25 trunked systems, up to four Preferred 
Sites and/or a Preferred Site List* can be associated 
with each talk group. This forces a call on the talk 
group to access the specified sites. The system 
manager can then keep mobiles on specific sites even 
if the “Site Search” feature has not been enabled. The 
preference for each site can be programmed for Least, 
None, Preferred, or Always as follows.

The Preferred Site Lists are programmed by the 
System Preferred Site List screen described on 
page 75. Up to 16 lists can be programmed, and each 
site can include up to 16 sites. 

If both a Preferred Site List and one or more 
Preferred Sites (selected at bottom of screen) are asso-
ciated with a talk group, the Preferred Sites at the 
bottom are searched first. The first entry found for a 

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.
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given site is used. If the same site is in both lists, the 
entry in the list at the bottom of the screen is used first.

Use Sys Preferred Site List* - When this box is 
checked, the talk group is associated with a Preferred 
Site List. The specific site list is selected by the drop 
down list.

 - Displays the Preferred Site List 
screen described on page 75 as a quick reference to 
determine which sites are included in each site list. 
This screen is for informational purposes only, so 
lists can be viewed but not be edited. Clicking the 
“Select into Talk Group” button in this screen sets the 
“List To Use” field in the main screen to the selected 
list.

Talk Group Specific Preferred Sites - Up to four indi-
vidual sites can also be associated with each talk 
group (see preceding information). Sites are enabled 
using the checkbox, and the following information is 
programmed for each site:

RFSS/Site ID No. - Designates a controller/site 
to which the talk group is allowed to roam.

Preference - Least, None (no preference), 
Preferred, or Always (preferred) is a weighting 
for steering to different sites.

Wide Area System Scan Preference - If the radio 
does not register on the system, it begins scanning to 
the last valid preference site on which it was 
registered.

Announcement Group List

The Announcement Group List screen which 
follows sets up P25 Trunking announcement groups 
that are used to communicate with several talk groups 
simultaneously. Each announcement group can have 
up to 15 talk groups. 

To display this screen, on the P25 Trunking Per 
System screen, select the Announcement Group List in 
the drop-down list and then click the  
button (see Figure 9-1). 

Group ID - This list displays the Announcement 
group IDs currently contained in the Announcement 
Group list. To edit an ID in this list, select it and then 
change it in the Selected Group box. This is the 
actual ID of the announcement group. Announce-
ment groups are assigned to channels in the Zone 
screen (see page 76). NOTE: This ID can be entered 
in either the decimal or hexadecimal format as 
described in Section 1.9.4.

 - Clicking this button adds the next avail-
able announcement group ID to the list. Each P25 
Trunked system can be programmed with up to 255 
announcement groups.

To add an entire block of announcement group IDs or 
a specific ID, click the arrow button  in the lower 
right corner of the screen. The following screen is 
then displayed. Refer to the preceding “Talk Group 
List” description for more information on this screen.

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.
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 - Clicking this button deletes the 
announcement group that is currently selected in the 
list.

Security Parameters - Programs the secure communi-
cation operation on each announcement group 
similar to talk groups described in the preceding 
“Talk Group List” description.

Use System Preferred Site List*- Selects one of the 
preferred sites for the announcement group. Refer to 
the preceding “Preferred Sites” description for more 
information.

Preferred Sites - Programs the preferred site informa-
tion similar to talk groups described in the preceding 
“Talk Group List” description. Up to four Preferred 
Sites and/or a Preferred Site List a can be associated 
with each announcement group. Refer to the 
preceding Talk Group List description for more 
information.

Talk Group ID - Selects the talk groups that are 
included in each announcement group. This ID can 
also be entered in either decimal or hexadecimal 
format as described in Section 1.9.4.

Site List

Sites in a P25 Trunking system are designated by 
a site number and RF subsystem (RFSS) number. The 
Site List screen shown above programs an alias for 
each site that is displayed when using the Site Search 
feature. 

To display the preceding screen, on the P25 
Trunking Per System screen, select Site List in the 
drop-down list and then click the  button 
(see Figure 9-1).

To add an alias, click the  button to 
display the Add Alias/ID screen, and to delete an alias, 
simply select it and click the Delete button. To edit an 
alias or ID, simply select it and make the desired 
changes. 

Alias - Programs up to 10 alphanumeric characters 
that identify the site. 

Site ID - Site ID from 0-48. 

RFSS ID - ID from 0-254 of the site controller that 
will be used.

Priority Scan List

NOTE: Before the priority monitor scan lists can be 
programmed as follows, the channels to be included in 
these lists must be set up in the Zone screen as 
described in Section 9.3 on page 76.

The Priority Scan List screen shown above sets 
up the Priority (Standard) Scan lists that can be 
programmed on each P25 Trunking system. Each scan 
list can include up to 16 channels, one of which may 
be a priority channel. These channels must be from the 
same P25 Trunking system. Channels from other 
systems are not allowed. Up to as many lists can be 
programmed as can be stored in the available memory.

To display this screen, on the P25 Trunking Per 
System screen, select Priority Scan List in the drop-
down list and then click the  button (see 
Figure 9-1). 

List Number - This drop-down list selects the scan 
list to edit. Click the “Add” button to add a scan list 
and “Delete” to delete a scan list. 

 - Clicking this button displays the screen 
shown on the right above which is used to edit the 

* This feature available only in 51xx models with Flash code Version 
1.8.0 or later and 53xx models with ARM code 1.21.0 or later.
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selected scan list. Check the channels in each zone to 
be included in the selected scan list. Repeat for the 
other scan lists if applicable. 

Scan Mode - If priority scan is used on a list, select 
“Priority on Selected” (51xx/53xx only) or “Priority 
on Programmed” from the drop down list. If priority 
scanning is not used, select “Non Priority Scan”. If 
“Priority on Programmed” is selected, check the box 
of the desired priority channel. 

NOTE: Priority talk group scanning must also be 
supported at the system level for it to occur as 
programmed. Talk Groups programmed as “Priority” 
in PCConfigure must also be designated as Priority 
Monitor Groups by the System Control software.

System Preferred Site List

The Preferred Site List screen which follows 
programs up to 16 Preferred Site Lists. These lists can 
be associated with individual talk groups on the Talk 
Group List screen described starting on page 71. This 
forces calls on a talk group to access specific sites. The 
preference for each site in a list can be set for Least, 
None, Preferred, or Always as follows.

Each list can be programmed with up to 16 sites. 
Therefore, the use of Preferred Site Lists allows up to 
16 sites to be associated with a group instead of just 4 

available on the Talk Group List screen. In addition, if 
several talk groups are associated with the same sites, 
a list can simply be selected instead of separate sites. 

Site Lists - This drop down list selects the list to be 
edited. To add a new list, click the “Add” button. To 
delete the selected list, click the “Delete” button.

Sites In List - To add/delete a site from the list, click 
the checkbox.

Site ID - Enter the site ID from 0-48.

Preference - Select the site preference in the drop 
down list. A default weighting is usually assigned to 
these preference levels which results in the most 
preference given to “Always” and the least prefer-
ence to “Least” as follows:

1. Always (preferred)
2. Preferred
3. None (no preference)
4. Least (preferred)

User Group ID List*

This User Group ID List screen which follows 
programs aliases that can be displayed if a call is 
received on a talk group ID within the programmed 
block. For example, with the preceding screen, if a 
group call is received on group IDs 234-264, the alias 
“Fire” can be displayed. The display of this alias is 
controlled by the “User Group ID” parameter on the 
Radio Wide screen.
 

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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Figure 9-2   P25 Trunked Channel Screen

9.3 P25 TRUNKED CHANNEL PARAMETERS

After the desired channels have been set up as 
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown 
in Figure 9-2 and then select the desired Zone using 
the drop-down list in the “Zones” box. Screens which 
program individual channel parameters are selected by 
clicking the channel in the “Channels” box.

The parameters displayed when a P25 Trunking 
channel is selected are as follows. Conventional and 
SMARTNET/SmartZone Trunked channels are 
described in Sections 7 and 8.

Channel Parameters

Channel Type - Indicates the type of channel 
(Conventional Analog, Conventional Digital, 
SMARTNET/SmartZone, Project 25 Trunked) that is 
currently selected in the “Channels” box.

Channel Alias - Programs the alias (identification) 
that is displayed when the channel is selected. Up to 
ten characters can be programmed. 

Scan List - Selects the priority (standard) scan list 
selected by the channel. If “No List” is selected, 
scanning is not selectable on that channel. 

Auto Scan - When this is checked, the radio automat-
ically begins scanning the scan list associated with 
the channel whenever the channel is selected. When 
it is not checked, scanning must be started manually 
by the Scan option switch.

IDs

The possible combinations of Talk Groups (TGs) 
and Announcement Groups (AGs) provide the 
following operation:

Talk Group Only - Transmit on TG, receive on TG.
Announcement Group Only - Transmit on AG, receive 

on all TGs in AG.
Talk and Announcement Groups - Tx on TG and rx on 

TG plus AG but not the TGs assigned to the AG.

NOTE: These IDs can be entered in either the decimal 
or hexadecimal format as described in Section 1.9.4.

Talk Group ID - Selects the talk group selected by 
that channel. Talk Groups are programmed by 
selecting “Talk Group List” on the Per System screen 
(see page 71).
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Announcement Group ID - Selects the announce-
ment group selected by that channel. Announcement 
Groups are programmed by selecting “Announce-
ment Group List” on the Per System screen (see 
page 73).

Emergency Group ID - Selects the talk group used 
for emergency calls on the channel. 

Other

Make Dynamic Regrouping Channel - Checking this 
box designates the channel as the dynamic 

regrouping channel. The talk group is then 
programmed over the air, so the Talk Group ID and 
Announcement Group ID are not programmable.

Dynamic Regrouping must be enabled on the System 
screen to program a dynamic regrouping channel. 
The dynamic talk group does not need to be a 
programmed group.

Transmit Disable* - When this feature is checked, 
transmitting is disabled on the channel, and it can be 
used for monitoring only.

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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PASSWORD DESCRIPTION

SECTION 10   PASSWORD DESCRIPTION

10.1 NEW PASSWORD ENHANCEMENTS

10.1.1  INTRODUCTION

NOTE: Passwords are not available with the 7780 
portable and 9883 mobile.

A new enhanced password feature is now avail-
able for 5100 portables and 5300 mobiles. The number 
of passwords have been increased along with the 
number of functions that can be under password 
control. The single Power-On password has been 
replaced by the following passwords: 

• Four Power-On (User x) Passwords 

• Download and Upload Passwords

• Master Password

10.1.2  SOFTWARE VERSIONS REQUIRED

The following revised PCConfigure and radio 
software is required for these new enhanced password 
features:

PCConfigure - Version 1.21.8 or later 

51xx Portable

Version 1.x Models - 1.12.1 or later
Version 2.x Models - 2.2.1 or later
Version 3.x Models - 3.2.1 or later

53xx Mobile

Version 1.x Models - 1.24.1 or later ARM
Version 2.x Models - 2.2.1 or later
Version 3.x Models - 3.2.1 or later

NOTE: Refer to Section 16 for more information on 
the preceding radio firmware versions. 

10.1.3  AVAILABILITY WITH EARLIER 
VERSIONS

The Power-On password feature available with 
earlier versions of radio firmware is no longer 

programmable using the latest versions of PCCon-
figure (1.21.2.8 or later). To program that feature in 
earlier radio models, an earlier version of the PCCon-
figure software must be used. It is programmed using 
the “Password at Power Up” function on the Global 
screen. 

Otherwise, PCConfigure 1.21.2.8 or later can be 
used to program earlier radio models with the limita-
tion that any new features which require updated firm-
ware are not available.

10.2 PROGRAMMING PASSWORDS

10.2.1  GENERAL

With new versions of PCConfigure, the “Pass-
word at Power Up” parameter has been removed from 
the Global screen as just described. Passwords are now 
programmed using a password management screen 
displayed by the Tools > Password Management menu 
(see Section 3.4). The applicable radio must be 
connected to the computer and powered up to display 
this screen. 

Password data is transferred and stored in an 
encrypted format for security purposes. In addition, 
actual passwords are never displayed. They are always 
indicated by eight asterisks (********). Therefore, it 
is not possible to determine what passwords are in a 
radio using the PCConfigure software.

Passwords must be 1-8 characters in length and 
consist of the numbers 0-9. Zeros are valid characters 
in any location, even as leading characters. Initially, all 
passwords are null (deleted) characters. Therefore, 
when initially programming a password, no entry is 
required in the “Original/Master Password” box.

10.2.2  LOST PASSWORDS

If a password is lost, it can be changed using 
PCConfigure by entering the Master password (see 
following). If even the Master password is lost or was 
not used, all passwords can be erased using the 
PCTune software as follows:
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1. With PCTune 1.1.1.0 or later, simply select Radio > 
Reset Passwords. Only password information is 
erased.

2. With earlier versions of PCTune, after starting the 
PCTune program, press SHIFT CTRL E to toggle 
the following Erase EEPROM function (otherwise it 
is grayed and not selectable). Then Select Radio > 
Erase EEPROM > Params Only. All password and 
personality information is erased, so the radio must 
be reprogrammed. NOTE: DO NOT SELECT 
“COMPLETE” because that erases all information 
and the radio must then be sent back to the factory 
to make it usable again.

10.2.3  CHANGING PASSWORD

An assigned password can be changed by the user 
if the “Set User Password” option button or menu 
parameter (51xx only) is programmed. Selecting this 
function displays prompts for entering and confirming 
a new password. 

NOTE: With the 51xx portable and 53xx Handheld 
Control Unit, it is recommended that a number key not 
be used for this function because the password mode is 
exited if that key is pressed to enter a number.

10.2.4  PASSWORD ENTRY PROCEDURE

Whenever a password is requested, it is entered as 
follows:

53xx Mobile - Rotate and press the Select switch.

51xx Portable - With DTMF keypad models, enter 
each number using the keypad and press the F2 (Enter) 
key after the last digit is entered. With limited keypad 
models, enter each number by pressing the Up/Down 
switch and press the F2 key after each digit.

10.3 PASSWORD DESCRIPTION

10.3.1  USER (POWER-ON) PASSWORDS

When a User Password is enabled, it must be 
entered each time radio power is turned on. Up to four 
different User Passwords (User 1/User 2/User 3/
User 4) can be programmed. Currently, the same radio 

features are enabled for each. Entering any User Pass-
word at power up enables normal radio operation.

10.3.2  DOWNLOAD/UPLOAD PASSWORDS

Separate Download (write) and Upload (read) 
passwords can be programmed to prevent unautho-
rized downloading or uploading of radio programming 
parameters (see Section 3.3). When one or both of 
these passwords are used, the proper password must be 
entered to perform the operation. A “User” password 
is not required to upload or download parameters. 

10.3.3  MASTER PASSWORD

The Master Password overrides all the preceding 
passwords. It can be used by a system administrator as 
a “pass key” to a password controlled function or to 
change a lost or inadvertently changed password. 
Master passwords are set up and changed the same as 
the other passwords. It does not override the following 
Zone Password.

10.4 ZONE PASSWORD

NOTE: The programming and usage of this password 
has not changed. It is independent from the preceding 
passwords, and programmed in the Zone > Edit Zones 
and Channels screen.

A zone password can also be programmed with 
the 53xx mobile and 51xx portable. It prevents unau-
thorized reprogramming of zones by keypad program-
ming. When this password is used, it must be entered 
before system or channel parameters in that zone can 
be changed. The zone password is programmed in the 
Edit Zones and Channels screen. This screen is 
displayed by clicking the Edit Zone button on the 
Zone screen (see Section 6.2).

A different password can be programmed for 
each zone. When a password protected zone is 
selected, “PASSWORD” is flashed the first time an 
attempt is made to select a system or channel 
parameter in that zone. Each digit of the password is 
then entered as previously described. The password is 
always eight digits long, and after the eighth digit is 
entered, system and channel parameters for that zone 
can be reprogrammed normally.
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SECTION 11   KEYPAD PROGRAMMING (53xx MOBILE)

11.1 INTRODUCTION

NOTE: Keypad programming is permitted by Federal 
Government users only. It is not permitted by any user 
regulated by the FCC (Federal Communications 
Commission). Radios with ARM code 1.22.0 or later 
require that the Keypad Programming option be factory 
enabled to program this feature (see Section 3.3).

Since keypad programming is permitted by 
Federal Government users only, only Federal models 
of this transceiver can be programmed with this 
feature. It is then available only if it has been enabled 
by factory programming and a conventional mode 
option switch is programmed for the “Keypad 
Programming” function. 

Keypad programming is then selected by simply 
pressing this switch (password entry is not required). 
The keypad programming mode is indicated by 
“CHNG ZONE” and a triangle in the display as 
follows:

Keypad programming allows conventional 
channel parameters such as the transmit and receive 
frequency, Call Guard squelch code, and encryption 
key to be changed. In addition, several conventional 
mode timers can be changed. It cannot be used to 
reprogram disabled channels or any P25 Trunked, 
SMARTNET, or SmartZone information.

11.2 MENU DESCRIPTION

A menu system is used to select parameters to be 
changed in the keypad programming mode. Rotate and 
press the Select switch to scroll through and select the 
available parameters. The available parameters and the 
section in which each is described are as follows:

• CHNG ZONE (11.3)
• CHNG CHAN (11.4)
• SYS PARMS (11.5)
• CHAN PARMS (11.6)

Press the Select switch to select the displayed 
parameter. Press the Keypad Programming option 
switch from one of the main menus to exit keypad 
programming or from other menus to exit back one 
level. A flowchart showing the keypad programming 
mode menu structure is located below.

Figure 11-1   53xx Keypad Programming Menu 
Flowchart
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The “CHNG ZONE” menu parameter selects the 
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11.4 CHANNEL CHANGE PARAMETER

The “CHNG CHAN” menu parameter selects the 
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Press the Select switch to display “CHNG 
CHAN” and then scroll through the programmed 
channels by rotating that switch. When the desired 
channel is displayed, select it by pressing the Select 
switch.

11.5 SYSTEM PARAMETERS

NOTE: If “ENTER PSWD” is briefly displayed when 
attempting to select one of the following parameters, 
the zone password must be entered before changes can 
be made. Refer to Section 10.4 for more information.

The “SYS PARMS” menu parameter selects the 
conventional mode timer to be reprogrammed (see 
following). Press the Select switch to select the “SYS 
PARMS” parameter and then rotate that switch to 
display the desired parameter. Then press the Select 
switch again to select it.

SCAN TIMER - Selects the Scan Hold timer. 
Rotate the Select switch to decrement/increment 
the timer in 0.5-second steps from 0-7.5 or set it to 
0 seconds to disabled it. When the desired value is 
displayed, store it by pressing the Select switch.

TX TIMER - Selects the transmit time-out timer. 
Rotate the Select switch to decrement/increment 
the timer in 15-second steps from 0-225 or disable 
it by selecting 0 seconds. When the desired value is 
displayed, store it by pressing the Select switch.

PEN TIMER - Selects the penalty timer. Rotate 
the Select switch to decrement/increment the timer 
in 15-second steps from 0-225 or disable it by 
selecting 0 seconds. When the desired value is 
displayed, store it by pressing the Select switch.

CONV TIMER - Selects the conversation timer. 
Rotate the Select switch to decrement/increment 
the timer in 30-second steps from 0-450 or disable 
it by selecting 0 seconds. When the desired value is 
displayed, store it by pressing the Select switch.

11.6 CHANNEL PARAMETERS

NOTE: If “ENTER PSWD” is briefly displayed when 
attempting to select one of the following parameters, 
the zone password must be entered before changes can 
be made. Refer to Section 10.4 for more information.

The “CHAN PARMS” menu parameter selects 
the following conventional channel parameters that 
can be reprogrammed. Press Select switch to select the 
“CHAN PARMS” parameter and then rotate that 
switch to display the desired parameter. Then press the 
Select switch again to select it. The squelch control 
parameters are unique to the type of conventional 
channel selected (analog or Project 25). 

NOTE: If a mixed mode channel is selected, both the 
Rx Code (analog) and Rx NAC (P25) which follow can 
be programmed. In addition, if the Tx Type is Analog, 
a Tx Code is programmed, and if it is Digital (P25), a 
Tx NAC is programmed.

RX FREQ - Sets the receive channel frequency. To 
select the digit to change or move the cursor to the 
right, press the Select switch. Then to display the 
desired digit, rotate the Select switch. The frequency is 
stored after programming the last digit. If an invalid 
frequency is entered, a beep sounds, “INVALID” is 
briefly displayed, and the frequency editing mode 
continues to be selected.

TX FREQ - Selects the transmit frequency the same 
as RX FREQ above.

CTCSS/DCS Squelch Control (Analog Channel)

RX CODE - Sets the receive Call Guard (CTCSS/
DCS) code. The currently selected code is initially 
displayed. If required, rotate and press the Select 
switch to select the desired type (CTCSS analog or 
DCS digital). Then enter the desired code similar to 
programming a receive frequency as just described. 
If an invalid code is entered, a beep sounds, 
“INVALID” is briefly displayed, and the editing 
mode continues to be selected.

TX CODE - Selects the transmit codes the same as 
RX CODE above. 

NAC Squelch Control (Project 25 Channel)

RX NAC - Selects the receive Network Access 
Code (NAC) which can be any number from 
0-4095. With later models, this number is displayed 
in hexadecimal from 000-FFF. Rotate and press the 
Select switch to enter the desired code. The 
displayed code is stored after the last digit is 
programmed. If an invalid code is entered, a beep 
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sounds, “INVALID” is briefly displayed, and the 
NAC editing mode continues to be selected.

TX NAC - Selects the transmit NAC the same as 
RX NAC above. 

TX POWER - Selects the desired power output level. 
Rotate the Select switch to scroll through the 
following choices. When the desired setting is 
displayed, store it by pressing the Select switch.

• POWER HIGH - High transmit power
• POWER LOW - Low transmit power
• POWER SW - Switchable power selectable by 

the High/Low power switch. This choice is not 
available if that switch is not programmed.

TX TIMER - Enables or disables the time-out timer 
on the current channel. Rotate the Select switch to 
toggle between the on and off mode, and when the 
desired setting is displayed, store it by pressing the 
Select switch.

Channel Alias* - Programs the alias for the channel. 
Up to ten characters from A-Z and 0-9 and spaces can 
be entered. Press Select switch once to display the 
current alias and then press it again or rotate it to 
program a new alias. Rotate the Select switch to 
display the desired character and then press it to move 
to the next position. The number is stored after the 
Select switch is pressed with the last position selected. 

NOTE: The next two parameters are programmed only 
if the radio is programmed for encryption.

Strapping* - Selects the encryption strapping mode 
for the channel as Clear, Secure, or Switched. 

Key Select* - Selects the encryption key for the 
channel if applicable. The key storage location of 0-15 
(PID) or 1-16 (SLN) is selected (see Section 4.3). If no 
keys are programmed, “No Keys” is displayed. 

CHAN SPACE (Analog Only) - Selects either wide 
or narrow band channel spacing on analog channels 
only. Rotate the Select switch to toggle between 
“WIDE” and “NARROW”, and when the desired 
setting is displayed, store it by pressing the Select 
switch.

SQ ADJUST (Analog Only) - Changes the preset 
squelch setting on that channel. The default setting is 
“0” and values of –7 to +7 can be selected. Increasing 
this setting toward +7 causes the squelch to open 
sooner so that weaker signals can be received, and 
decreasing it toward –7 causes the opposite to occur.

TG ID (P25 Only) - Selects the talk group for the 
selected channel. Rotate the Select switch to display 
the alias of each preprogrammed talk group and then 
press it to store the desired talk group.

Transmit Type (P25 Mixed Mode Only) - If the 
selected channel is a mixed mode, analog and P25 
channel, this selects the transmit type. Either Analog 
or Digital (P25) can be selected. This then determines 
if a Tx Code or Tx NAC is programmed above.
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SECTION 12   KEYPAD PROGRAMMING (51xx PORTABLE)

12.1 INTRODUCTION

NOTE: Refer to Section 11.1 for information regarding 
the restricted availability of keypad programming.

Keypad programming is available only if it has 
been enabled by factory programming and a conven-
tional mode option switch or menu parameter is 
programmed for the “Keypad Programming” func-
tion. It is then selected by simply pressing that switch 
or selecting that menu parameter. The keypad 
programming mode is indicated by “CHNG ZONE” 
and  in the display.

Keypad programming allows conventional 
channel parameters such as the transmit and receive 
frequency, Call Guard squelch code, and encryption 
code to be changed. In addition, several conventional 
mode timers can be changed. It cannot be used to 
reprogram disabled channels or any P25 Trunked and 
SMARTNET/SmartZone information.

12.2 MENU DESCRIPTION

A menu system is used to select parameters to be 
changed in the keypad programming mode. A flow-
chart showing the keypad programming mode menu 
structure is located in Figure 12-1. When the keypad 
programming mode is selected by the Keypad 
Programming option button or menu parameter, the 
first menu parameter “CHNG ZONE” is displayed as 
just described. Press the Up/Down switch to scroll 
through the available parameters which are listed 
below. 

• CHNG ZONE (12.3)
• CHNG CHAN (12.4)
• SYS PARMS (12.5)
• CHAN PARMS (12.6)

Press the F2 (Select) key to select a highlighted 
parameter, and press the F1 key from one of the main 
menus to exit keypad programming. Pressing it in the 
other menus returns to the previous menu. The Up/
Down switch is also used in several menus to scroll 
through available selections. Additional information 
on this parameters is located in the following sections.

Figure 12-1   51xx Keypad Programming Menu 
Flowchart
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P25Trunked/SMARTNET/SmartZone channels cannot 
be selected. This does not change the channel selected 
for normal operation. 

Press the Select switch to select the “CHNG 
CHAN” parameter and then scroll through the 
programmed channels by pressing the Up/Down 
switch. When the desired channel is displayed, select it 
by pressing F2 switch.

12.5 SYSTEM PARAMETERS

NOTE: If “PASSWORD” is briefly displayed when 
attempting to select one of the following parameters, 
the zone password must be entered before changes can 
be made. Refer to Section 10.4 for more information.

The “SYS PARMS” menu parameter selects the 
conventional mode timers to be reprogrammed (see 
following). Press the F2 switch to select the “SYS 
PARMS” parameter and then press the Up/Down 
switch to display the desired parameter. Then press the 
F2 switch again to select it.

SCAN TIMER - Selects the Scan Hold timer. 
Press the Up/Down switch to decrement/increment 
the timer in 0.5-second steps from 0-7.5 or set it to 
0 seconds to disable it. When the desired value is 
displayed, store it by pressing the F2 switch.

TX TIMER - Selects the transmit time-out timer. 
Press the Up/Down switch to decrement/increment 
the timer in 15-second steps from 0-225 or disable 
it by selecting 0 seconds. When the desired value is 
displayed, store it by pressing the F2 switch.

PEN TIMER - Selects the penalty timer. Press the 
Up/Down switch to decrement/increment the timer 
in 15-second steps from 0-225 or disable it by 
selecting 0 seconds. When the desired value is 
displayed, store it by pressing the F2 switch.

CONV TIMER - Selects the conversation timer. 
Press the Up/Down switch to decrement/increment 
the timer in 30-second steps form 0-450 or disable 
it by selecting 0 seconds. When the desired value is 
displayed, store it by pressing the F2 switch.

12.6 CHANNEL PARAMETERS

NOTE: If “PASSWORD” is briefly displayed when 
attempting to select one of the following parameters, 
the zone password must be entered before changes can 
be made. Refer to Section 10.4 for more information.

The “CHAN PARMS” menu parameter selects 
the following conventional channel parameters that 
can be reprogrammed. Press F2 switch to select the 
“CHAN PARMS” parameter and then press the 
Up/Down switch to display the desired parameter. 
Then press the F2 switch to select it. The squelch 
control parameters are unique to the type of conven-
tional channel selected (analog or Project 25). 

NOTE: If a mixed mode channel is selected, both the 
Rx Code (analog) and Rx NAC (P25) which follow can 
be programmed. In addition, if the Tx Type is Analog, 
a Tx Code is programmed, and if it is Digital (P25), a 
Tx NAC is programmed.

TX FREQ - Programs the transmit channel frequency. 
The digit being changed flashes, and press the Up/
Down switch to select the desired number for that 
digit. Then press the F2 switch to move to the next 
digit. If an invalid frequency is entered, a beep sounds, 
“INVALID” is briefly displayed, and the number must 
be re-entered. 

RX FREQ - Programs the transmit frequency the 
same as RX FREQ above.

SQ ADJ (Analog Only) - Changes the preset squelch 
setting on that channel. The default setting is “0” and 
values of –7 to +7 can be selected. Increasing this 
setting toward +7 causes the squelch to open sooner so 
that weaker signals can be received, and decreasing it 
toward –7 causes the opposite to occur.

NOTE: The channel spacing is not set with P25 chan-
nels because it is always narrow, and the squelch 
cannot be changed because the setting is critical for 
proper receiver operation.

CHAN SPC (Analog Only) - Selects either wide or 
narrow band channel spacing on analog channels only. 
Press the Up/Down switch to select “WIDE” or 
“NARROW”, and when the desired setting is 
displayed, store it by pressing the F2 switch.
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NOTE: The next two parameters are programmed only 
if the radio is programmed for encryption.

Key Select* - Selects the encryption key for the 
channel if applicable. The key storage location of 0-15 
(PID) or 1-16 (SLN) is selected (see Section 4.3). If no 
keys are programmed, “No Keys” is displayed. 

Strapping* - Selects the encryption strapping mode 
for the channel as Clear, Secure, or Switched. 

TG ID (P25 Only) - Selects the talk group for the 
selected channel. Press F2 to display the current talk 
group ID and then press F2 again to enter a different 
ID from 1-65,535*. This number must be entered 
directly using the DTMF keypad. 

Channel Alias* - Programs the alias for the channel 
(DTMF keypad models only). Up to ten characters can 
be entered. Press F2 once to display the current alias 
and then press it again to program a new alias. Alpha-
numeric characters are programmed using the 0-9 
keys. Pressing a key once enters the first letter on the 
key and then pressing it successive times enters the 
letters and the number on the key. For example, press 
the “2” key twice to enter “B”. Press the F2 key to 
move to the next position or press it twice to enter a 
space.

TX TIMER - Enables or disables the time-out timer 
on the current channel. Press the Up/Down switch to 
select the on and off mode, and when the desired 
setting is displayed, store it by pressing the F2 switch.

TX POWER - Selects the desired power output level. 
Press the Up/Down switch to scroll through the 
following choices. When the desired setting is 
displayed, store it by pressing the F2 switch.

• Power High - High transmit power
• Power Low - Low transmit power
• Power SW - Switchable power selectable by the 

High/Low power switch. This choice is not 
available if that switch is not programmed.

CTCSS/DCS Squelch Control (Analog Channel)

TX CODE - Programs the transmit Call Guard 
(CTCSS/DCS) code. The currently selected code 
and is initially displayed. Press the Up/Down 
switch to select the desired code type (CTCSS 
analog or DCS digital). Then press F2 to select it 
and enter the code number similar to programming 
a channel frequency as just described.

RX CODE - Selects the receive codes the same as 
TX CODE above. 

NAC Squelch Control (Project 25 Channel)

TX NAC - Programs the transmit Network Access 
Code (NAC) which can be any number from 
0-4095. With later models, this number is displayed 
in hexadecimal from 000-FFF. The procedure is 
similar to programming a TX FREQ just described. 
If an invalid code is entered, a beep sounds, 
“INVALID” is briefly displayed, and the code must 
be re-entered.

RX NAC - Selects the receive NAC the same as 
TX NAC above. 

Transmit Type (P25 Mixed Mode Only) - If the 
selected channel is a mixed mode, analog and P25 
channel, this selects the transmit type. Either Analog 
or Digital (P25) can be selected. This then determines 
if a Tx Code or Tx NAC is programmed above.
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SECTION 13   SYSTEM KEY

13.1 GENERAL

To program certain SMARTNET/SmartZone and 
Project 25 Trunking parameters, the proper System 
Key must be detected by PCConfigure. The System 
Key is provided by EFJohnson to authorized users. It 
is not the same as the encryption (hardware) key, and it 
is not required to program conventional analog and 
conventional Project 25 parameters.

The parameters which are available only with the 
System Key are described in the following informa-
tion. Other parameters associated with trunking, such 
as Zones and Channels, continue to be editable. If a 
System Key has no trunking parameters enabled, a 
default trunking system of “One” is assigned and 
disabled parameters are unavailable for assignment to 
this system even though the radio is trunking capable.

13.2 SYSTEM KEY LOCATION

The system key should be copied by the user to 
the “Keys” folder of the PCConfigure directory. This 
folder is automatically created when PCConfigure is 
installed. The default directory in which PCConfigure 
is installed is as follows. Some other location may also 
have been selected.

Program Files\EF Johnson\PCConfigure1_x.x.

The system key can also be loaded from other 
folders using the Radio > Load System Keys function. 
A dialog box is then displayed which allows the folder 
to be selected. When the program is restarted, either 
the “Keys” folder or the last selected folder is selected, 
depending on the Tools > Preferences programming 
(see Section 3.4).

 - The yellow “Key” icon on the 
system screen (see Figure 8-1) indicates that a system 
key is present in this folder. If a system key is not 
present, this yellow key icon has a red “X” over it as 

shown above and none of the following parameters 
can be programmed. 

NOTE: If the red “X” is still displayed after a key is 
copied to the “keys” folder, it may be necessary to 
restart the PCConfigure program for it to recognize 
the key. In addition, be sure to select the new system 
ID contained in the key in the IDs > System drop down 
list on the Per System screen.

13.3 DISABLED SMARTNET/SMARTZONE 
PARAMETERS

The following SMARTNET/SmartZone 
parameters cannot be Added or Deleted without the 
proper System Key:

• System ID - Only the system IDs from available 
keys can be selected.

• Individual ID
• Control channels
• Talk groups
• Announcement groups
• Emergency groups
• Connect tone
• Splinter channel option

13.4 DISABLED PROJECT 25 TRUNKING 
PARAMETERS

The following Project 25 Trunked parameters 
cannot be Added or Deleted without the proper System 
Key (conventional analog and Project 25 parameters 
can still be edited). 

• WACN ID
• Home system ID
• Site ID
• RFSS ID
• Individual ID
• Control channels
• Talk groups
• Announcement groups
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SECTION 14   CLONING PROCEDURE (51xx ONLY)

14.1 INTRODUCTION

14.1.1  GENERAL

The Clone feature enables one radio to program 
another with identical information. The PCConfigure 
programming software is not required. This feature is 
available with 51xx portables only. Other requirements 
are as follows:

• The Clone menu parameter must be enabled in the 
master (sending) radio. This parameter is not 
required with the slave (receiving) radio. 

• The master and slave radios must be identical 
models (same frequency range and options). 

• Flash code Version 1.5.0/2.0.0/3.0.0 or higher is 
required with both radios (see Section 16.1). 
PCConfigure Version 1.17 or higher is required to 
program the Clone menu parameter.

Only zones with conventional analog and P25 
channels can be transferred using this function. Any 
SMARTNET/SmartZone and P25 trunked informa-
tion is not transferred. In addition, the P25 Unit ID, 
encryption keys, and the RSI ID and other OTAR 
information are not transferred. Cloned zones are indi-
cated in the slave radio by an asterisk in the first char-
acter position of the zone alias (the first character is 
replaced by this asterisk).

14.1.2  WIRELESS CLONING

A new wireless cloning feature is available that 
allows one radio to program another using an RF link 
instead of having to be physically connected by a 
cloning cable. Only 5100 radios with the following 
firmware or later have this feature. Refer to Section 
16.1 for more information on 5100 versions.

Version 1 Radio - 1.12.1 to 1.14.3 only
Version 2 Radios - 2.2.1 to 2.4.6 only
Version 3 Radios - Not available
Version 4 Radios - Available with all versions

The wireless cloning feature utilizes the P25 data 
functionality of the radio. Therefore, a conventional 
P25 channel must be programmed in both radios and 
the slave radio must be programmed with a P25 Unit 

ID. In addition, Data Registration must be enabled on 
Page 2 of the Per System screen (see page 41). If it is 
not enabled, “Disabled” is displayed. Radios with 
wireless cloning capability have a new selection in the 
cloning menu to select either Clone N (Normal) or 
Clone W (Wireless). If Wireless is selected, and addi-
tional menu is displayed for entering the P25 Unit ID 
of the destination radio (slave). The Zone/Complete 
mode is then selected. 

14.2 CLONING PROCEDURE

1. With normal (non-wireless) cloning, connect the 
master (sending) radio to the slave (receiving) radio 
using Cloning Cable, Part No. 023-5100-930.

2. On the master radio, select the Clone menu param-
eter and press the F2 key. If applicable, select either 
“Clone W” (Wireless) or “Clone N” (Normal). If 
normal cloning was selected or if this is not select-
able, proceed to step 4.

3. With wireless cloning, a screen is then displayed for 
entering the P25 Unit ID of the destination (slave) 
radio. Enter this ID using the keypad (or the Up/
Down keys) and F2. 

4. Select the “Zone” or “Complete” clone mode as 
desired. Operation in these modes is as follows:

Zone - This mode allows channel information for 
only the selected zone to be transferred. Information 
programmed on the Global, Radio Wide, and By 
System screens is not changed. A list of the current 
conventional zones is displayed. Select the desired 
zone by highlighting it and pressing the F2 key. A 
selected zone is indicated by an asterisk (*). Scroll 
to “OK” and press F2 to begin the data transfer. The 
selected zone in the slave radio is overwritten. 
Previously, multiple zones could be selected and 
they were appended to those in the slave radio.

Complete - This mode transfers all conventional 
programming information. This includes informa-
tion on the Global, Radio Wide, and By System 
screens. Simply highlight “Complete” and press the 
F2 key to begin the data transfer. This mode over-
writes all this information currently in the slave 
radio. None of the previous information is retained 
except for the IDs as described in Section 14.1.1.
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SECTION 15   ANTI-CLONING FEATURES

NOTE: The information which follows refers to copying 
of parameters from one radio to another using the 
PCConfigure software. It is not referring to cloning 
using two radios described in the preceding section. 

15.1 INTRODUCTION

The latest releases of 5100 and 5300 radio and 
PCConfigure software include safeguards to prevent 
unauthorized cloning of radios programmed for 
trunked operation using the PCConfigure software. 
The trunked operating modes are SMARTNET, Smart-
Zone, and P25 Trunking.

Many trunking parameters are restricted and can 
be programmed or edited only with the correct System 
Key as described in Section 13. These new safeguards 
prevent another radio from being cloned with restricted 
trunking information without the correct System Key.

15.2 SOFTWARE VERSIONS

The following programmer and radio software 
releases support these new cloning safeguards:

PCConfigure - Version 1.20 or later
5100 Portable - Flash Code Ver 1.9.0/2.0/3.0 or higher
5300 Mobile - Flash Code Version 2.0/3.0 or higher; 

ARM Code Version 1.22.0 or higher (early models).

The new version of PCConfigure (1.20 or later) is 
required to program all 51xx/53xx radios with the 
above software. The new PCConfigure software can 
also be used to program radios with earlier software. 
However, 51xx/53xx radios with the earlier software 
do not support the new cloning safeguards. The 7780 
and 9883 models always require the correct System 
Keys to write information to the radio.

15.3 DESCRIPTION OF CHANGES

All programming files uploaded from a radio 
with the new version of PCConfigure will now include 
information on the specific radio from which it was 
read (uploaded). The ESN (Electronic Serial Number) 
and other information is stored in an encrypted form in 
the data file. This information is also included with file 
when it is saved to disk, if applicable. Other operation 
with these changes is as follows:

Saving a New File

NOTE: It is no longer possible to save any type of new 
programming file to disk without a radio connected. 

All files saved to disk must now be associated 
with a specific radio. Therefore, when saving a new 
file for the first time, the radio must connected to the 
computer so the ESN and other information can be 
read and stored with the file. However, a previously 
saved disk file can be opened and edited and then re-
saved to disk without a radio connected. In addition, 
files containing trunking parameters can be saved 
without the proper system key.

Writing a File To Radios Containing New Software

Correct System Key Available - A file with 
trunking parameters can be edited as desired and 
written to any radio. 

Correct System Key Not Available - Restricted 
trunking parameters cannot be changed (see 
Section 13). However, non-restricted trunking and 
conventional parameters can still be changed. The 
data file can be written to the same radio only. If it 
is written to a different radio, the data is scrambled 
and “Params Fail” is displayed by the radio when 
programming is finished. 

File Containing Only Conventional Parameters 
(P25 or Analog) - There are no editing restrictions 
and data files can be written to any radio.

Radios With Earlier Software

When a file write operation is initiated, the 
PCConfigure software checks the software version of 
the radio. If it is an earlier version than is listed in 
Section 15.2, the file is written regardless of the 
System Key or the source radio of the data file. 

Using Earlier Versions of PCConfigure

As described in Section 15.2, Version 1.20 or 
later PCConfigure must be used to program radios 
with the new software. This applies to both conven-
tional and trunked operation. Improper operation 
results if earlier versions are used.
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SECTION 16   51xx/53xx FIRMWARE VERSIONS

Table 16-1   51xx Encryption Hardware Configurations

Radio Version [1]
Application 
(Firmware) 
Code Base

Analog Channel 
Encryption

Digital Channel 
Encryption

DES DES-XL DES-OFB AES
Version 1 (No Module/Software Encryption)

Current standard version which uses the -110 Logic 
board and -410 UI Board. Not FIPS approved. 

1.xx Yes No Yes Yes 

Version 2 (uses EFJ SEM module)
Current version which has the new EFJohnson SEM 
(Subscriber Encryption Module) on the logic board. 
This version uses the -150 Logic and -450 UI 
boards. All radios include the SEM, and the desired 
encryption options (if any) are enabled by factory 
programming. FIPS approved.

Initially same 
as above, then 
2.xx

Yes No Yes Yes 

Version 3 (uses Motorola UCM module)
Current version which has the Motorola UCM (Uni-
versal Crypto Module) on the logic board. This ver-
sion uses the -160 Logic and -460 UI boards, and is 
ordered when DES-XL encryption is required. FIPS 
approved.

3.xx Yes Yes Yes Yes 

Version 4 (uses EFJ SEM module)
New version designed for use with new RF mod-
ules. It uses the same EFJohnson SEM (Subscriber 
Encryption Module) as Version 2 boards above. 
With the 51xx, the 5500-120 Logic and 5500-420 
UI boards are used. With the 53xx, the 5500-600 
Logic board is used. All radios include the SEM, 
and the desired encryption options (if any) are 
enabled by factory programming. FIPS approved.

4.xx Yes No Yes Yes 

[1] The version number is also indicated by the 13th digit of the radio part number (242-51xx-xxx-xxV).

16.1 51XX PORTABLE FIRMWARE VERSIONS

General

Beginning in November 2004, a new version of 
the 51xx portable is planned to begin shipping 
(Version 4 Table 16-1). This version has new RF, 
Logic, and Universal Interface boards, and uses 
different firmware (application code) that is not 
compatible with earlier or other models. The four 
radio versions now available are shown in Table 16-1.

Firmware Version Used

The firmware code base used by each of these 
four versions is shown in Table 16-1. This is the oper-

ating code of the radio that may occasionally be 
updated using the “Transfer > Write Code To Radio” 
function (see Section 3.3). For example, if firmware 
with new operating features or fixes is loaded into a 
Version 2 radio, it would have a 2.xx version number. 

Initially, a few Version 2 radios used Version 
1.11.9 code which was the same as that used with the 
Version 1 radios. However, later code releases for 
Version 2 radios are not compatible with Version 1 
radios, so Version 2.xx code must be used.

NOTE: The code version (and therefore radio version) 
is briefly displayed when the radio powers up.
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Programming Software Required

PCConfigure™ programming software, Version 
1.25.0 or later is required to program radios with the 
Version 4 boards. This software can also be used to 
program radios with the earlier boards.

16.2 53XX MOBILE FIRMWARE VERSIONS

General

Beginning in November 2003, a revised logic 
board began shipping in 53xx models. This board 
utilized a new control logic design similar to that used 
in the Version 2 and 3 51xx portable. This board is 
available in the following configurations. All versions 
are FIPS approved.

SEM Version - This version has the EFJohnson 
SEM (Security Encryption Module) soldered to the 
board. It is used whenever DES, DES-OFB, or 
AES encryption is required. It does not provide 
DES-XL encryption.

UCM Version - This includes a plug-in Motorola 
UCM encryption module. It is used whenever 
DES-XL Motorola proprietary encryption is 
required. It also provides DES, DES-OFB, or AES 
encryption. 

No Encryption Version - If encryption is not 
required, either the earlier logic board (see 
following) or the UCM version without the UCM 
module is used. 

Early Unrevised Logic Board

This version is Part No. 035-1800-4xx and is 
being replaced by the above versions. This board has 
an ARM processor and a jack for plugging in 
Motorola encryption modules that provide DES/DES-
XL/DES-OFB and AES encryption. It does not use the 
SEM module. 

Programming Software Required

PCConfigure programming software, Version 
1.21.2.5 or later is required to program radios with the 
revised board. This software can also be used to 
program radios with the unrevised board. The “5300” 
Radio Series is selected for both boards. The software 

automatically detects which board is used when 
parameters are written to the radio.

Firmware Required

Radios with the revised and unrevised logic 
boards use different firmware (operating/Flash soft-
ware) as follows. When downloading code using the 
PCConfigure software (such as when purchasing new 
operating features), the radio must be powered up 
when the password is entered so that the logic board 
version can be detected.

Models with Revised Board - A single code file is 
used similar to the 5100 portable. SEM code has a 
2.xx version number, and UCM code has a 3.xx 
version number. 

Models with Unrevised Board - Two code files 
are used, one of which programs DSP parameters 
and the other which programs ARM processor 
parameters. These code sets have a 1.xx version 
number.

Identifying Radios With Revised Logic Board

Refer to the radio Serial Number on the label on 
the bottom cover to determine if it is a version with the 
revised logic board. Radios with the new revised logic 
board have a Revision Letter (letter following 53xx0) 
of “G” or higher. Radios with an A-F Revision Letter 
have the early unrevised -4xx logic board just 
described. 

The board version can also be determined by 
noting the software version number that is briefly 
displayed when power is turned on. The version 
numbers are as follows:

Software Version Displayed Board Version

Ver 1.xx Early unrevised
Ver 2.xx SEM version
Ver 3.xx UCM version

Version 4 Models

Early 2005 availability is planned for 53xx 
models that have the Version 4 configuration described 
in Table 16-1. These models will also have new RF, 
logic, interface, and interconnect boards. 
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SECTION 17   CALL GUARD (CTCSS/DCS) AND 800 MHz CHANNEL TABLES

SECTION 18   P25 PACKET DATA MODE

Table 17-1   Call Guard (CTCSS/DCS) Codes

Recommended Tone Call Guard Codes

Code Freq Code Freq Code Freq Code Freq Code Freq
09 91.5 18 123.0 27 167.9 36* 233.6

01 67.0 10 94.8 19 127.3 28 173.8 37* 241.8
02 71.9 11** 97.4 20 131.8 29 179.9 38* 250.3
03 74.4 12 100.0 21 136.5 30 186.2 39** 69.3
04 77.0 13 103.5 22 141.3 31 192.8 40** 206.5
05 79.7 14 107.2 23 146.2 32 203.5 41** 229.1
06 82.5 15 110.9 24 151.4 33 210.7 42** 254.1
07 85.4 16 114.8 25 156.7 34* 218.1
08 88.5 17 118.8 26 162.2 35* 225.7
* These tones normally are not used because of their close proximity to the voice frequencies
** This tone is normally not used because it may cause interference with adjacent tones.

Recommended Digital Call Guard Codes
023 065 131 172 261 346 431 532 654 743
025 071 132 174 263 351 432 546 662 754
026 072 134 205 265 364 445 565 664
031 073 143 223 271 365 464 606 703
032 074 152 226 306 371 465 612 712
043 114 155 243 311 411 466 624 723
047 115 156 244 315 412 503 627 731
051 116 162 245 331 413 506 631 732
054 125 165 251 343 423 516 632 734

18.1 GENERAL

P25 packet data transmissions* are or soon will 
be available with 5100 portable and 5300 mobile 
radios. A P25 Packet Data option button or menu 
parameter (5100 only) is used to toggle the data mode.

The P25 Packet Data mode allows a subscriber 
unit to act as a packet data modem for a remote appli-
cation connected to the subscriber unit via an RS-232 
or SLIP (Serial Line Internet Protocol) connection. 
The SLIP connection requires an Ethernet port which 
is currently not available with either radio.

18.2 HARDWARE REQUIRED

18.2.1  5100 PORTABLE

The standard PCConfigure programming cable 
provides the RS-232 port (female DB9 connector) for 
connecting the external data equipment. 

18.2.2  5300 MOBILE

A special data pigtail cable (Part No. 597-2002-
282) is installed in the radio to provide external access 
to the RS-232 lines. This cable also has a female DB9 
connector for connecting the external equipment. 

* This feature available only in 51xx models with code 1.12.1/2.2.1/
3.2.1 or later and 53xx models with code 1.24.1/2.2.1/3.2.1 or later.
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FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq

Mobile Tx 
Freq

800 MHz Channels

1 851.0125 806.0125
2 851.0375 806.0375
3 851.0625 806.0625
4 851.0875 806.0875
5 851.1125 806.1125
6 851.1375 806.1375
7 851.1625 806.1625
8 851.1875 806.1875
9 851.2125 806.2125

10 851.2375 806.2375
11 851.2625 806.2625
12 851.2875 806.2875
13 851.3125 806.3125
14 851.3375 806.3375
15 851.3625 806.3625
16 851.3875 806.3875
17 851.4125 806.4125
18 851.4375 806.4375
19 851.4625 806.4625
20 851.4875 806.4875
21 851.5125 806.5125
22 851.5375 806.5375
23 851.5625 806.5625
24 851.5875 806.5875
25 851.6125 806.6125
26 851.6375 806.6375
27 851.6625 806.6625
28 851.6875 806.6875
29 851.7125 806.7125
30 851.7375 806.7375
31 851.7625 806.7625
32 851.7875 806.7875
33 851.8125 806.8125
34 851.8375 806.8375
35 851.8625 806.8625
36 851.8875 806.8875
37 851.9125 806.9125
38 851.9375 806.9375
39 851.9625 806.9625
40 851.9875 806.9875
41 852.0125 807.0125
42 852.0375 807.0375
43 852.0625 807.0625
44 852.0875 807.0875
45 852.1125 807.1125
46 852.1375 807.1375
47 852.1625 807.1625
48 852.1875 807.1875
49 852.2125 807.2125
50 852.2375 807.2375

51 852.2625 807.2625
52 852.2875 807.2875
53 852.3125 807.3125
54 852.3375 807.3375
55 852.3625 807.3625
56 852.3875 807.3875
57 852.4125 807.4125
58 852.4375 807.4375
59 852.4625 807.4625
60 852.4875 807.4875
61 852.5125 807.5125
62 852.5375 807.5375
63 852.5625 807.5625
64 852.5875 807.5875
65 852.6125 807.6125
66 852.6375 807.6375
67 852.6625 807.6625
68 852.6875 807.6875
69 852.7125 807.7125
70 852.7375 807.7375
71 852.7625 807.7625
72 852.7875 807.7875
73 852.8125 807.8125
74 852.8375 807.8375
75 852.8625 807.8625
76 852.8875 807.8875
77 852.9125 807.9125
78 852.9375 807.9375
79 852.9625 807.9625
80 852.9875 807.9875
81 853.0125 808.0125
82 853.0375 808.0375
83 853.0625 808.0625
84 853.0875 808.0875
85 853.1125 808.1125
86 853.1375 808.1375
87 853.1625 808.1625
88 853.1875 808.1875
89 853.2125 808.2125
90 853.2375 808.2375
91 853.2625 808.2625
92 853.2875 808.2875
93 853.3125 808.3125
94 853.3375 808.3375
95 853.3625 808.3625
96 853.3875 808.3875
97 853.4125 808.4125
98 853.4375 808.4375
99 853.4625 808.4625
100 853.4875 808.4875

101 853.5125 808.5125
102 853.5375 808.5375
103 853.5625 808.5625
104 853.5875 808.5875
105 853.6125 808.6125
106 853.6375 808.6375
107 853.6625 808.6625
108 853.6875 808.6875
109 853.7125 808.7125
110 853.7375 808.7375
111 853.7625 808.7625
112 853.7875 808.7875
113 853.8125 808.8125
114 853.8375 808.8375
115 853.8625 808.8625
116 853.8875 808.8875
117 853.9125 808.9125
118 853.9375 808.9375
119 853.9625 808.9625
120 853.9875 808.9875
121 854.0125 809.0125
122 854.0375 809.0375
123 854.0625 809.0625
124 854.0875 809.0875
125 854.1125 809.1125
126 854.1375 809.1375
127 854.1625 809.1625
128 854.1875 809.1875
129 854.2125 809.2125
130 854.2375 809.2375
131 854.2625 809.2625
132 854.2875 809.2875
133 854.3125 809.3125
134 854.3375 809.3375
135 854.3625 809.3625
136 854.3875 809.3875
137 854.4125 809.4125
138 854.4375 809.4375
139 854.4625 809.4625
140 854.4875 809.4875
141 854.5125 809.5125
142 854.5375 809.5375
143 854.5625 809.5625
144 854.5875 809.5875
145 854.6125 809.6125
146 854.6375 809.6375
147 854.6625 809.6625
148 854.6875 809.6875
149 854.7125 809.7125
150 854.7375 809.7375
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FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq.

Mobile Tx 
Freq

FCC Chan. 
No. 

Mobile Rx 
Freq

Mobile Tx 
Freq

800 MHz Channels

151 854.7625 809.7625
152 854.7875 809.7875
153 854.8125 809.8125
154 854.8375 809.8375
155 854.8625 809.8625
156 854.8875 809.8875
157 854.9125 809.9125
158 854.9375 809.9375
159 854.9625 809.9625
160 854.9875 809.9875
161 855.0125 810.0125
162 855.0375 810.0375
163 855.0625 810.0625
164 855.0875 810.0875
165 855.1125 810.1125
166 855.1375 810.1375
167 855.1625 810.1625
168 855.1875 810.1875
169 855.2125 810.2125
170 855.2375 810.2375
171 855.2625 810.2625
172 855.2875 810.2875
173 855.3125 810.3125
174 855.3375 810.3375
175 855.3625 810.3625
176 855.3875 810.3875
177 855.4125 810.4125
178 855.4375 810.4375
179 855.4625 810.4625
180 855.4875 810.4875
181 855.5125 810.5125
182 855.5375 810.5375
183 855.5625 810.5625
184 855.5875 810.5875
185 855.6125 810.6125
186 855.6375 810.6375
187 855.6625 810.6625
188 855.6875 810.6875
189 855.7125 810.7125
190 855.7375 810.7375
191 855.7625 810.7625
192 855.7875 810.7875
193 855.8125 810.8125
194 855.8375 810.8375
195 855.8625 810.8625
196 855.8875 810.8875
197 855.9125 810.9125
198 855.9375 810.9375
199 855.9625 810.9625
200 855.9875 810.9875

201 856.0125 811.0125
202 856.0375 811.0375
203 856.0625 811.0625
204 856.0875 811.0875
205 856.1125 811.1125
206 856.1375 811.1375
207 856.1625 811.1625
208 856.1875 811.1875
209 856.2125 811.2125
210 856.2375 811.2375
211 856.2625 811.2625
212 856.2875 811.2875
213 856.3125 811.3125
214 856.3375 811.3375
215 856.3625 811.3625
216 856.3875 811.3875
217 856.4125 811.4125
218 856.4375 811.4375
219 856.4625 811.4625
220 856.4875 811.4875
221 856.5125 811.5125
222 856.5375 811.5375
223 856.5625 811.5625
224 856.5875 811.5875
225 856.6125 811.6125
226 856.6375 811.6375
227 856.6625 811.6625
228 856.6875 811.6875
229 856.7125 811.7125
230 856.7375 811.7375
231 856.7625 811.7625
232 856.7875 811.7875
233 856.8125 811.8125
234 856.8375 811.8375
235 856.8625 811.8625
236 856.8875 811.8875
237 856.9125 811.9125
238 856.9375 811.9375
239 856.9625 811.9625
240 856.9875 811.9875
241 857.0125 812.0125
242 857.0375 812.0375
243 857.0625 812.0625
244 857.0875 812.0875
245 857.1125 812.1125
246 857.1375 812.1375
247 857.1625 812.1625
248 857.1875 812.1875
249 857.2125 812.2125
250 857.2375 812.2375

251 857.2625 812.2625
252 857.2875 812.2875
253 857.3125 812.3125
254 857.3375 812.3375
255 857.3625 812.3625
256 857.3875 812.3875
257 857.4125 812.4125
258 857.4375 812.4375
259 857.4625 812.4625
260 857.4875 812.4875
261 857.5125 812.5125
262 857.5375 812.5375
263 857.5625 812.5625
264 857.5875 812.5875
265 857.6125 812.6125
266 857.6375 812.6375
267 857.6625 812.6625
268 857.6875 812.6875
269 857.7125 812.7125
270 857.7375 812.7375
271 857.7625 812.7625
272 857.7875 812.7875
273 857.8125 812.8125
274 857.8375 812.8375
275 857.8625 812.8625
276 857.8875 812.8875
277 857.9125 812.9125
278 857.9375 812.9375
279 857.9625 812.9625
280 857.9875 812.9875
281 858.0125 813.0125
282 858.0375 813.0375
283 858.0625 813.0625
284 858.0875 813.0875
285 858.1125 813.1125
286 858.1375 813.1375
287 858.1625 813.1625
288 858.1875 813.1875
289 858.2125 813.2125
290 858.2375 813.2375
291 858.2625 813.2625
292 858.2875 813.2875
293 858.3125 813.3125
294 858.3375 813.3375
295 858.3625 813.3625
296 858.3875 813.3875
297 858.4125 813.4125
298 858.4375 813.4375
299 858.4625 813.4625
300 858.4875 813.4875
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301 858.5125 813.5125
302 858.5375 813.5375
303 858.5625 813.5625
304 858.5875 813.5875
305 858.6125 813.6125
306 858.6375 813.6375
307 858.6625 813.6625
308 858.6875 813.6875
309 858.7125 813.7125
310 858.7375 813.7375
311 858.7625 813.7625
312 858.7875 813.7875
313 858.8125 813.8125
314 858.8375 813.8375
315 858.8625 813.8625
316 858.8875 813.8875
317 858.9125 813.9125
318 858.9375 813.9375
319 858.9625 813.9625
320 858.9875 813.9875
321 859.0125 814.0125
322 859.0375 814.0375
323 859.0625 814.0625
324 859.0875 814.0875
325 859.1125 814.1125
326 859.1375 814.1375
327 859.1625 814.1625
328 859.1875 814.1875
329 859.2125 814.2125
330 859.2375 814.2375
331 859.2625 814.2625
332 859.2875 814.2875
333 859.3125 814.3125
334 859.3375 814.3375
335 859.3625 814.3625
336 859.3875 814.3875
337 859.4125 814.4125
338 859.4375 814.4375
339 859.4625 814.4625
340 859.4875 814.4875
341 859.5125 814.5125
342 859.5375 814.5375
343 859.5625 814.5625
344 859.5875 814.5875
345 859.6125 814.6125
346 859.6375 814.6375
347 859.6625 814.6625
348 859.6875 814.6875
349 859.7125 814.7125
350 859.7375 814.7375

351 859.7625 814.7625
352 859.7875 814.7875
353 859.8125 814.8125
354 859.8375 814.8375
355 859.8625 814.8625
356 859.8875 814.8875
357 859.9125 814.9125
358 859.9375 814.9375
359 859.9625 814.9625
360 859.9875 814.9875
361 860.0125 815.0125
362 860.0375 815.0375
363 860.0625 815.0625
364 860.0875 815.0875
365 860.1125 815.1125
366 860.1375 815.1375
367 860.1625 815.1625
368 860.1875 815.1875
369 860.2125 815.2125
370 860.2375 815.2375
371 860.2625 815.2625
372 860.2875 815.2875
373 860.3125 815.3125
374 860.3375 815.3375
375 860.3625 815.3625
376 860.3875 815.3875
377 860.4125 815.4125
378 860.4375 815.4375
379 860.4625 815.4625
380 860.4875 815.4875
381 860.5125 815.5125
382 860.5375 815.5375
383 860.5625 815.5625
384 860.5875 815.5875
385 860.6125 815.6125
386 860.6375 815.6375
387 860.6625 815.6625
388 860.6875 815.6875
389 860.7125 815.7125
390 860.7375 815.7375
391 860.7625 815.7625
392 860.7875 815.7875
393 860.8125 815.8125
394 860.8375 815.8375
395 860.8625 815.8625
396 860.8875 815.8875
397 860.9125 815.9125
398 860.9375 815.9375
399 860.9625 815.9625
400 860.9875 815.9875

401 861.0125 816.0125
402 861.0375 816.0375
403 861.0625 816.0625
404 861.0875 816.0875
405 861.1125 816.1125
406 861.1375 816.1375
407 861.1625 816.1625
408 861.1875 816.1875
409 861.2125 816.2125
410 861.2375 816.2375
411 861.2625 816.2625
412 861.2875 816.2875
413 861.3125 816.3125
414 861.3375 816.3375
415 861.3625 816.3625
416 861.3875 816.3875
417 861.4125 816.4125
418 861.4375 816.4375
419 861.4625 816.4625
420 861.4875 816.4875
421 861.5125 816.5125
422 861.5375 816.5375
423 861.5625 816.5625
424 861.5875 816.5875
425 861.6125 816.6125
426 861.6375 816.6375
427 861.6625 816.6625
428 861.6875 816.6875
429 861.7125 816.7125
430 861.7375 816.7375
431 861.7625 816.7625
432 861.7875 816.7875
433 861.8125 816.8125
434 861.8375 816.8375
435 861.8625 816.8625
436 861.8875 816.8875
437 861.9125 816.9125
438 861.9375 816.9375
439 861.9625 816.9625
440 861.9875 816.9875
441 862.0125 817.0125
442 862.0375 817.0375
443 862.0625 817.0625
444 862.0875 817.0875
445 862.1125 817.1125
446 862.1375 817.1375
447 862.1625 817.1625
448 862.1875 817.1875
449 862.2125 817.2125
450 862.2375 817.2375
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451 862.2625 817.2625
452 862.2875 817.2875
453 862.3125 817.3125
454 862.3375 817.3375
455 862.3625 817.3625
456 862.3875 817.3875
457 862.4125 817.4125
458 862.4375 817.4375
459 862.4625 817.4625
460 862.4875 817.4875
461 862.5125 817.5125
462 862.5375 817.5375
463 862.5625 817.5625
464 862.5875 817.5875
465 862.6125 817.6125
466 862.6375 817.6375
467 862.6625 817.6625
468 862.6875 817.6875
469 862.7125 817.7125
470 862.7375 817.7375
471 862.7625 817.7625
472 862.7875 817.7875
473 862.8125 817.8125
474 862.8375 817.8375
475 862.8625 817.8625
476 862.8875 817.8875
477 862.9125 817.9125
478 862.9375 817.9375
479 862.9625 817.9625
480 862.9875 817.9875
481 863.0125 818.0125
482 863.0375 818.0375
483 863.0625 818.0625
484 863.0875 818.0875
485 863.1125 818.1125
486 863.1375 818.1375
487 863.1625 818.1625
488 863.1875 818.1875
489 863.2125 818.2125
490 863.2375 818.2375
491 863.2625 818.2625
492 863.2875 818.2875
493 863.3125 818.3125
494 863.3375 818.3375
495 863.3625 818.3625
496 863.3875 818.3875
497 863.4125 818.4125
498 863.4375 818.4375
499 863.4625 818.4625
500 863.4875 818.4875

501 863.5125 818.5125
502 863.5375 818.5375
503 863.5625 818.5625
504 863.5875 818.5875
505 863.6125 818.6125
506 863.6375 818.6375
507 863.6625 818.6625
508 863.6875 818.6875
509 863.7125 818.7125
510 863.7375 818.7375
511 863.7625 818.7625
512 863.7875 818.7875
513 863.8125 818.8125
514 863.8375 818.8375
515 863.8625 818.8625
516 863.8875 818.8875
517 863.9125 818.9125
518 863.9375 818.9375
519 863.9625 818.9625
520 863.9875 818.9875
521 864.0125 819.0125
522 864.0375 819.0375
523 864.0625 819.0625
524 864.0875 819.0875
525 864.1125 819.1125
526 864.1375 819.1375
527 864.1625 819.1625
528 864.1875 819.1875
529 864.2125 819.2125
530 864.2375 819.2375
531 864.2625 819.2625
532 864.2875 819.2875
533 864.3125 819.3125
534 864.3375 819.3375
535 864.3625 819.3625
536 864.3875 819.3875
537 864.4125 819.4125
538 864.4375 819.4375
539 864.4625 819.4625
540 864.4875 819.4875
541 864.5125 819.5125
542 864.5375 819.5375
543 864.5625 819.5625
544 864.5875 819.5875
545 864.6125 819.6125
546 864.6375 819.6375
547 864.6625 819.6625
548 864.6875 819.6875
549 864.7125 819.7125
550 864.7375 819.7375

551 864.7625 819.7625
552 864.7875 819.7875
553 864.8125 819.8125
554 864.8375 819.8375
555 864.8625 819.8625
556 864.8875 819.8875
557 864.9125 819.9125
558 864.9375 819.9375
559 864.9625 819.9625
560 864.9875 819.9875
561 865.0125 820.0125
562 865.0375 820.0375
563 865.0625 820.0625
564 865.0875 820.0875
565 865.1125 820.1125
566 865.1375 820.1375
567 865.1625 820.1625
568 865.1875 820.1875
569 865.2125 820.2125
570 865.2375 820.2375
571 865.2625 820.2625
572 865.2875 820.2875
573 865.3125 820.3125
574 865.3375 820.3375
575 865.3625 820.3625
576 865.3875 820.3875
577 865.4125 820.4125
578 865.4375 820.4375
579 865.4625 820.4625
580 865.4875 820.4875
581 865.5125 820.5125
582 865.5375 820.5375
583 865.5625 820.5625
584 865.5875 820.5875
585 865.6125 820.6125
586 865.6375 820.6375
587 865.6625 820.6625
588 865.6875 820.6875
589 865.7125 820.7125
590 865.7375 820.7375
591 865.7625 820.7625
592 865.7875 820.7875
593 865.8125 820.8125
594 865.8375 820.8375
595 865.8625 820.8625
596 865.8875 820.8875
597 865.9125 820.9125
598 865.9375 820.9375
599 865.9625 820.9625
600 865.9875 820.9875
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- 866.0000 821.0000
601 866.0125 821.0125

- 866.0250 821.0250
602 866.0375 821.0375
603 866.0500 821.0500
604 866.0625 821.0625
605 866.0750 821.0750
606 866.0875 821.0875
607 866.1000 821.1000
608 866.1125 821.1125
609 866.1250 821.1250
610 866.1375 821.1375
611 866.1500 821.1500
612 866.1625 821.1625
613 866.1750 821.1750
614 866.1875 821.1875
615 866.2000 821.2000
616 866.2125 821.2125
617 866.2250 821.2250
618 866.2375 821.2375
619 866.2500 821.2500
620 866.2625 821.2625
621 866.2750 821.2750
622 866.2875 821.2875
623 866.3000 821.3000
624 866.3125 821.3125
625 866.3250 821.3250
626 866.3375 821.3375
627 866.3500 821.3500
628 866.3625 821.3625
629 866.3750 821.3750
630 866.3875 821.3875
631 866.4000 821.4000
632 866.4125 821.4125
633 866.4250 821.4250
634 866.4375 821.4375
635 866.4500 821.4500
636 866.4625 821.4625
637 866.4750 821.4750
638 866.4875 821.4875

- 866.5000 821.5000
639 866.5125 821.5125

- 866.5250 821.5250
640 866.5375 821.5375
641 866.5500 821.5500
642 866.5625 821.5625
643 866.5750 821.5750
644 866.5875 821.5875

645 866.6000 821.6000
646 866.6125 821.6125
647 866.6250 821.6250
648 866.6375 821.6375
649 866.6500 821.6500
650 866.6625 821.6625
651 866.6750 821.6750
652 866.6875 821.6875
653 866.7000 821.7000
654 866.7125 821.7125
655 866.7250 821.7250
656 866.7375 821.7375
657 866.7500 821.7500
658 866.7625 821.7625
659 866.7750 821.7750
660 866.7875 821.7875
661 866.8000 821.8000
662 866.8125 821.8125
663 866.8250 821.8250
664 866.8375 821.8375
665 866.8500 821.8500
666 866.8625 821.8625
667 866.8750 821.8750
668 866.8875 821.8875
669 866.9000 821.9000
670 866.9125 821.9125
671 866.9250 821.9250
672 866.9375 821.9375
673 866.9500 821.9500
674 866.9625 821.9625
675 866.9750 821.9750
676 866.9875 821.9875

- 867.0000 822.0000
677 867.0125 822.0125

- 867.0250 822.0250
678 867.0375 822.0375
679 867.0500 822.0500
680 867.0625 822.0625
681 867.0750 822.0750
682 867.0875 822.0875
683 867.1000 822.1000
684 867.1125 822.1125
685 867.1250 822.1250
686 867.1375 822.1375
687 867.1500 822.1500
688 867.1625 822.1625
689 867.1750 822.1750
690 867.1875 822.1875

691 867.2000 822.2000
692 867.2125 822.2125
693 867.2250 822.2250
694 867.2375 822.2375
695 867.2500 822.2500
696 867.2625 822.2625
697 867.2750 822.2750
698 867.2875 822.2875
699 867.3000 822.3000
700 867.3125 822.3125
701 867.3250 822.3250
702 867.3375 822.3375
703 867.3500 822.3500
704 867.3625 822.3625
705 867.3750 822.3750
706 867.3875 822.3875
707 867.4000 822.4000
708 867.4125 822.4125
709 867.4250 822.4250
710 867.4375 822.4375
711 867.4500 822.4500
712 867.4625 822.4625
713 867.4750 822.4750
714 867.4875 822.4875

- 867.5000 822.5000
715 867.5125 822.5125

- 867.5250 822.5250
716 867.5375 822.5375
717 867.5500 822.5500
718 867.5625 822.5625
719 867.5750 822.5750
720 867.5875 822.5875
721 867.6000 822.6000
722 867.6125 822.6125
723 867.6250 822.6250
724 867.6375 822.6375
725 867.6500 822.6500
726 867.6625 822.6625
727 867.6750 822.6750
728 867.6875 822.6875
729 867.7000 822.7000
730 867.7125 822.7125
731 867.7250 822.7250
732 867.7375 822.7375
733 867.7500 822.7500
734 867.7625 822.7625
735 867.7750 822.7750
736 867.7875 822.7875
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737 867.8000 822.8000
738 867.8125 822.8125
739 867.8250 822.8250
740 867.8375 822.8375
741 867.8500 822.8500
742 867.8625 822.8625
743 867.8750 822.8750
744 867.8875 822.8875
745 867.9000 822.9000
746 867.9125 822.9125
747 867.9250 822.9250
748 867.9375 822.9375
749 867.9500 822.9500
750 867.9625 822.9625
751 867.9750 822.9750
752 867.9875 822.9875

- 868.0000 823.0000
753 868.0125 823.0125

- 868.0250 823.0250
754 868.0375 823.0375
755 868.0500 823.0500
756 868.0625 823.0625
757 868.0750 823.0750
758 868.0875 823.0875
759 868.1000 823.1000
760 868.1125 823.1125
761 868.1250 823.1250
762 868.1375 823.1375
763 868.1500 823.1500
764 868.1625 823.1625
765 868.1750 823.1750
766 868.1875 823.1875
767 868.2000 823.2000
768 868.2125 823.2125
769 868.2250 823.2250
770 868.2375 823.2375
771 868.2500 823.2500
772 868.2625 823.2625
773 868.2750 823.2750
774 868.2875 823.2875
775 868.3000 823.3000
776 868.3125 823.3125
777 868.3250 823.3250
778 868.3375 823.3375
779 868.3500 823.3500
780 868.3625 823.3625
781 868.3750 823.3750
782 868.3875 823.3875

783 868.4000 823.4000
784 868.4125 823.4125
785 868.4250 823.4250
786 868.4375 823.4375
787 868.4500 823.4500
788 868.4625 823.4625
789 868.4750 823.4750
790 868.4875 823.4875
791 868.5000 823.5000
792 868.5125 823.5125
793 868.5250 823.5250
794 868.5375 823.5375
795 868.5500 823.5500
796 868.5625 823.5625
797 868.5750 823.5750
798 868.5875 823.5875
799 868.6000 823.6000
800 868.6125 823.6125
801 868.6250 823.6250
802 868.6375 823.6375
803 868.6500 823.6500
804 868.6625 823.6625
805 868.6750 823.6750
806 868.6875 823.6875
807 868.7000 823.7000
808 868.7125 823.7125
809 868.7250 823.7250
810 868.7375 823.7375
811 868.7500 823.7500
812 868.7625 823.7625
813 868.7750 823.7750
814 868.7875 823.7875
815 868.8000 823.8000
816 868.8125 823.8125
817 868.8250 823.8250
818 868.8375 823.8375
819 868.8500 823.8500
820 868.8625 823.8625
821 868.8750 823.8750
822 868.8875 823.8875
823 868.9000 823.9000
824 868.9125 823.9125
825 868.9250 823.9250
826 868.9375 823.9375
827 868.9500 823.9500
828 868.9625 823.9625
829 868.9750 823.9750
830 868.9875 823.9875

- 869.0000 824.0000
- 869.0125 824.0125
- 869.0250 824.0250
- 869.0375 824.0375
- 869.0500 824.0500
- 869.0625 824.0625
- 869.0750 824.0750
- 869.0875 824.0875
- 869.1000 824.1000
- 869.1125 824.1125
- 869.1250 824.1250
- 869.1375 824.1375
- 869.1500 824.1500
- 869.1625 824.1625
- 869.1750 824.1750
- 869.1875 824.1875
- 869.2000 824.2000
- 869.2125 824.2125
- 869.2250 824.2250
- 869.2375 824.2375
- 869.2500 824.2500
- 869.2625 824.2625
- 869.2750 824.2750
- 869.2875 824.2875
- 869.3000 824.3000
- 869.3125 824.3125
- 869.3250 824.3250
- 869.3375 824.3375
- 869.3500 824.3500
- 869.3625 824.3625
- 869.3750 824.3750
- 869.3875 824.3875
- 869.4000 824.4000
- 869.4125 824.4125
- 869.4250 824.4250
- 869.4375 824.4375
- 869.4500 824.4500
- 869.4625 824.4625
- 869.4750 824.4750
- 869.4875 824.4875
- 869.5000 824.5000
- 869.5125 824.5125
- 869.5250 824.5250
- 869.5375 824.5375
- 869.5500 824.5500
- 869.5625 824.5625
- 869.5750 824.5750
- 869.5875 824.5875
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- 869.6000 824.6000
- 869.6125 824.6125
- 869.6250 824.6250
- 869.6375 824.6375
- 869.6500 824.6500
- 869.6625 824.6625
- 869.6750 824.6750
- 869.6875 824.6875
- 869.7000 824.7000
- 869.7125 824.7125
- 869.7250 824.7250

- 869.7375 824.7375
- 869.7500 824.7500
- 869.7625 824.7625
- 869.7750 824.7750
- 869.7875 824.7875
- 869.8000 824.8000
- 869.8125 824.8125
- 869.8250 824.8250
- 869.8375 824.8375
- 869.8500 824.8500
- 869.8625 824.8625

- 869.8750 824.8750
- 869.8875 824.8875
- 869.9000 824.9000
- 869.9125 824.9125
- 869.9250 824.9250
- 869.9375 824.9375
- 869.9500 824.9500
- 869.9625 824.9625
- 869.9750 824.9750
- 869.9875 824.9875
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A
Acknowledge Alert Tone 39
Add System 14
Affiliation Hold Off 34
Affiliation Type 54
Alert Site Trunking 34, 35
Analog Transmit DES/DES-XL 54
ANI 40, 49, 51
Announcement Group ID 64, 77
Announcement Group List 59, 73
Announcement Groups 63, 76
Anti-Cloning Features 88
Auto Scan 63, 76
Auxiliary B 28
Auxiliary B Input 28

B
Backlight During Keypad Lockout 25
Backlight Level 26
Backlight on Keypress 25
Backlight On Time 26
Band 21
Battery Saver 24
Baud Rates 15
Busy Channel Lockout 48, 50
Busy Channel Override 40
Busy Update Timer 67

C
CAI Data Max Tx Attempts 41, 69
Call Alert 40
Call Alert Decode 40
Call Alert Encode 40
Call Alert Usage 68
Call Guard (CTCSS/DCS) Codes 

Table 91
Call List 42, 56, 71
Call Timer 38
CHAN PARMS 80, 83
Channel Alias 47, 49, 63, 76
Channel Bandwidth 54
Channel ID List 70
Channel Selector Enabled 26
Channel Setup 37

Channel Type 47, 49, 76
CHNG CHAN 80, 83
CHNG ZONE 80, 83
Clear Alert Tone 32
Clone Feature 87
Close 14
Comports 15
Computer Description 6
Connect Tone 53
Control Channel List 55, 70
Controller Type 26
Conventional System Parameters 37
Conversation 39
Convert Band 14
Creating Systems 9
CTCSS/DCS 47, 50
CTCSS/DCS Table 91
CTCSS/DCS/NAC List 45
Cursor 24
Customized Roaming Properties 55

D
D/H Box 21
Data Registration Enabled 41
Data/SNDCP 69
Decimal/Hexadecimal Select 8
Default RCM Address 68
Default User Selected Scan List 38
Delete System 15
Digit Duration 40
Digital Squelch 50
Digital Unit ID 32
Disable Site Trunking Operation 68
Display Option 32
Display Options 33, 36
Display Site Trunking 33, 35
DTMF Emergency ID 32
DTMF PTT ID 32
Dynamic Regrouping 53, 68

E
Electronic Serial Number 88
Emergency 52, 66
Emergency (Conventional) 39
Emergency Alarm 39, 52, 66
Emergency ANI Call - Analog 39
Emergency Blocked 35
Emergency Call 52, 66
Emergency Call - Digital 39
Emergency Group ID 77
Emergency Hot Mic 39, 52, 66
Emergency Hot Mic Time 39, 52, 66
Emergency Man Down 28
Emergency Retry Counter 53, 66

Encryption Key ID 38, 43, 72
Enhanced Private Conversation 54
Erase Keys on Keyset Change 28
External PA Display 27

F
Failsoft 35
Failsoft Enable 59, 72
Failsoft Inactivity 34
Failsoft Inactivity Duration 35
File 21
File Menu 14
File Size Indication 8
Firmware Upgrading Restrictions 10
Force Unmute Time 67
Frequency 47, 50
Front Keypad Lockout Only 25
Full Spectrum CC Scan 33, 35
Function Button Programming 30

G
Global Emergency Channel 24
Global Screen 8, 23
GPS feature 28
Group ID 50
Group Selection 50

H
Handheld Control Unit (HHC) 6
Hang-Up Box Monitor 25
Help 8, 20
Hexadecimal 20
Hold Off Time 35
Holdoff Delay 35
Home Channel 23
Home Zone 23
Horn Cadence 24
Hot DTMF 54

I
Ignition Power Down 24
Ignore Clear/Secure 26
Ignore Keypad CTCSS 49, 51
Individual (Unit) Call List Settings 38
Individual Call Maximum Target 

Ring 35
Individual ID 52
Infinite Key Retention 28
Information 21
Initial Delay 40
Installation 7
Inter Digit Delay 40
ISP Sequence Length 67
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ISW Delay Time 53

K
Key Management 27
Key PID 48, 58
Keypad 25
Keypad CTCSS/DCS 40
Keypad DTMF 48, 50
Keypad Programming 80
Keypad Type 25
Keys 52, 66
Keys Table 28
KMF IP Address 69
KMP UDP Port 69

L
LED Disabled w/Backlight Off 26
LED Indicator 24
Load System Keys 15
Lock Channel Selector 25
Lock Volume Knob 25
Lost Passwords 78
Low Battery Beep 24
Low Battery Indicators 24
Low Power 24

M
Main Screens 8
Make Dynamic Regrouping 

Channel 77
Manual, Operating 6
Manual, Service 6
Master Radio 87
MDC ID 32
Menu Enabled 26
Menu Items Programming 30
Message Alias List 42, 56
Message Trunking 68
Mic Levels 25
Microphone Jack 6
Minimum Volume 25
Mixed Mode 49
Mobile Computer IP Address 70
Modulation Level 47, 50

N
NAC 50
New 14
No Rx Activity 39, 53, 67
Normal/Silent 39

O
On New 19
Open 14
Option Switch Functions 31

Option Switch/Menu Parameter 
Table 31

Organization Identity 18
Organizer 8, 21
Originating Response Kind 41, 69
OTAR 27, 69
OTAR and Data Settings 40, 69
OTAR Enabled 41, 69
OTAR Keys Table 28
Other Band Trunking List 62
Out-of-Range Indication 34, 36
Override Talkgroup Security 

Settings 51

P
P25 Customized Roaming 

Properties 70
P25 Packet Data 91
P25 PTT ID 32
P25 Talk Group on Rx 32
Password

Changing 79
Download/Upload 19, 78, 79
Management 18
Master 19, 78, 79
Operation 78
Power On 78, 79
User 18, 79
Zone 79

Penalty 39
Per System Screen 8
Permanent Keypad Lockout 25
Phone Access Code List 45
Phone DTMF Timing 53
Phone Interconnect Settings

P25 41
Phone Interconnect Usage 54, 68
Phone List 45, 57
PID/ASM Mode 27
Power 47, 50
Power Up Channel 24
Power Up In 23, 24
Power Up Zone 23
Preference 73
Preferences 19
Preferred Sites 59, 60, 72
Print 14
Priority Lookback Time A 38
Priority Lookback Time B 38
Priority Sampling 44
Priority Scan List 44, 60, 74
Priority Scan Programming 9
Private Call 2 54
Private Call Maximum Int Ring 35
Private Call Usage 53, 68
Programmable Title and Logo 8
Programmed Channels Only on 

Display 25
Programming Cable 5

Programming Procedure 12
Programming Setup 5
PTT - ID 68
PTT ID Enable 53
PTT Warning Time 67

Q
Quick Fade Protect 67

R
Radio Check 40, 67
Radio Inhibit 40, 67
Radio Menu 14
Radio Random Hold Off Time 35
Radio Wide Conventional 

Parameters 32
Radio Wide Scan Programming 9
Radio Wide Screen 8
Radio-Wide Scan List 29
rcf 8
Read Options From Radio 17
Read Parameters From Radio 15
Read Version Info From Radio 16
Read/Write IP Address 17
Read/Write Spur Frequencies 17
Registration Inactivity Timer 69
Registration Number of Attempts 69
Registration Time Between 

Attempts 69
Rekey Request Time Out 41, 69
Release Notes 8
Remember Band 19
Remember Baud Rate 20
Remember Keys Directory 20
Remember Series 19
Remote Programming Interface 

(RPI) 5, 6
Response Pending Timer 67
Response Timer 41, 69
RFSS 66
RFSS Response Time 67
RFSS/Site ID No. 73
Ring Time 35
RS-232 Port 91
RSSI Threshold 35, 54
Rx Audio to External PA 27
Rx Auto Detect 48, 59
Rx Security Level 41, 69
Rx Voice Interrupts Data 70

S
Save 14
Save As 14
Scan Hold Time 30, 38, 53, 67
Scan List 76
Scan Mode 44, 60
Scan Programming 9
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Scan Talk Back Type 29
Scan Time 33
Security 48
Security Type 48, 58
Selected User 19
Send to Selected Organizer Group 14
Series 14, 21
Setting Up Channels 37
Setting Up Zones 36
Show MON Icon 33, 34, 36
Single Tone Encoder 40
Site 66
Site List 61, 74
Size 21
Slave Radio 87
SLN/CKR Mode 27
SmartZone Coverage Type 68
SNDCP Activation Wait Timer 70
SNDCP Dwell Timer 70
Soft Power Down 24
Sound 24
Splinter Channels 53
Standard Private Conversation 54
Standard Scan Programming 9
STAR Trunking 54
Status Alias List 42, 56, 70
Status Aliasing 68
Status Bar 21
Strapping Mode 48, 58, 72
Subscriber IP Address 70
Subscriber OTAR UDP Port 69
Surveillance Mode 26

SYS PARMS 80, 83
System ID 52, 65
System Key 86, 88
System Key Location 86
System Lists 41
System Preferred Site List 61, 75
System, Creating 9

T
Talk Group 63
Talk Group ID 60, 63, 76
Talk Group List 43, 57, 71
Talk Group Specific Preferred 

Sites 59, 73
Talk Groups 76
Talk Permit Tone 64, 67
Talkback Scan 34, 36
Time Out 47, 50
Time-Out Timer 53, 67
Tone On/Off 24
Tone Volume 25
Toolbar 20
Toolbar Options 18
Transfer Menu 15
Transmission Trunking 53, 68
Transmit 47
Transmit Disable 64, 77
Transmit Power 54, 68
Transmit Type 82, 85
Tx Chirp 24
Tx DES/DES-XL 48, 58

Tx Security Level 41, 69
Tx Time-Out 39
Tx/Rx Frequency 72

U
Unit 66
Unit RSI 27, 32
Use Sys Preferred Site List 59, 73
Use System Preferred Site List 58, 72
User Group ID List 45, 62, 75
User x 18

V
View Programmed Radio Wide 

Functions 15
Volume Ticks 26

W
WACN 65
Wireless Cloning 87
Write Application Code to Radio 16
Write DSP Code To Radio 16
Write Parameters To Radio 15

Z
Zone Password 79
Zone Screen 8
Zone Setup 36
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